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Serendipity Megarip Manual 
Copyright © Serendipity Software Pty Ltd 

Reproduction of any part of this user manual is strictly forbidden without prior written permission from Serendipity 
Software Pty Ltd. All company names, product names and trademarks mentioned in this manual are the property of  
the respective company. 

Important Notice 

Every effort is made to ensure the information contained within this user manual is correct. Serendipity Software Pty 
Ltd  cannot  be  held  responsible  for  any  errors  contained  within  this  user  manual  and  will  not  enter  into  any 
negotiations for claims of compensation relating to actions taken resulting from the information provided in this user 
manual for any reason whatsoever. 

Serendipity Software Pty Ltd is constantly making improvements to the software and as such, this user manual may 
not contain the latest information. Every effort is made to maintain the user manual and for the latest version, please  
check the website: 

https://www.serendipity-software.com.au

If there are any errors within this user manual, please detail them in an email to: 

support@serendipity-software.com.au

 

Further information, tutorials and how-to documents are available within the Serendipity Software Knowledge Base: 
https://skb.serendipity-software.com.au

Serendipity Megarip Product Manual – Version 9.1
4

https://skb.serendipity-software.com.au/
mailto:support@serendipity-software.com.au
https://www.serendipity-software.com.au/


Product Overview 
Serendipity Megarip is a high speed raster image processor (RIP) capable of accepting a variety of file formats, such 
as Postscript Level 3, PDF, TIFF, JPEG, PNG, Scitex CT and EPS. It is used to proof post-RIP data to either an 
output device, such as an Inkjet printer or to a file format, such as PDF. 

Serendipity Megarip runs in a Server and Client configuration. The Server runs on a computer on the network and is 
protected by a USB dongle.  The dongle licenses the level  of  software and the input  drivers and output  drivers 
purchased. 

The Client can run on the same computer on the network, whether it is local (LAN) or remote (WAN). The Client 
connects  to  the  Server  using  the  standard  network  protocol  TCP/IP and is  used  as  the  configuration  tool  and  
monitoring application to the Server. The Client is not licensed and can be run multiple times on the network. 

Jobs are sent to Serendipity Megarip in a variety of ways to suit your workflows. Printers can be published on the  
network in order for jobs to be printed from your usual desktop applications. Hot folders (Drop Folders) can be  
shared, where files can be copied or saved for processing. Files can also be submitted directly from the Client or drop 
zones can be created for dragging and dropping files in. Once a file is submitted it is spooled into the system, the file  
type is detected and it is passed on for processing. 

Imaging is the first process to take place. Imaging interprets the file format and samples the job’s resolution to change 
it to that of the configured output format. By doing so, an intermediate file is generated, called the Imaged file. The  
Imaged File can be viewed using the SoftProof utility. The file format maintains all the plates associated with the job  
and is viewed at the full output resolution. The Imaged File can also be re-submitted at any time for processing to the  
same or a different output. There is no need to spool and interpret the job again. * 

After the imaging process has completed, the job is passed to the rendering engine. This takes the Imaged File and 
creates  the  file  ready  for  output.  The process  includes  applying  any  output  characteristics  such as  orientation,  
cropping, colour management (ICC Profiles) and creation of the configured format, whether for an Inkjet printer or a 
file format, such as PDF. 

The Imaged File can be rendered as many times as desired. Each time, any of the output characteristics can be 
changed prior to rendering. 

Once the job is rendered, it is submitted for printing to the output device or file format. Multiple output queues can be  
created and multiple devices can be printed to simultaneously. Most of the output devices supported use a direct  
printer driver and therefore the Server has more control of options, such as, selecting specific media and printing  
directions. 

The  Client  monitors  the  whole  process  from start  to  finish,  showing  a  jobs  progress  in  a  QueueManager  and 
QueueStatus window. Jobs can be managed separately by placing a job on hold, releasing a job, cancelling or 
promoting as desired. The processes (queues) can be paused at any time, holding all jobs from spooling, imaging,  
rendering or printing. If a job fails, the error can be examined, rectified and the job retried. There are logs reporting all  
Server and Client functionality and job information from first detection on the RIP to final output. The logs can be 
searched, filtered or saved to a file. 

The system creates a database of all configurations, calibration curves and other settings. This database can be  
backed-  up on demand or  automatically,  so a working copy is  always available.  It  can be copied to  any other  
Serendipity Megarip as a whole database or as individual items. 

*This applies to any output characteristics. 
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Installation - DVD 
The installation section described the process for each operating system in turn. 

The software is supplied on one DVD for macOS, Windows and Linux versions. All versions come with a dongle and 
require  a  dongle  driver  be  installed.  Existing installations of  the software are given the opportunity  to  upgrade, 
preserving any existing configurations. 

What’s on the DVD? 
The DVD contains all elements required to run Serendipity Megarip and associated programs. They are divided into 
directories: 

• Docs – Contains all documentation. 

• Dongle – Contains the dongle drivers for all supported operating systems. 

• Drivers – Contains the Megarip PPDs for all supported operating systems. 

• Extras – Contains additional components loaded as part of the install process. 

• HTML – Contains the information required for the web browser install. This automatically launches the default 
browser for installation to begin. 

• Linux – Contains the Serendipity Megarip installation packages for Linux. 

• Macosx – Contains the Serendipity Megarip installation package for macOS. 

• Serendipity Client – Contains the Serendipity Client application for all supported operating systems. 

• Testprn – Contains Serendipity internal test print files. 

• Windows – Contains the Serendipity Megarip installation package for Windows. 
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Windows Installation - DVD
Administrator rights are required to install Serendipity Megarip. If upgrading from an existing installation to version  
9.1, see the “Upgrading to Version 9.1” section within this manual. 

Important Note: Version 9.1 installations using a Serendipity Dongle do not require a dongle driver installation. 

Installing the Dongle Driver (Sentinel SuperPro USB Dongles Only) 

The first step is to install the dongle driver. 
To install: 

1. Remove all USB dongles from the computer. 
2. On the DVD, navigate to the dongle/windows folder. 
3. Double-click the Sentinel Protection Installer.exe file to launch the application. 
4. Follow any onscreen instructions to complete the installation. 
5. Restart the computer when finished. 

Installing Serendipity Megarip 
The next step is to install Serendipity Megarip. Select the appropriate file for your system to install. 

1. Either select and run the Megarip installer by clicking the link on the browser page (if it pops up as Autoplay  
when  the  DVD  is  inserted),  or  go  to  the  DVD  and  navigate  to  the  Windows  directory  to  run  the  file 
megarip64.msi. 

2. Follow the onscreen instructions to complete the installation. 

Note:  You can type your own path and the installation program will make the folder for you, provided the chosen  
location has valid permissions. Use back slashes (\) to separate directories. 

Sentinel SuperPro Dongle Users Only – If a desktop 
icon  is  created  as  a  shortcut  to  launch  the  Megarip 
Server, this needs to be adjusted to run the “...-compat” 
executable.  This  file  is  located  in  the  installation 
directory.

The following message will appear if you fail to run the 
correct  Server  executable  for  the  Sentinel  SuperPro 
dongle:
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Installing the Stand-alone Serendipity Client (for Windows)
If additional computers on your network require access to Megarip, the stand-alone Serendipity Client can be installed 
on those machines.

Note:  Download the Serendipity Client installer/s appropriate to the operating system of the additional machine/s. 
See the relevant OS instructions if not installing on Windows.

To install the Client:

1. Download the Serendipity Client Windows Installer file from the Serendipity website.

2. Double-click the serendipity_client_9_1_windows_64bit.msi file to begin installation.

3. Follow any onscreen instructions to continue.  The installer  will  install  additional  Windows components if  
required, and place a Serendipity Client icon on the Desktop.

Once the installation has finished, proceed to the “Running the Software” section of this manual. 
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macOS Installation - DVD
Administrator rights are required to install Serendipity Megarip. If upgrading from an existing installation to version  
9.1, see the “ Upgrading to Version 9.1” section within this manual. 

Important Note:  Version 9.1 installations using a  Serendipity Driverless Dongle  do not require a dongle driver 
installation. 

macOS  11  Big  Sur  and  higher  require  a  Serendipity  Driverless  USB  Dongle  for  the  software  to  function.  
Legacy Sentinel SuperPro USB dongles are only compatible with macOS 10.15 and below.

Installing the Dongle Driver (Sentinel SuperPro USB Dongles Only) 
The first step is to install the dongle driver. 

To install: 

1. Remove all USB dongles. 

2. On the DVD, navigate to the dongle/macosx folder. 

3. Double+click the Sentinel System Driver.pkg file to launch the installer. 

4. Follow the onscreen instructions to complete the installation. 

5. Restart the computer when finished. 

Installing the Serendipity Printer Drivers 
The Serendipity  Printer  Drivers are used when setting up a Published Pagesetup for  printing from a third party 
application (e.g. Photoshop) directly to Megarip. 

The installation package is located on the installation DVD: 

1. Navigate to the /drivers/mac/ folder and run the file Serendipity Printer Drivers.pkg 

2. An installer window will appear. Follow the prompts to complete the installation of the drivers. The installer will  
require administrator access privileges. 

Installing Serendipity Megarip 
1. Go to the macosx folder on the installation DVD. 

2. Double-click the file Serendipity Megarip Package.pkg to launch the installer. 

3. Follow the onscreen instructions to complete the installation. 

Sentinel SuperPro Dongle Users Only – If a desktop icon is 
created as a shortcut to launch the Megarip Server, this needs 
to be adjusted to run the  “...-compat” executable. This file is 
located in the installation directory.

The following message will appear if you fail to run the correct 
Server executable for the Sentinel SuperPro dongle:
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Installing the Stand-alone Serendipity Client (for macOS)
If additional computers on your network require access to Megarip, the stand-alone Serendipity Client can be installed 
on those machines.

Note:  Download the Serendipity Client installer/s appropriate to the operating system of the additional machine/s. 
See the relevant OS instructions if not installing on macOS.

To install the Client:

1. Download the Serendipity Client macOS zip file from the Serendipity website.

2. Unzip the serendipity_client_9_1_macosx.zip file.

3. Double-click the Serendipity Client.pkg file to begin installation.

4. Follow any onscreen instructions to complete the installation.

Once the installation has completed, proceed to the “Running the Software” section of this manual. 

Serendipity Megarip Product Manual – Version 9.1
10



Linux Installation – DVD
Important Note:  Version 9.1 Linux installations require a Serendipity Driverless Dongle. If you are using a 
Sentinel SuperPro dongle, contact Serendipity or your dealer before upgrading.

Installing Serendipity Megarip 
Two sets of installers are available for Linux: 

AlmaLinux, CentOS 9, and Rocky Linux™ Platforms 

• serendipity-megarip-9.1-1.x86_64.rpm – installs the 64-bit Megarip Server and native Serendipity Client 

• serendipity-client-9.1-1.x86_64.rpm – installs a 64-bit standalone Serendipity Client 

• serendipity-c5-9.1-1.x86_64.rpm – installs a 64-bit standalone C5 Client 

Debian and Ubuntu Platforms 

• serendipity-megarip_9.1-1_amd64.deb – installs the 64-bit Megarip Server and native Serendipity Client 

• serendipity-client_9.1-1_amd64.deb – installs a 64-bit standalone Serendipity Client 

• serendipity-c5_9.1-1_amd64.deb – installs a 64-bit standalone C5 Client 

File Locations (DVD)

linux directory:

serendipity-megarip-9.1-1.x86_64.rpm

serendipity-megarip_9.1-1_amd64.deb

Serendipity Client/Linux directory:

serendipity-client-9.1-1.x86_64.rpm

serendipity-client_9.1-1_amd64.deb

serendipity-c5-9.1-1.x86_64.rpm

serendipity-c5_9.1-1_amd64.deb

See the following pages for installation instructions.
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AlmaLinux, CentOS 9, or Rocky Linux™ Installations
Before Megarip installation (for AlmaLinux, CentOS 9, and Rocky Linux™): 

1. Open a terminal window. 

2. At the prompt, type the following command: sudo dnf install epel-release -y

For CentOS 9 Only: 

1. At the terminal window type the following command: sudo crb enable

2. Once done, continue with the Megarip installation.

To install Megarip:

1. Open a terminal window. 

2. Navigate to the Linux directory on the DVD, or the folder containing the downloaded rpm installer file. 

3. At the prompt, type the following command: 

sudo dnf install ./serendipity-megarip-9.1-1.x86_64.rpm 

4. Type “y” at the prompt to install the package. 

5. Next, any user login accounts that will  be using Megarip need to be added to “serendipity” group. At the 
prompt type the following command: 

sudo gpasswd --add username serendipity 

6. For the new serendipity user group user/s to be applied, it is now necessary to restart the computer.

7. If a standalone Serendipity or C5 Client is required, follow the above steps for the appropriate file installation. 

Ubuntu or Debian Installations
1. Open a terminal window. 

2. Navigate to the Linux directory on the DVD, or the folder containing the downloaded deb installer file. 

3. At the prompt, type the following command: 

Ubuntu: sudo apt-get install ./serendipity-blackmagic_9.1-1_amd64.deb
Debian: su

 apt-get install ./serendipity-blackmagic_9.1-1_amd64.deb 

4. Type “y” at the prompt to install the package. 

5. Next, any user login accounts that will  be using Megarip need to be added to “serendipity” group. At the 
prompt type the following command: 

Ubuntu: sudo gpasswd --add username serendipity

Debian: su

 gpasswd --add username serendipity 

6. For the new serendipity user group user/s to be applied, it is now necessary to restart the computer.

7. If a standalone Serendipity or C5 Client is required, follow the above steps for the appropriate file installation. 
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Installing the Stand-alone Serendipity Client (for Linux)
If additional computers on your network require access to Megarip, the stand-alone Serendipity Client can be installed 
on those machines.

Note:  Download the Serendipity Client installer/s appropriate to the operating system of the additional machine/s. 
See the relevant OS instructions if not installing on Linux.

Before installation (for AlmaLinux, CentOS 9, and Rocky Linux™): 

1. Open a terminal window. 

2. At the prompt, type the following command: sudo dnf install epel-release -y

For CentOS 9 Only: 

1. At the terminal window type the following command: sudo crb enable

Once done, continue with the Megarip installation.

To install the Client:

1. Open a terminal window. Navigate to the location of the installation file. At the prompt type the following 
command:

AlmaLinux: sudo dnf install ./serendipity-client-9.1-1.x86_64.rpm

CentOS: sudo dnf install ./serendipity-client-9.1-1.x86_64.rpm

Rocky Linux™: sudo dnf install ./serendipity-client-9.1-1.x86_64.rpm

Ubuntu: sudo apt-get install ./serendipity-client_9.1-1_amd64.deb

Debian: su

apt-get install ./serendipity-client_9.1-1_amd64.deb

2. Enter "Y" at the prompt to install the package.

Stand-alone Serendipity Client user logins do NOT need to be added to a group as per the Megarip installation  
instructions above.

Once the Linux installation has completed, proceed to the “Running the Software” section of this manual. 
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Installation – File Download via Website
The software is downloaded from the Serendipity website. There are files for macOS, Windows and Linux versions. 

Note: All installation files are 64-bit.

Windows Installation – File Download
1. Download the Megarip Windows Installer file from the Serendipity website.

2. Double-click the serendipity_megarip_9_1_windows_64bit.msi file to begin installation.

3. Follow any onscreen instructions to continue.  The installer  will  install  additional  Windows components if  
required.

Note: The Windows (.msi) file installs both the Megarip Server and Serendipity Client.

Sentinel SuperPro Dongle Users Only – If a desktop 
icon  is  created  as  a  shortcut  to  launch  the  Megarip 
Server, this needs to be adjusted to run the “...-compat” 
executable.  This  file  is  located  in  the  installation 
directory.

The following message will appear if you fail to run the 
correct  Server  executable  for  the  Sentinel  SuperPro 
dongle:

Installing the Stand-alone Serendipity Client (for Windows)
If additional computers on your network require access to Megarip, the stand-alone Serendipity Client can be installed 
on those machines.

Note:  Download the Serendipity Client installer/s appropriate to the operating system of the additional machine/s. 
See the relevant OS instructions if not installing on Windows.

To install the Client:

1. Download the Serendipity Client Windows Installer file from the Serendipity website.

2. Double-click the serendipity_client_9_1_windows_64bit.msi file to begin installation.

3. Follow any onscreen instructions to continue.  The installer  will  install  additional  Windows components if  
required, and place a Serendipity Client icon on the Desktop.

Once the Windows installation has completed, proceed to the “Running the Software” section of this manual.
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macOS Installation – File Download
1. Download the .zip file containing the Megarip macOS Installer package from the Serendipity website.

2. Unzip the folder then double-click the Serendipity_Megarip.pkg file to begin installation.

3. Follow any instructions to continue.

Note: The macOS Installer Package (.pkg) installs both the Megarip Server and Serendipity Client.

Important Note: macOS 11 Big Sur and higher require a Serendipity Driverless USB Dongle for the software to 
function. Legacy Sentinel SuperPro USB dongles are only compatible with macOS 10.15 and below.

Sentinel SuperPro Dongle Users Only – If a desktop icon 
is created as a shortcut to launch the Megarip Server, this 
needs  to  be  adjusted  to  run  the  “...-compat” executable. 
This file is located in the installation directory.

The  following  message  will  appear  if  you  fail  to  run  the 
correct Server executable for the Sentinel SuperPro dongle:

Installing the Stand-alone Serendipity Client (for macOS)
If additional computers on your network require access to Megarip, the stand-alone Serendipity Client can be installed 
on those machines.

Note:  Download the Serendipity Client installer/s appropriate to the operating system of the additional machine/s. 
See the relevant OS instructions if not installing on macOS.

To install the Client:

1. Download the Serendipity Client macOS zip file from the Serendipity website.

2. Unzip the serendipity_client_9_1_macosx.zip file.

3. Double-click the Serendipity Client.pkg file to begin installation. 

4. Follow the onscreen instructions to complete the installation.

Once the macOS installation has completed, proceed to the “Running the Software” section of this manual.
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Linux Installation – File Download
Important Note:  Version 9.1 Linux installations require a Serendipity Driverless Dongle. If you are using a 
Sentinel SuperPro dongle, contact Serendipity or your dealer before upgrading.

AlmaLinux, CentOS 9 Stream, or Rocky Linux™ Installations
Before Megarip installation (for AlmaLinux, CentOS 9, and Rocky Linux™): 

1. Open a terminal window. 

2. At the prompt, type the following command: sudo dnf install epel-release -y

For CentOS 9 Only: 

1. At the terminal window type the following command: sudo crb enable

2. Once done, continue with the Megarip installation.

To install Megarip:

1. Navigate to the Linux directory containing the downloaded rpm installer file. 

2. At the prompt, type the following command: 

sudo dnf install ./serendipity-megarip-9.1-1.x86_64.rpm 

3. Type “y” at the prompt to install the package. 

4. Next, any user login accounts that will  be using Megarip need to be added to “serendipity” group. At the 
prompt type the following command: 

sudo gpasswd --add username serendipity 

5. For the new serendipity user group user/s to be applied, it is now necessary to restart the computer. 

6. If a standalone Serendipity or C5 Client is required, follow the above steps for the appropriate file installation. 

Ubuntu or Debian Installations
1. Download the appropriate file for your operating system from the Serendipity Downloads page.

2. Open a terminal window. At the prompt type the following command:

Ubuntu: sudo apt-get install ./serendipity-megarip_9.1-1_amd64.deb

Debian: su

 apt-get install ./serendipity-megarip_9.1-1_amd64.deb

3. Enter "Y" at the prompt to install the package.

4. Once installed, any user login accounts that will be using Megarip need to be added to “serendipity” group.  
Open a Terminal window. At the prompt type the following command:

Ubuntu: sudo gpasswd --add username serendipity

Debian: su

 gpasswd --add username serendipity

5. For the new serendipity group user/s to be applied, it is now necessary to restart the machine.
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Installing the Stand-alone Serendipity Client (for Linux)
If additional computers on your network require access to Megarip, the stand-alone Serendipity Client can be installed 
on those machines.

Note:  Download the Serendipity Client installer/s appropriate to the operating system of the additional machine/s. 
See the relevant OS instructions if not installing on Linux.

Before installation (for AlmaLinux, CentOS 9, and Rocky Linux™): 

1. Open a terminal window. 

2. At the prompt, type the following command: sudo dnf install epel-release -y

For CentOS 9 Only: 

1. At the terminal window type the following command: sudo crb enable

Once done, continue with the Serendipity Client installation.

To install the Client via Terminal:

1. Open a terminal window. At the prompt type the following command:

AlmaLinux: sudo dnf install ./serendipity-client-9.1-1.x86_64.rpm

CentOS: sudo dnf install ./serendipity-client-9.1-1.x86_64.rpm

Rocky Linux™: sudo dnf install ./serendipity-client-9.1-1.x86_64.rpm

Ubuntu: sudo apt-get install ./serendipity-client_9.1-1_amd64.deb

Debian: su

apt-get install ./serendipity-client_9.1-1_amd64.deb

2. Enter "Y" at the prompt to install the package.

Stand-alone Serendipity Client user logins do NOT need to be added to a group as per the Megarip installation  
instructions above. 

Once the Linux installation has completed, proceed to the “Running the Software” section of this manual.
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Upgrading to Version 9.1 
This section details upgrading an existing Megarip installation to version 9.1. The installer automatically upgrades the 
existing database to the current version 9.1 format. 

As a  precaution,  before upgrading it  is  recommended that  the Megarip database,  license,  and ICC profiles are 
backed-up using the Archives application (see  Windows Upgrade  or  macOS Upgrade  sections for details),  or by 
copying the database directories (see Copying the Database and ICC Folders section for details). 

A complete Server and Client backup can also be performed using the Server Help menu > Backup Server option, 
and the Serendipity Client Help menu > Backup Client Preferences option. 

Important Note: Pagesetups imported from version 5 (and below) archives will be automatically split into Jobticket, 
Media and Pagesetup data types but remain functionally linked. Version 9.1 archives cannot be opened or imported  
into previous versions of Megarip. 

Windows – Upgrading to Version 9.1 
Archiving Current Installations 

To archive a database: 

1. Run the existing Megarip Server and Serendipity Client. 

2. Go to the Client Application menu > Archives (or Archiver in earlier versions). 

3. Select File menu > Perform Full Backup. 

4. Alternatively, select Edit menu > Add to Archive (all) and add all database items to the archive file, or right-
click in the Archives window and select Add to Archive (all) > Everything from the contextual menu. 

5. Once all database items have appeared in the Archives window, select File menu > Save Archive to save 
the .sdb archive file to a chosen location. 

6. Close the Archives application when finished. 

Alternatively, a complete Server and Client backup can also be performed using the Server Help menu > Backup 
Server option, and the Serendipity Client Help menu > Backup Client Preferences option. 

Important Note:  Version 9.1 installations using a  Serendipity Driverless Dongle  do not require a dongle driver 
installation. 

Installing the Dongle Driver Update (Sentinel SuperPro USB Dongles Only)
Version 9.1 dongles (new or upgraded) require an up-to-date Safenet dongle driver in order to function. 

To upgrade: 

1. Make sure the Megarip Server and Client are not running and remove any USB dongles (Megarip or any 
other) from the computer. 

2. On  the  installation  DVD,  navigate  to  the  dongle/windows  directory  and  run  the  Sentinel  Protection 
Installer.exe file. 

3. Run the Sentinel Installer. 

4. Select Upgrade and Next. 

5. Follow the onscreen instructions to complete the upgrade. 

6. Restart the computer when finished. 
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Installing the Megarip Version 9.1 Upgrade 
Current Windows file/folder security and permissions makes it necessary to install Megarip v9.1 in the root directory 
of the hard drive, e.g., C:\Serendipity\ rather than Program Files, where earlier versions of Megarip were installed. 

To upgrade: 

1. Navigate to the windows directory on the installation DVD, or to the location of the downloaded file.

2. Run the megarip64.msi (64-bit) file. 

3. If necessary, change the installation directory to the root directory of the hard drive, e.g., C:\Serendipity\ and 
click Next. 

4. Follow the onscreen instructions to complete the upgrade. 

5. Plug the Megarip dongle into an available USB port. 

6. Start the Megarip v9.1 Server and the Serendipity Client. 

Sentinel SuperPro Dongle Users Only – If a desktop 
icon  is  created  as  a  shortcut  to  launch  the  Megarip 
Server, this needs to be adjusted to run the “...-compat” 
executable.  This  file  is  located  in  the  installation 
directory.

The following message will appear if you fail to run the 
correct  Server  executable  for  the  Sentinel  SuperPro 
dongle:

If the installation location did not require changing, the existing database should appear once the Server and Client 
have restarted, reformatted and intact in the Workbench application. The Client should open with the previous version 
configurations. 

If the installation location changed, or in the event the existing database is not complete, the database backup needs  
to be imported using the Archives application. 

To import an existing database backup: 

1. Open the Archives application from the Serendipity Client > Application menu. 

2. In Archives, select File menu > Open Archive. 

3. Navigate to and select the saved backup archive .sdb file. Click Open. The archive will open in the Archives 
window and display all database items from the previously backed-up configuration. 

4. Once the archive has loaded select Edit menu > Add to Database > Whole Archive. This will import the entire  
database. 

5. Alternatively, choose individual items to import from the list and select Edit > Add to Database> Selected 
Nodes. 

6. The database items will be imported and appear in the Workbench for use. 

For further information on archives and backing-up databases, see the “Archives” section within this manual. 
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macOS – Upgrading to Version 9.1 

Archiving Current Installations 
To archive a database: 

1. Run the existing Megarip Server and Serendipity Client. 

2. Go to the Client Application menu > Archives (or Archiver in earlier versions). 

3. Select File menu > Perform Full Backup. 

4. Alternatively, select Edit menu > Add to Archive (all) and add all database items to the archive file, or right-
click in the Archives window and select Add to Archive (all) > Everything from the contextual menu. 

5. Once all database items have appeared in the Archives window, select File menu > Save Archive to save 
the .sdb archive file to a chosen location. 

6. Close the Archives application when finished. 

Alternatively, a complete Server and Client backup can also be performed using the Server Help menu > Backup 
Server option, and the Serendipity Client Help menu > Backup Client Preferences option. 

Important Note:  Version 9.1 installations using a  Serendipity Driverless Dongle  do not require a dongle driver 
installation. 

Installing the Dongle Driver (Sentinel SuperPro USB Dongles Only) 
The first step is to install the dongle driver. 

1. Remove all USB dongles from the computer. 

2. Navigate to the dongle/macosx directory. 

3. Double-click the Sentinel System Driver.pkg file to launch the installer. 

4. Follow the onscreen instructions to complete the installation. 

5. Restart the computer when finished. 

Installing the Megarip Version 9.1 Upgrade 
To upgrade: 

1. Navigate to the macosx directory on the DVD, or to the location of the downloaded file.

2. Run the Serendipity Megarip.pkg file. 

3. Select the drive and location to install the software. The installer will choose the current installation location by 
default, which in most cases is /Applications/Serendipity. 

4. Follow the onscreen instructions to complete the upgrade. 

5. Plug the Megarip dongle in to an available USB port. 

6. Start the Megarip v9.1 Server and the Serendipity Client. 
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Sentinel SuperPro Dongle Users Only – If a desktop 
icon  is  created  as  a  shortcut  to  launch  the  Megarip 
Server, this needs to be adjusted to run the “...-compat” 
executable.  This  file  is  located  in  the  installation 
directory.

The following message will appear if you fail to run the 
correct  Server  executable  for  the  Sentinel  SuperPro 
dongle:

If the installation location was not changed, the existing database should appear once the Server and Client have 
restarted, reformatted and intact in the Workbench. The Client should open with the previous version configurations. 

If the installation location changed, or in the event the existing database is not complete, the database backup needs  
to be imported using the Archives application. 

To import an existing database: 

1. Open the Archives application from the Serendipity Client > Application menu. 

2. In Archives, select File menu > Open Archive. 

3. Navigate to and select the saved backup archive .sdb file. Click Open. The archive will open in the Archives 
window and display all database items from the previously backed-up configuration. 

4. Once the archive has loaded, select Edit menu > Add to Database > Whole Archive. This will import the entire  
database. 

5. Alternatively, choose individual items to import from the list and select Edit > Add to Database > Selected 
Nodes. 

The database items will be imported and appear in the Workbench for use. 
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Linux – Upgrading to Version 9.1 

Archiving Current Installations 
To archive a database: 

1. Run the existing Megarip Server and Serendipity Client. 

2. Go to the Client Application menu > Archives (or Archiver in earlier versions). 

3. Select File menu > Perform Full Backup. 

4. Alternatively, select Edit menu > Add to Archive (all) and add all database items to the archive file, or right-
click in the Archives window and select Add to Archive (all) > Everything from the contextual menu. 

5. Once all database items have appeared in the Archives window, select File menu > Save Archive to save 
the .sdb archive file to a chosen location. 

6. Close the Archives application when finished. 

Alternatively, a complete Server and Client backup can also be performed using the Server Help menu > Backup 
Server option, and the Serendipity Client Help menu > Backup Client Preferences option. 

Important Note:  Version 9.1 installations require a  Serendipity Driverless Dongle. If  you are using a Sentinel 
SuperPro dongle, contact Serendipity or your dealer before upgrading.

Installing the Megarip Version 9.1 Upgrade 
To upgrade: 

1. Follow the instructions as per the Linux Installation section for the operating system being used as outlined 
in this manual. 

If the installation location was not changed, the existing database should appear once the Server and Client have 
restarted, reformatted and intact in the Workbench. The Client should open with the previous version configurations. 

If the installation location changed, or in the event the existing database is not complete, the database backup needs  
to be imported using the Archives application. 

To import an existing database: 

1. Open the Archives application from the Serendipity Client > Application menu. 

2. In Archives, select File menu > Open Archive. 

3. Navigate to and select the saved backup archive .sdb file. Click Open. The archive will open in the Archives 
window and display all database items from the previously backed-up configuration. 

4. Once the archive has loaded, select Edit menu > Add to Database > Whole Archive. This will import the entire  
database. 

5. Alternatively, choose individual items to import from the list and select Edit > Add to Database > Selected 
Nodes. 

The database items will be imported and appear in the Workbench for use. 
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Saving/Restoring  the  Megarip  Database and  ICC  Profiles  using  the  File 
System
An alternate method for backing up the existing database and ICC profiles is to copy the relevant file folders from 
Megarip to another location before upgrading to version 9.1. 

Important Note: The below folders can all be automatically backed-up using the Backup Server menu option. This is 
the preferred and recommended method of backup. 

The database items are held in a folder called defaultss.dbd in the following locations: 

macOS <Megarip installation directory>/lib/defaultss.dbd/

Windows <Megarip installation directory>\lib\defaultss.dbd\ 

Linux/Sun/SGI <Megarip installation directory>\lib\defaultss.dbd\ 

The ICC Profiles are stored in a folder called ICC in the following locations: 

macOS <Megarip installation directory>/lib/ICC/ 

Windows <Megarip installation directory>\lib\icc\ 

Linux/Sun/SGI <Megarip installation directory>\lib\ICC\  

The dongle licenses are stored in a folder called license in the following locations. The folder may appear as empty, 
but it still requires copying: 

macOS <Megarip installation directory>/lib/license/ 

Windows <Megarip installation directory>\lib\license\ 

Linux/Sun/SGI <Megarip installation directory>\lib\license\ 

To restore the database and ICC profiles to an upgraded Megarip 

1. Ensure the Megarip Server and Serendipity Client are shutdown. 

2. Copy and replace the backed-up  defaultss.dbd, license,  and  ICC  folders into the relevant locations (as 
listed above) for the installation. 

3. Start the Server and Client. All previous database items should now appear in the Workbench. 

Important  Note:  Pagesetups imported  from older  archives will  be  automatically  split  into  Jobticket,  Media  and 
Pagesetup data  types,  but  remain  functionally  linked.  Version 9.1  archives cannot  be opened or  imported into 
previous versions of Megarip. 
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Running the Software 
Once the software has been installed, launch the Server and Client application to begin configuration. The Server 
should be started first and allowed to complete its initialisation process before the Client is launched. If the Client is  
started first, it will attempt to connect to an active Server. If none are present, a Connect to Server window will open, 
waiting for an active Server to appear on the Network. 

Important Note for macOS Apple silicon (ARM) machine users 

Many spectrophotometer and printer's screening (HTM) drivers have yet to be updated by their manufacturers to be 
compatible with ARM architecture. As such, users will find that these device drivers are unavailable if Megarip is run 
in its default mode on an Apple silicon (ARM-based) Mac.

Users installing on Apple silicon Macs will need to run Megarip, Serendipity Client and/or C5 in 'Rosetta' Intel 
emulation mode to maintain access to these device drivers.

Before running the Megarip Server or Serendipity Client, follow the steps below to 
enable Rosetta mode for your software: 

Before starting the Server and Client

1. Open a Finder window.

2. Navigate to the Applications/Serendipity/Serendipity Megarip folder.

3. Highlight the  Serendipity Client application and select  CMD+I or right-click 
and select Get Info from the menu.

4. Tick the checkbox to enable Open Using Rosetta mode.

5. Repeat  the  above  steps  for  the  Serendipity  Megarip,   or  C5  Client 
application if necessary.

Starting the Megarip Server (Dongle)
1. Plug the dongle in to an available USB port. 

2. Launch the Server by double-clicking the Serendipity Megarip file in the installation directory, or the shortcut  
icon on the desktop/dock. 

Sentinel SuperPro Dongle Users Only – If a desktop icon is 
created as a shortcut to launch the Megarip Server, this needs 
to be adjusted to run the  “...-compat”  executable. This file is 
located in the installation directory.

The following message will appear if you fail to run the correct 
Server executable for the Sentinel SuperPro dongle:

The Server window will appear, showing information about the Server software and initialisation process will begin. 
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Note: The Server will not initialise if a recognised dongle is not present on the computer from which it is run. If the 
dongle is removed at any point while the Server is running, all job processing will cease and the Server will stop 
shortly afterwards. Once the dongle is reconnected, close and restart the Server. 

Starting the Megarip Server (Software Dongle License)
Note: In order to use this method, an internet connection is required and you must have a valid product license 
linked to your registered email address.

1. Run the Megarip Server application.

2. Activate the Software Dongle:

a) In the Server window, select the File menu > Activate Software Dongle option.

b) Enter your Serendipity registered email address and password in the login screen.

If you have multiple Megarip products available, a dropdown will appear for you to select which one to use after 
successfully logging in. 

Once you are logged in the Server window will appear with information about the Server and the option to start is  
available (if auto-start is not configured).

Starting the Megarip Server (Subscription)
Note: In order to use this method, an internet connection is required and you must have a valid product license 
linked to your registered email address.

1. Run the Megarip Server application.

2. Activate the Subscription:

a) In the Server window, select the File menu > Activate Subscription option.

b) Enter your Serendipity registered email address and password in the login screen.

If you have multiple Megarip products available, a dropdown will appear for you to select which one to use after 
successfully logging in. 

Once you are logged in the Server window will appear with information about the Server and the option to start is  
available (if auto-start is not configured).

Starting the Serendipity Client 
Once the Server has completed initialisation, launch the Client by double-clicking the Serendipity Client file in the 
installation directory or the desktop/dock icon, or by selecting the Launch menu > Serendipity Client option in the 
Server window.

The Client will connect to the active Server and display the default monitoring system – Jobs – on the screen. From 
this point, configuration of the system or loading a pre-configured setup can be done. 

Serendipity Megarip Product Manual – Version 9.1
25



Serendipity Client Configuration
The Serendipity Client application is used as the configuration tool and monitoring application for the Server. It can be 
run on the same machine, or on another locally (LAN) or remotely (WAN) networked computer. The Client connects to 
the Server via standard TCP/IP network protocol and is not licensed, so it can be run multiple times on the network.

There are two (2) methods of configuration – using a pre-configured setup, or manually creating each item. 

Using a pre-configured Media setup
In order to begin processing jobs a Media, an Output, and a Pagesetup will need to be created.

• A Media controls the settings for output, colour correction, ICC profiles, screen printing and output screening.

• An  Output determines where any processed jobs are sent, either to a printer, a file location, or a remote 
destination.

• A Pagesetup is where the Output and Media are assigned.

Media Catalogue is an integrated application that allows users to access Serendipity's online database of Media 
configurations. Media can be downloaded and added to the Workbench database automatically, so you can begin 
proofing and printing straight away.

1. Open Media Catalogue from the Serendipity Client Help menu.

2. Select Create New to configure an Output, Media and Pagesetup combination.

3. In the top of the window click the Output Driver button and select your driver (printer).

4. In the left Media column you will see any available Media appear for your selected driver.

5. Select the Media you would like to setup. All details will appear on the right side of the window.

6. Click Next to continue.

7. The Setup for Media window will appear. You can edit any of the available name fields here if required.

8. As you are creating a new Output, leave the option on Create New.

9. If you are connecting to the output via Bonjour, set up access via the dropdown. If not, click “Select Later” and 
configure the connection method in the next step (see For Non-Bonjour Connections below). 

10. Click Create to continue. The selected combination will automatically be added to the Workbench. Close the 
Media Catalogue when finished.

For Non-Bonjour Connections:

1. Go to the Workbench application. If this is not open, in the Serendipity Client window select Application menu 
> Workbench.

2. On the left you will see a list of datatypes in a column. Select Output.

3. A list of available Output items will appear. Select the Output you just created with the Media Catalogue.

4. On the right a configuration panel will appear. Select Connection.

5. Click the Destination Driver button. From the popup, choose your connection method, for e.g., FTP or TCP/IP.

6. Enter any relevant information and save the changes (File menu > Save).

You are now able to submit jobs or a test print to confirm the connection.
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Manual Client Configuration 
This section will explain how to setup a basic configuration in order to print a file to a printer and monitor the job  
throughout  the  process.  For  detailed  information  on  specific  modules/applications  mentioned,  see  the  relevant 
sections of this manual. 

The default  monitoring application – Jobs – opens with a factory standard layout,  including the QueueManager, 
Thumbnail  and  QueueStatus  modules.  System  queues  (Image,  Render,  Asset,  Spool  and  AutoDetect)  will  be 
displayed in the QueueManager. Specific queues will need to be configured for the above-mentioned process. 

There are four (4) sections within the Client that require configuration in order to begin processing jobs from the RIP 
to the printer. These are (in no particular order): 

• A Pagesetup and Media where jobs are processed. 

• An Output where the print job will be sent. 

• An optional Jobticket, where any custom processing requirements are set. 

Note: Each Pagesetup must be linked to a valid Media and Output, so it is recommended to create those first before  
the Pagesetup is created. 

To begin configuration: 

1. Select Application menu > Workbench. The Workbench application is where all configuration takes place.

Output Configuration 
1. Select Output from the Data Types list on the left and create a new one by selecting File menu > New. 

2. The Output name “Untitled” will appear in the items list, highlighted for renaming. This is the name of the 
Output that will appear in the Pagesetup. Select the item. 

3. In the Queue panel of the grey configuration area, click the Output button and select the appropriate driver 
for your printer from the list. 

4. In  the  Destination  panel,  select  a  destination  driver  (connection  method)  for  the  printer  and  enter  the 
appropriate information, e.g., the IP address of the printer. If USB or Bonjour/Zeroconf is selected, click the 
Edit button to select the correct device/service from the Custom Settings popup window. 

5. Configure any Collating or Nesting requirements as needed. See the Workbench > Output section of this 
manual for further details on this option. 

6. OPTIONAL  – After  a Media is created,  it  can be assigned to the Output  via the Change Media button.  
Assigning a Media to the Output will only allow jobs submitted to that Media to print. See the Media section of  
this manual for further information. 

7. Save the Output configuration when finished by selecting File menu > Save. 

Media Configuration 
1. Select Media from the Data Types list on the left and create a new Media by selecting File menu > New. 

2. The Media name “Untitled” will appear in the items list, highlighted for renaming. This is the name of the 
Media 

that will appear in the Output and Pagesetup. Rename and select the item. 
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3. In the Output panel of the grey configuration area, click the Output button and select the appropriate driver 
for  your  printer  from  the  list.  This  should  be  the  same  driver  as  was  used  for  the  previous  Output 
configuration. 

4. Configure the print resolution to be used (if applicable), and the print colourspace (RGB/CMYK etc). 

5. Select any custom settings for the printer. Click the Edit button to select any options from the popup settings  
window. These may include paper type, print mode, cutting options, light ink usage. Click Accept to close the 
window. 

6. Set the Output ICC profile via the Choose ICC Profile button. In most cases for a new install this will be the 
Standard SWOP (CMYK) profile. Optionally, load your own profile by selecting the Upload File button and 
navigating to the file location. 

7. Save the Media when finished by selecting File menu > Save. 

Note: This Media configuration is the minimal setup required to get your proof/print workflow functioning. For proofing 
work,  the Media  will  need to  be  correctly  calibrated.  For  a  complete  HowTo guide for  configuring  a  calibrated 
Pagesetup/Media/Output,  refer  to  the  Serendipity  Software  Knowledge  Base  (https://skb.serendipity-
software.com.au) 

Pagesetup Configuration 
1. Select Pagesetup from the Data Types list and create a new Pagesetup by selecting File menu > New. 

2. The name “Untitled” will appear in the list, highlighted for renaming. Rename and press Enter. Select the item. 

3. Assign the Output created previously to the Pagesetup via the Change Output button. A popup will appear 
to select the Output. Click OK when done. 

4. Assign the Media created previously to the Pagesetup via the Change Media button. Select the Media in the 
popup window that appears and click OK. Jobs will be printed using this Media unless another is selected 
when submitting a job to print. 

5. A Jobticket  (if required) can also be assigned to the Pagesetup here. This will process any jobs with the 
Jobticket properties if sent to this Pagesetup. 

6. Set any flow control or configure a DropFolder via the Publish & Flow Control panel. 

7. Save the Pagesetup configuration when finished by selecting File menu > Save. 

Jobticket Configuration (Optional) 
1. Select Jobticket from the Data Types list and create a new Jobticket by selecting File menu > New. 

2. Rename if required and press Enter. 

3. If the RGB and Press Input profiles for processing the job are different to those in the System Settings, adjust  
them via the Colour Management tab. 

4. Adjust any rendering intent if required. 

5. Configure any other sheet, effects, rotation, or other options as required and save the Jobticket via File menu 
> Save. 

6. If desired, the Jobticket can be assigned to the Pagesetup created previously. See the Pagesetup instructions 
above for where to assign the Jobticket.  Any jobs will  be automatically processed with these configured 
options (if it is assigned to the Pagesetup) when submitted. 

This completes the basic configuration of Megarip. 
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Monitoring Jobs – Configuration 
Once the base configuration is complete, a monitoring application needs to be configured so jobs can be managed 
throughout the system. 

There are two (2) types available – Jobs (default) or Monitor. 

Jobs 
This is the default application, launched when the Client is started for the first time. 

The Jobs application has a pre-configured set of tabs available for monitoring various processes throughout the entire 
workflow. The default tab layout includes the QueueManager, Thumbnail, and QueueStatus modules. See the “Jobs”  
application section within this manual for further information. 

Any Output items created in the earlier “Manual Configuration”  will  automatically appear in the QueueManager 
module. 

To add additional tab layouts: 

1. In the Jobs application, select the Tabs menu > Add Tabs option. 

2. A window will appear with various factory default layouts available for use. 

3. Select the required tab layout from the list. A preview example screen will be displayed to the right. 

4. Click Add. The new tab will appear in the Jobs window. 

Additional pre-configured tabs may be added to the Jobs application as required. See the “Jobs” application section 
of this manual for further information. 

Monitor 
The Monitor application performs the same workflow monitoring functions as the Jobs application and was the default 
application in previous versions of the software, before the Jobs application was introduced. Monitor allows the user 
to customise the size and layout of tabs and job management modules. 

1. Select Application menu > Monitor to open a Monitor window. The default view will include a Queues tab and 
a Logs tab. 

2. The Queues tab contains the QueueManager, Thumbnail, and QueueStatus modules. The Logs tab contains 
the ClientLog and ServerLog modules. 

3. If you would prefer to have any new Output queues automatically added to the QueueManager for future use, 
enable the Auto Queue Order checkbox via the Toolbar (spanner icon). 

The module windows may be resized and positioned by selecting the Layout menu > Edit. 

1. Select the window corner with the mouse and resize it by dragging the mouse to the desired size. 

2. Select Layout menu > Use when done to lock the module window position. 

Additional tabs and modules may be added to the Monitor as required. 

• Tabs are created via the Tabs menu > New Tab option. 

• Modules are added via the Layout Menu and selecting the appropriate module to add from the list. 
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Submitting Jobs 
There are various methods available for submitting files for printing when using the Serendipity Client. 

The Submit Menu 
Selecting Submit > Files will present the file choose window to select the file for processing. 

Once a file is selected, the option to choose which Pagesetup/Media/Jobticket combination will be used is displayed. 
Flow control can be enabled to hold jobs after imaging or rendering, along with number of copies and publication  
options. For complete information on the Submit menu, see the Serendipity Client Menu Items section of this manual. 

DropFolders 
DropFolders can be created via the Pagesetup in the Workbench application. 

A dropfolder is an allocated folder where files can be dropped into it for automatic processing. A Pagesetup will need  
to be published in order to access its dropfolder. 

Important Note: Any files dropped into a DropFolder should be copies, not originals, as they will be auto-deleted 
from the folder once sent for processing. 

For further information on the configuration of a DropFolder, see the Pagesetup section of this manual. 

Third Party Applications 
Supported file types can be submitted to the Serendipity Client for processing directly from third party applications,  
like Adobe Illustrator or Photoshop. 

The Pagesetup will need to be published as a print destination, allowing the design application to see it and print to it  
directly. For the configuration of a published Pagesetup printer, see the Pagesetup and/or  Publishing a Pagesetup 
sections of this manual. 

Studio 
The Studio application allows for the manual placement and nesting of files. 

Once a job layout  has been created,  it  is  submitted for  printing via  the Studio menu.  The option to select  the 
Pagesetup/Media/Jobticket combination will be displayed before the job is sent for processing. 

For complete details on the Studio application, see the Studio section of this manual. 

Desktop Submit 
There is  a  further  option when submitting  an image to  Megarip,  available  via  the right-click  (contextual)  menu. 
Selecting an image file from the desktop or Finder (Mac) / Window Explorer (Win) and right-clicking will display the  
following menu options: 

• Open With > Serendipity Client – Opens the selected file in the Client using the SoftProof application. 

The following will appear in the Services menu option for macOS, standard right-click menu for Windows: 

• Submit Asset (Serendipity Client) – Sends the selected file to Megarip as an Asset for use in Studio. 

• Submit  (Serendipity Client)  – Sends the selected file to Megarip for  processing.  The submit  window will  
appear to select the Pagesetup/Media/Jobticket processing combination. 

• Preview (Serendipity Client) – Open the selected file in the Client using the SoftProof application. 
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The Serendipity Megarip Server 
The Megarip Server runs on the machine where the dongle is installed. The Server handles the processing of all jobs 
through the system and must be started before the Client is launched. 

As the Server starts, it checks to ensure either a valid dongle is installed on the machine and which modules are 
enabled (licensed). The Server calculates the speed of the machine it is running on and checks the integrity of the 
database before loading it. 

Once the Server is up and running, a clock keeps track of the duration the Server is operational. 

Server Options 
The window displays the Server information and various options once it is running.

The main window will display the product and version, software build dates, dongle serial number, and a Maintenance 
end date (optional). The maintenance end date will only be shown if the dongle has a valid maintenance contract. 

Serendipity Megarip Menu Options 
• About – Shows information about the Server. 

◦ Server tab – Displays information about the Server including the version, build date, dongle type and 
serial  number,  and  the  highest  version  of  software  available  to  the  dongle.  Warranty  information  is 
displayed, and if the dongle also has a maintenance contract, the expiry date will be listed. 

◦ Licensed Drivers tab – Displays a list of enabled RIP, Output and Destination drivers. Select from the 
dropdown menu to display the available drivers. 

◦ Installed Updates tab – Displays a list of all software updates installed for the Server. 

◦ Connected Clients – Displays a list of all Serendipity Client or C5 Client connections to the Server. 

• Quit – Quit the Server application. 

File Menu 
• Stop Server – Stop the Server from running without quitting Serendipity Megarip. 

• Start Server – Start the Server if it is in a stopped state. 

• Restart Server – Restarts the Server. 

• Activate Software Dongle – Select this login option if you have an active Software Dongle License. A further 
popup window will  appear to Login. Once logged in, the Server can be started. This is only available for 
software dongle licensed users. Changes to Deactivate Software Dongle when logged in.

• Activate Subscription – Select this login option if you have an active Subscription. A further popup window will  
appear to Login. Once logged in, the Server can be started. This is only available for subscription users.  
Changes to Deactivate Subscription when logged in.

• Update Dongle – Allow users/administrators to update the dongle with activation codes to enable various 
input and output licenses. See the Dongle Updater section for further information. This is only available for 
dongle-based licenses.

• Close – Close the window. If the Server is running, a warning will appear to confirm Server shutdown. 
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Launch Menu
• Serendipity Client  – Open the Serendipity Client application.  This option is not available for Megarip C5 

product users.

• C5 Client – Open the C5 Client application. 

Startup Options 
• Start Server on Launch – The Server will start once the application is launched. 

• Restart Server on Crash – The Server will restart automatically after a crash. 

• Start as Cluster Node – Start the Server as a cluster node (slave) to be used by another Megarip Server for 
imaging and rendering tasks. Do not use this option before reading further information in the Applications >  
Clustering section of this manual. 

• Start in Safe Mode – Start the Server but cease all job processing. Safe mode is used for maintenance in the 
event a Pagesetup or other database item is corrupted, or is functioning incorrectly. Once maintenance is 
complete, the Server will need to be restarted in normal mode. 

• Theme – This dropdown menu allows the selection of an overall visual theme for the  Server window. The 
available options are: 

◦ Light –  Server appears in the standard Light Mode. The option matches how the  Server appeared in 
previous versions of the software.

◦ Dark – Server appears in Dark Mode, appearing predominantly in black/grey tones with white text.
◦ System –  Optional  item depending on operating  system.  Server matches the  light/dark  appearance 

configured for applications in the operating system settings. This is the default Theme setting.

Help Menu 
• Knowledge Base – Open the Serendipity Knowledge Base website (https://skb.serendipity-software.com.au) 

in the operating system’s default web browser.

• Troubleshoot Dongle – Open a Troubleshooting Dongles article in the Serendipity Knowledge Base (link). The 
article includes useful links to help diagnose dongle and server function issues for new installations, or when 
moving an installation and dongle to a new machine.

• Update Options – Configure a time for Megarip to periodically check for software updates. 

• Check for Updates – Immediately check for any software updates. 

• Install Local Updates – Manually update the software package by downloading (.pax) package files. See the 
Installing Manual Updates section for further information. 

• Install Additional Software – Open the Serendipity Updater application on the Additional Software tab, listing 
any new and uninstalled software components and/or printer screening drivers. Each item can be ticked for 
installation. 

• Rebuild Additional Software – This option is normally only to be use upon request by Serendipity Software 
support. This will run a fresh software scan that may require components to be downloaded and installed. 

• Clear Updates Cache – All updates applied by the Serendipity Updater application are stored locally. This 
option will clear the folder of all files. This does not affect any installed updates. 

• Backup  Server –  Perform  a  complete  backup  of  the  Server,  including  the  Workbench  database 
(defaultss.dbd, license, and ICC folders), Calcheck History database (databases folder), plus Server settings 
and preferences. 
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• Restore Server – Import settings from a previously saved Server backup (.backup or .ssb) file. 

Note – Server Backup (.ssb) files created using Blackmagic 9.1+, can be opened for a Restore by double-
clicking on the file, or by selecting the file on the desktop the choosing the Restore Backup (Serendipity 
Server) option from the file’s contextual (right-click) menu. 
Older pre-9.1 .backup files must be opened via the Restore Server menu option above.

For further information on the automatic software update functions, see the  Serendipity Updater  section of this 
manual. 
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Media Catalogue 
The Media Catalogue is a built-in feature designed to assist in the creation of new Pagesetup, Media and Output  
configurations, as well as allow for modification of existing Pagesetup and Media configurations. 

The  Media  Catalogue  accesses  the  Serendipity  Software  website  in  order  to  download  and  install  Media 
configurations for use within the Serendipity Client. 

Write access to the Workbench is required in order to use Media Catalogue, along with access to a Megarip Server  
and the internet. 

The application has two (2) options when opened: 

• Create New – Create a new Pagesetup, Media, and 
Output combination for use in the Serendipity Client. 

• Modify  –  Modify  an  existing  Pagesetup  and Media 
combination. 

Create New 

• Add a Pagesetup, Media, and Output to the Workbench. 

• Printer Driver – Select the output driver to use. A dropdown menu will display a list of available drivers. 

• Media Window – Once a driver is selected, any available Medias for download will be displayed. Clicking on 
the name will display the properties of the configuration to the right. 

• Back – Go back to the previous screen. 

• Next – Continue to the next configuration screen. 

• Close – Close the Media Catalogue. 

Setup for Media Window (Create New) 

• Pagesetup – The name of the Pagesetup being created. Rename as required. If the name already exists, a 
red cross will appear next to the field on the right. 

• Media – The name of the Media selected as per the previous screen. 

• Output – Use an existing Output from the Workbench or create new. 

• Use  Existing  –  Select  the  Output  to  use  from  the  dropdown  menu.  This  will  overwrite  the  current 
configuration. 

• Create New – Enter a name for the Output. If the name already exists, a red cross will appear next to the field  
on the right. 

• Select Bonjour Printer – Displays a list of available bonjour printers to assign to the Output. 

• Select Later – Create the Output with no destination set. This should be configured in the Workbench in order 
to send jobs to a printer. 

• Create – Create the Pagesetup, Media, and Output in the Workbench. Confirmation will appear when done. 
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Modify 

• Modify an existing Pagesetup and Media configuration. A Pagesetup with an Output using the driver to be 
modified must exist in the Workbench in order to make changes to the configuration. 

• Printer Driver – Select the output driver to modify. A dropdown menu will display a list of available drivers. 

• Media Window – Once a driver is selected, any available Medias for download will be displayed. Clicking on 
the name will display the properties of the configuration to the right. 

• Back – Go back to the previous screen. 

• Next – Continue to the next configuration screen. 

• Close – Close the Media Catalogue. 

Setup for Media Window (Modify) 

• Pagesetup – The name of the Pagesetup being modified. Select from the dropdown menu. Only Pagesetups 
relevant to the selected printer driver will appear in the list. If a Pagesetup does not exist, a red cross will  
appear next to the field on the right. 

• Media – The Media selected from the previous screen that will be assigned to the Pagesetup. This is a read-
only field. If a Media exists with the same name, a yellow warning will appear to the right. The option to 
rename (if required) will appear once the Modify button has been pressed. 

• Back – Go back to the previous screen. 

• Close – Close the Media Catalogue. 

• Modify – Modify the selected Pagesetup with the Media. Warning messages will  appear if  there are any 
duplications with names. These may be edited or overwritten as required. 

If there are no current Media configurations available for the selected output driver, a message will appear onscreen. 
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The Serendipity Updater 
The Serendipity Updater provides a simple and convenient way of updating Serendipity Megarip and standalone 
Serendipity Client applications. 

The Updater tracks the current software installation status and automatically checks for available software updates, 
bug fixes, maintenance patches, and new drivers. 

New updates are listed along with release notes, previously installed updates are logged in the Updater, and notes 
can be viewed at any time. 

Note: The Serendipity Updater requires access to the internet to function. Updates are not downloaded or installed 
until initiated by the user, as the Server and/or Client are shutdown as part of the update process. 

The following update functions are available in the Help menu of the Megarip Server application and/or the Help  
menu of the standalone Serendipity Client. 

• Update Options – Configure a time for Megarip to periodically check for software updates. 

• Never – The software will not check for updates. 

• When (Time/Day) – Configure a time/day to automatically check for any software updates. 

• Notify When Updates are Available – A message will appear onscreen when updates are available to install. 

• Check for Updates – Immediately check for any software updates. 

When configuring a time/day for checking for updates via the Server Help menu, a restart of the Server is required for  
any changes to take effect. 

Additional Software Tab 

This section will list any uninstalled or new drivers, or components that have not been installed. Items can be selected  
and installed individually as required. 

Note: The Serendipity Client installed on the Megarip Server machine is updated as part of Server updates and does 
not gain access to the “Check for Updates” Help menu option. If Secure Mode is active, users can be configured to 
receive an email when software updates are available. See the Accounts Admin section of this manual for further  
information on email configuration. 
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The Megarip Dongle Updater 
The Megarip dongle licenses the level (version) of software and enables any input drivers (RIPs) and output drivers 
that have been purchased. If any additional licenses are activated, the dongle will require updating in order to access 
them. 

The Dongle Updater is a built-in application, accessed via the Server File menu > Update Dongle option. 

To avoid misuse of the software license, activation codes are unique to each dongle serial number. Any updating 
should be completed by a Server administrator. 

Important Note: Before updating any dongles, ensure the Server is in Stop mode. 

BEFORE UPDATING 

There are two (2) versions of the Dongle Updater, depending on the type of dongle being used: 

1. Serendipity Driverless Dongle; or 

2. Sentinel SuperPro USB Dongle (legacy). 

Follow the instructions relative to the type of dongle installed. If you have any questions regarding the dongle and 
updating, contact Serendipity Software Support. 

Method 1 – Serendipity Driverless Dongle 

Updating the Dongle 

Before activating or updating the dongle, be sure to have access to the dongle code (update string). 

One (1) code is required in order to update the dongle, referred to as the Update String(on screen), or the Dongle 
Reprogram String (in the email). 

The encrypted string is very long and appears like this (Example Only): 

-----BEGIN SERENDIPITY LICENSE----- 

AAABABWM4I+am0j+p82g2eLX+JyR1xuY90/2ANYATtoPpYhw7SXMCHPEN50Kd/e5kSmBQXjHMko1kO/De9go 
PhpOalBTbjq4XyKr7vVmqi90GExLN6Qc97x3G51QlSlBiSVol9wbO7jDRK+n2o4zmCDWDmNHnRqPjIABc9os 
Xz17X1UQELSPz+2d0YrAcKP5I9OZUSjI0Cu1xbzyXOmMXOM8hHeDOnBUNxeYssMrHP96gOX8qAhvRoDzsaNg 
XBn/I9GetaLPDWt26pcArky2jXyzUJKByEWSbjZcoqL891bwnbsOvRNiuJZuymhWolhwMcbNHPXod+JEiTZv 
A5LfrU/sN4q8Ve2blf09mKQG80+ujn54oqqmW6Ax43SZRS/CUV0ohxEBDOgTGHPymLTCYPnSNHdi1fSIvVC3 
QbDAvtP5DLwaW7uyCiKlalvok5FcB7Ckm75Tuijy04zmHDr4ZXb1LdswBhA5n1a3v6u19W5cjBJwibor6Q1y 
W79gMmEvLYt8S79lYYYLfGqXmNGpvFlMjkTDBUzb90k5VqPbT7urBZfLHXdraef8xaLwrOdZ/K1WGmAQgPKi 
915sx4vpTA+v9yH/6kegpuhwI2uCoVGkum5cj/CzqqLXwWroPEXpc5GBGbWxVHy1zwTQ/nDakpIIr74= 

-----END SERENDIPITY LICENSE----- 

  

To Update the Serendipity Driverless Dongle 

1. Plug the Serendipity dongle in to the computer and run the Server application. 

2. Select the Server File menu > Update Dongle. The Server will stop. If there are any Client applications open,  
a Connect to Server window and/or disconnection message will appear. 

3. A window will open for the Dongle Updater application. 

4. Enter the entire update code (including the Begin and End lines) into the available field. It is best practice to  
copy and paste the code to avoid any keying errors. 

5. Once the code has been entered correctly, the Update Dongle button will be enabled. Click it. 
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6. A confirmation message will appear after the dongle has successfully updated and a Server quit and restart is  
required. 

7. Quit the Server application and restart. The dongle is now updated and any new filters and/or drivers will 
appear in the Serendipity Client for use. 

The code can also be loaded via the Load from File button, allowing the code to be imported directly from a stored txt 
file. The update code must exist in this document in its entirety. Incomplete or partial codes are not accepted by the  
Updater. 

Method 2 – Sentinel SuperPro USB Dongle 

Updating the Dongle 

Before  activating  or  updating  the  dongle,  be  sure  to  have  access  to  the  dongle  codes.  Codes  are  sent  from 
Serendipity Software directly, or via your Dealer on purchase of the software. 

Two (2) codes are required in order to update the dongle, referred to as Key Code 1 and Key Code 2. 

The codes are located in the “Dongle reprogram string” field of the email and are separated by a space. 

The first, long string is Key Code 1. The second shorter string is Key Code 2. 

For example:

If the string reads “cc81b1c62047f2adf14836466d4722df707c0f1ba887c23b 3180e9c3bd17776602” 

Key Code 1 would be: cc81b1c62047f2adf14836466d4722df707c0f1ba887c23b 

Key Code 2 would be: 3180e9c3bd17776602 

  

To Update the Sentinel SuperPro Dongle 

1. Plug the current USB dongle in to the computer and run the Server application. 

2. Select the Server File menu > Update Dongle. The Server will stop. If there are any Client applications open,  
a Connect to Server window and/or disconnection message will appear. 

3. A window will open for the Dongle Updater application. 

4. Enter Key Codes 1 and 2 into the relevant fields. It is best practice to copy and paste the codes to avoid any 

keying errors. DO NOT COPY THE SPACE BETWEEN THE CODES. 

5. Once the codes have been entered correctly, the Update Dongle button will be enabled. Click it. 

6. A confirmation  message  will  appear  after  the  dongle  has  successfully  updated  and  a  Server  restart  is 
required. 

7. Quit the Server application and restart. The dongle is now updated and any new filters and/or drivers will 
appear in the Serendipity Client for use. 
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When updating from Version 3 or below, before restarting the Server: 

1. Go to the installation directory for Megarip on the computer. 

2. Open the lib folder. 

3. Open the printers folder. 

4. Sort the files by date. 

5. Delete all old files ending in *v.so 

6. Once the files have been deleted, the Megarip Server can be restarted. 

Note: Failure to remove the old files from the printers folder will noticeably slow down the Server when it is restarting. 

  

Rescuing a Serendipity Driverless Dongle 
In the event the Serendipity driverless dongle has been compromised, or the license installation directory has been 
deleted or has not been correctly recovered from an update, the following procedure is available to recover the 
Serendipity dongle information. This is not available for any Sentinel SuperPro USB dongles. 

Important Note:  To avoid any problems, Serendipity Software always recommend a complete Server and Client 
backup. The license folder (including contents) will be saved when a Server backup is run. The Server backup can 
be accessed via the Server menu > Help > Backup Server. 

If a Server backup has been done for Version 9.1 (Serendipity Driverless Dongle Only), the dongle can be rescued 
by restoring the backup. 

To Restore a Version 9.1 Backup: 

1. Plug the Serendipity driverless dongle into an available USB port. 

2. Run the Megarip Server application. 

3. Select the Server Help menu > Restore Server option. 

4. A message will appear to confirm the restore. Click Yes. 

5. A message will appear stating the Server will need to be shutdown to continue. Click Yes. 

6. Navigate to the Server backup file location and click Open to restore from the backup. This can take a few  
minutes to complete. Do not close any applications during the restore process. 

7. Once successful, a message will appear to confirm the restore. Click OK. 

8. Restart the Server. The dongle should now be restored and licenses available for use with the Serendipity 
Client application. 

To Rescue a Serendipity Driverless Dongle: 

1. Plug the Serendipity dongle into an available USB port. 

2. Run the Megarip Server application. 

3. A message window will appear with the following message: 

“No useable  dongle  found.  If  you have a  valid  license string  you  can  enter  rescue mode and repair  a 
damaged dongle. Enter rescue mode? Yes/No.” 
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4. Click Yes to continue. You must have a rescue dongle license string from Serendipity Software to continue. 
This is  NOT  the same as a dongle update string. If you do not have a license string, contact Serendipity  
Software Support to arrange. An email will be sent with the relevant information. 

5. Once the correct dongle license string has been entered, the Rescue Dongle button will be available. Click 
when ready. 

6. A confirmation message will appear to state the dongle has successfully been rescued. Click OK. 

7. Quit the Megarip Server and restart. 

8. If the  license  directory was deleted (or not recovered with a Server backup file), an update string will  be 
required to reactivate the dongle. To confirm if a dongle has been activated: 

9. Click the Serendipity Megarip Menu (Mac) or the File menu (Win). 

10.Select About. 

11. In the About window, select the More/Less button to view the enabled licenses for the dongle. 

12.If this is blank, the dongle requires activation. If input and/or output drivers are listed as per your purchase, 
the dongle does not require further activation. 

To Activate the Serendipity Dongle 

1. Run the Server application. 

2. Select the Server File menu > Update Dongle. The Server will stop. 

3. A window will open for the Dongle Updater application. 

4. Enter the entire update code (including the Begin and End lines) into the available field. It is best practice to  
copy  and  paste  the  code  to  avoid  any  keying  errors.  The  update  code  is  referred  to  as  the  “  Dongle 
Reprogram String” in any email correspondence from Serendipity Software. 

Note: If you do not have the dongle update code, contact Serendipity Software Support for assistance. 

5. Once the code has been entered correctly, the Update Dongle button will be enabled. Click it. 

6. A confirmation message will appear after the dongle has successfully updated and a Server quit and restart is  
required. 

7. Quit the Server application and restart. The dongle is now updated and any input drivers and/or output drivers 
will appear in the Serendipity Client for use. 

The code can also be loaded via the Load from File button, allowing the code to be imported directly from a stored txt 
file. The update code must exist in this document in its entirety. Incomplete or partial codes are not accepted by the  
Updater. 
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The Serendipity Client 
The Serendipity Client is a graphic user interface (GUI) used for configuration, maintenance, and monitoring the 
Megarip Server. 

The Client can be installed and run locally on the same machine, or from any supported computer on the network 
using TCP/IP protocol. There is no limit to the number of Client connections to the Server, and each Client will have 
its own settings specific to the user. 

Once installed, the Client connects to a Megarip Server and loads the settings into the Client interface. Any Client can 
access the job management information and view the current status. The configuration can be open to all users, or  
protected via Secure Mode, which allocates specific access for created users and user groups. 

For more information on how to setup secure access, see the Secure Mode section of this manual. 

Look and Feel 
There is a common theme and functionality to the Client,  with many ways to complete the same task, such as 
configuring a Pagesetup from the QueueManager. Various options are available using the right-click menu to bring up 
other contextual menu options. This will vary depending upon the section of the Client interface being used. 

Anywhere there is a chooser to select an item from the database, a search field will be indicated by a magnifying  
glass. Entering text in the search field filters the list, showing only the matching items. The search can be inverted 
with CMD+SHIFT+I (Mac) or CTRL+SHIFT+I (Win) to hide the matching items. The search box will turn black to 
indicate inverse searching. Pressing ESC will dismiss the search. 

There are two (2) main sections to the Client – the Workbench and the Jobs application. 

• The Workbench is used to configure the various parts of the Server. This is used to create queues, setup 
input paths and various calibration functions. 

• The Jobs application is used for managing and viewing jobs as they pass through the system. 

The  Applications  and  Modules  add functionality  and provide  tools  for  managing  the  Server  and jobs  passing 
through it. There are also menu options containing system utilities and preferences. 

Workbench 
The Workbench is where the main software configuration takes place. Medias, Pagesetups, Jobtickets, Output paths 
and correction curves can all be set up here. 

When items are created or changed in the Workbench, they are saved to a database read by the Server each time at 
startup. The database can be backed-up and copied to other (Version 9.1) Megarip Servers. 

The Workbench is a split window. The Data Types list displays the database item categories that can be selected for  
creation or editing. The items list shows the available database items within each category. The grey area shows the 
settings and options for each item. 

The Data Types section has two (2) views – Browse and Search. Browse allows the user to view and select any of  
the items for display. The tab containing the magnifying glass flips to a search window, which acts like a filter showing  
any items containing the search text. 
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Workbench Menu Options 

Application 
Access all available applications via this menu. Each application will open in its own separate window. 

• System Settings (Windows OS) – Access the System Settings (Preferences) for the Serendipity Client. This 
option is available under the Serendipity Client Menu for macOS users. 

• Quit (Windows OS) – Quit the Serendipity Client application. This option is available under the Serendipity 
Client Menu for macOS users. 

Submit 
• Files – Select files to submit to a Pagesetup/Media/Jobticket combination for processing. 

• Files as Asset – Select files to send to the Studio asset queue. Assets will appear in the QueueManager 
queue as thumbnails but are not processed until submitted for printing from the Studio application. 

• ICC Target – This is the standard option that should be used when calibrating a printer Media and submitting 
an ICC target to generate an output ICC profile. Files submitted using this option utilise the Paper Profile,  
Linearisation LUT, and Correction LUT in the Media but are not ICC corrected. 

Note: This is the standard option for submitting an EPS or TIFF ICC chart used for creating an output ICC profile 
when calibrating a printer Media. 

• ICC Target  without  Colour  Correction  –  Submit  an  ICC target  to  a  selected  Pagesetup/Media/Jobticket 
combination. All ICC options and colour correction curves are disabled. A message will appear to confirm the 
option before submitting. 

• Test Prints – Submit one or more internal test prints. 

• Test Prints as ICC Target – Submit one or more internal test images as an ICC target. This allows users to 
store a commonly used ICC target chart in the “lib/testprints” folder for easy access when calibrating Media. 

File 
• New – Create a new item in the database. 

• Save – Save changes made in the database. 

• Duplicate – Make a copy of the currently selected item. 

• Revert – Reload the last saved version of the selected item. 

• Delete – Delete the currently selected item. 

• Print – Print the details of the selected item. 

• Get Info – Open a popup window displaying General and Ownership information for the selected item. The 
General  panel  displays  the  type,  created,  and  modified  timestamps for  the  item.  The  Ownership  panel 
displays the User and Group permissions for the item. 

Note: The User and Group will be listed as “admin” for normal installations. If secure mode is active, a user with  
sufficient privileges can make changes to the item permissions with respect to other users. When in secure mode, 
the admin user login is able to change the user or group to which the item belongs. If multiple items are selected, the  
admin user can make a mass change to the permissions of all items. 

• Add to Archive – Add the selected items into a new Archive window. See the Archives section for further  
information. 

Serendipity Megarip Product Manual – Version 9.1
42



• Database  Utility  –  Opens the  Database  Utility  to  show and  optionally  delete  unused Workbench items; 
Undelete items; repair broken items; and perform database maintenance. See below for further information 
on this function.

• Export as C5 Pack – Export Media files from the Workbench to a specific location for use with the C5 Client. 

• Export/Import Folders – Export or import the folder structure used within the Workbench. It will not import or  
export the contents. 

Database Utility
In addition to the database backup provided by the Archives application and Server Backup function, the Workbench 
keeps its own backup and item version storage to maintain database integrity for day-to-day use.

The  Database  Utility  provides  a  simple  interface 
enabling users to verify and maintain the health of the 
configurations  integral  to  Megarip  colour 
management, print, and proofing workflows.

The utility is accessed via the File menu, or right-click 
contextual  menu  when  highlighting  an  item  in  the 
Workbench datatypes list. 

The  interface  has  four  (4)  tabs:  Unused,  Deleted, 
Broken, and Maintenance.

Unused Tab

This tab displays the list of Workbench database items and ICC profiles not currently referenced by any other item, 
i.e., not assigned or used as part of a functioning proof / print configuration.

The left panel lists the items, item type, and the last time the item was modified. Right-click in the column headers to  
change the displayed columns. When an item is selected, the right panel shows detailed item information.

Options: 

• Update – Update the data displayed in the Unused tab to reflect any changes made to the database since the 
Database Utility was opened. 

• Archive & Delete – Add and save the selected unused items to an (.sdb) archive via the Archive application, 
then Delete it from the Workbench database. The operation will then close the Database Utility. 

• Delete – Delete the selected unused item/s from the Workbench database.

• OK – Close the Database Utility.

Deleted Tab

This tab displays items that have been deleted from the Workbench, item type, the last time the item was modified, 
the time it was deleted, and the time the item expires. Right-click in the column headers to change the displayed 
columns.

Deleted items are held by the database for a period of 90 days, after which they expire and are permanently deleted.  
Until then, deleted items can be restored to the Workbench at any time manually, or as part of a database repair  
operation (see below).
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Options:

• Update – Update the data displayed in the Deleted tab to reflect any changes made to the database since the 
Database Utility was opened.

• Undelete – Restore the selected item to the Workbench database.

• OK – Close the Database Utility.

Broken Tab

This tab displays corrupt database items, and “broken” items that no longer function because one or more other 
database items they were referencing are corrupt, or have been deleted.

The list shows the broken items, item type, and the last time the item was modified. Right-click in the column headers 
to change the displayed columns.

Options:

• Update – Update the data displayed in the Broken tab to reflect any changes made to the database since the  
Database Utility was opened.

• Repair – Perform a repair on the selected broken item, retrieving missing or deleted items from the internal 
backup if they are available, re-assigning them to the broken item, then restoring the item to the Workbench 
database.

• Edit  –  Open an edit  window for  the selected broken item,  allowing it  to  be  manually  repaired.  Missing 
elements of the item will be displayed in red italics.

• OK – Close the Database Utility.

Note: The Broken tab will rarely contain items. The Server performs a database integrity check on start, automatically  
repairing any damaged or  broken items using data  from the internal  backup.  If  the Server  cannot  be restarted 
because it is being used in an active workflow, a database integrity check can be performed manually using the Verify 
Database option in the Maintenance tab (below).

Maintenance Tab

This tab is used for database maintenance, integrity checks and repair.

The tab displays a standard Server Log window for error tracking if required (refer to the Modules > Server Log  
section of this manual).

Options:

• Verify  Database  –  Manually  run  an  integrity  check  on  the  existing  Workbench  database,  automatically 
repairing any damaged or broken database items using data from the internal backup. This function is the 
recommended method for repairing the Workbench database.

• Verify Rolling Backup – Manually run an integrity check on the Workbench internal rolling backup, ensuring all  
items and item versions have been correctly backed up.

• OK – Close the Database Utility.

 

Edit 
• Undo – Undo the last change. There are multiple undo options configured via the Client Settings section. 
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• Redo – Redo the last undone change. There are multiple redo options, depending on the undo status and 
configuration in the Client Settings. 

• Find – Open a text box at the bottom of the Workbench panel to locate the search text on the screen. 

View 
• Split Vertical/Horizontal – Change the view to either vertical or horizontal split on the screen. 

• Show Type Column – Used in conjunction with Show Usage to display the type of data listed. 

• Show Modified Time Column – Display the last modified time for the time items listed. 

• Show Usage – Display the items within the database that the currently selected item uses (e.g., a Pagesetup 
would show the Media and Output it uses). 

• Reverse Usage – Reverses the usage shown (was called Show Referrers in previous versions). 

• Organise Data Types – Organise data types in the Workbench list into related categories. This is the default  
view. 

Modules 
Access all available modules via this menu. A floating window will appear for each separate module opened. 
For further information, see the Modules section of this manual. 

Server 
• Server Settings – Access the system settings or preferences for the Megarip Server. For more information, 

see the Server Settings section of this manual. 

• Connect to Server – Select a Megarip Server to connect to on the available network. 

• Resume/Pause Processing – Pause or resume all  job processing and print queues. Queues pause after 
completion of the current task. 

• Accounts Admin – An authorised administrator can create, modify, and manage user accounts and groups. 

• Chatterbox – Chat to other users connected to the same Server. The Chatterbox window will  display the 
Clients connected to the Server. A nickname can be entered in the Client Settings, otherwise the machine 
name is used. If  the users name cannot be selected, the user has selected the Away option and is not  
available. 

• Broadcast Message – Send messages to all users connected with a Client to the same Server. Selecting the 
Broadcast option displays a message window to type into and send. The message is displayed on the users  
screen for a short time and will automatically dismiss if it is not acknowledged by clicking OK. 

• Download PPD – Download the Megarip PPD from the Server to the desired location. Use the PPD when 
installing a local printer. When installed, the PPD (postscript printer description) is selected as the printer  
driver when setting up a Megarip Published Pagesetup as a print destination for third-party applications. 

Window 
• Bring All to Front – Shows any open window of the Client and can be selected to bring it to the front. 

• Cycle Through Windows (CMD+` or CTRL+`) – Cycle through the open windows within the Client. 
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Help 
• Server  Info –  Provides  information  about  the  Server  including  version,  platform,  speed,  processors, 

hostname, IP, product, and vendor. 

• What's This – Select and click on any part of the interface to display a short help description. 

• User Manual – Open a PDF of the Megarip manual. 

• Knowledge Base – Open the Serendipity Knowledge Base website (https://skb.serendipity-software.com.au) 
in the operating system’s default web browser.

• Media Catalogue – Open the Media Catalogue application to download and install Pagesetup/Media/Output 
configurations in the Workbench. See the Media Catalogue section of this manual for further information. 

• The following three (3) options will appear when using the standalone Serendipity Client: 

◦ Update Options – Configure a time for Megarip to periodically check for software updates. 

◦ Check for Updates – Immediately check for any software updates. 

◦ Install  Local  Updates –  Manually  update  the  Serendipity  software  package  by  downloading  (.pax) 
package files. See the Installing Manual Updates section for further information. 

• Backup Client Preferences – Perform a backup of the Client settings. A window will  appear to choose a 
location to save the file. The backup will save Client preferences, folder structure within the Workbench, and 
Client layouts. This does not save jobs, database items or ICC profiles. 

• Restore Client Preferences – Import settings from a previously saved Client backup (.backup or .scb) file.

Note – Client Backup (.scb) files created using Megarip 9.1+, can be opened for a Restore by double-clicking 
on the file, or by selecting the file on the desktop the choosing the Preview (Serendipity Client) option from 
the file’s contextual (right-click) menu.

Older pre-9.1 .backup files must be opened via the Restore Client Preferences menu option above.

Contextual Menu (Right-Click)

In addition to selected File menu options listed above, the following are available via the contextual (right-click) menu: 

• New Folder – Folders are a great way to organise the data types list items. Folders are client based, meaning 
each user can have their own folder configuration if required. 

• New Folder with Selection – Place any selected items into a new folder. 

• Remove Folder – Remove the selected folder, placing items within the folder back in the general items list. 

• Open/Close Selected Folders – Expand or collapse the selected folders to show or hide the items within. 

Note: Folders in the items list are internal to the Serendipity Client, used to organise database items. They are not 
operating system file folders. 
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Workbench Data Types 
The following data types (databases) within the Workbench are used to accurately process jobs. 

• Calcheck Chart – Provide a validation check for a hardcopy proof or a monitor. 

• Camera – Set up a camera ICC profile for use with the SoftProof application when viewing RGB images. 

• Gradation Curve – Adjust colour in a job by applying a curve to the individual process colours. 

• ICC Tweak Set – Build up a library of colours that need “tweaking” for accurate output. 

• Jobticket  – Controls  the input  screening,  resampling,  ICC matching,  rendering intents,  effects,  fitting or 
scaling, and other options applied to incoming jobs. 

• Media – Control configuration settings for output, colour correction, ICC profiles, screen printing, and output 
screening. 

• Output – Determine where processed jobs are to be output as files, to a printer, or to a remote location. 

• Pagesetup – Where the desired output, media, and alternative job submission methods are assigned. 

• Pagesetup Pool – Print to one or more Pagesetups. 

• Paper Profile – Define the paper and ink characteristics of the Media being used by the output driver/device. 

• Press – Contains the colour and dotgain attributes of a press. Used by the SoftProof application to show to 
effects of printing a job on a particular press. 
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Calcheck Chart 
The calcheck chart data type is where charts are configured and stored for use in colour validation checks. The charts 
are comprised of user-created or imported colour patches, along with target standards and tolerances. These items 
are saved to the database and can be used or adjusted at  any time. The calcheck chart is then used in conjunction 
with the Calcheck application to provide a validation check for a hardcopy proof or a monitor. 

Once the chart is setup it normally never needs to be changed; the standards to be used are saved with the chart. 
When reading the chart with the Calcheck application, simply load it and measure. If you wanted to use a different 
standard, this is done in the chart and not the Calcheck application. 

The chart can be attached to a job as it passes through the Jobticket and Pagesetup, or printed from the Calcheck 
application. 

The window shows a list of the patches on the right and colour information on the left. For each patch selected its Lab 
values, delta tolerance and patch type can be adjusted. The overall target preferences are specified in the lower half  
of the panel. 

Toolbar Options 

The following options are available via the toolbar at the top of the panel: 

• New Colour – Create a new colour in the list with default* values. Values and colour names can be adjusted. 

• Delete Colours – Delete the selected colours from the list. 

• Duplicate Colours – Make copies of the selected colours. Use shift or ctrl keys for multi-selection. 

• Rename Colours – Change the name of one or more colours. 

• Import Patches from Files* - Import a patch set from a colour data file, such as those of colour standards or 
ICC profile makers. 

• Reorder Patches – Reorder the patches. Selecting this will display another window to select one or more 
colours and drag them into a new order. Use the up and down arrow keys and shift or control to multi-select. 

• Generate Patches from ICC – Select an ICC profile from which to create a set of patches. Selecting this 
option displays a file chooser to select an ICC profile. A prompt will appear for the number of patches to 
generate. The minimum number is 16, maximum is 512. 

• Add Colours from Library – Add colours to the chart from a special colour set.

*Note:  When creating or importing new colours they are stored with the default  tolerance settings. This is user 
configurable and should be set before the patch set is created. 

Patch Definition 

On the left are a series of controls used to define each patch. Selecting a patch from the list will load the colour into  
the colour match box at the top, and load the Lab/CMYK/RGB values into the respective fields. To change the value, 
simply type the new number into the relevant field. 

• Lab (or CMYK/RGB) – The Lab (or CMYK/RGB) value for the selected colour. 

• Δe tolerance – Set the maximum Δe value for the selected colour. 

• ΔH tolerance – Set the maximum ΔH value for the selected colour. 

• ΔCh tolerance – Set the maximum ΔCh value for the selected colour. 
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• Patch Type – Identify important patch types from the set. The options are: 

◦ Paper – Select the patch that represents the paper being checked. 

◦ Cyan/Magenta/Yellow/Black – Identify a patch for each colour from your set. 

◦ Gray – Used to identify gray patches in the chart. 

◦ Generic – Most patches are generic and are classified as generic if they don't fall into one of the above 
types. 

Note: When generating patches from an ICC profile, the patches are automatically assigned the correct type. 

Target Standards 

There are three (3) standards that can be used to compare against a proof. These are Δe, ΔH, and ΔCh. 

The first standard, Δe, is always enabled. The other two standards must be enabled for the results to appear on the  
calcheck. To enabled, select the tab and tick the Target checkbox. 

For each standard, specify the limits used for a pass and fail status. For Δe, also choose which of the Δe standards  
are to be used – deltaE, CIE94, CIE2000, CMC(1:1), or CMC(1:2). 

Important Note: The correct standard to be tested must be selected and saved with the chart. Only that standard will 
be tested for a pass or fail. If you are checking another standard, change it here and save again. For example, if you 
are checking deltaE and you want CIE2000 you will need to change it, save, and re-measure. 

The limits are: 

• Average – For all the patches in the chart that will be measured by Calcheck, the average must be below this  
value for a pass. 

• Maximum – This is the default value used when creating or importing patches. This value is only used for  
assigning the maximum tolerance for the import. When the target is measured, the tolerance set per patch is 
the one used to determine a pass or fail status. 

• 95th Percentile – 95% of measured Δe/H/Ch patches are expected to have a delta of less than or equal to the 
entered value. A value of 0 disables the metric.

• Standard (Std) Deviation – The standard deviation across all the patches must not exceed this value. 

The Calcheck will only report a pass for a proof or monitor if all patches in the target chart are within tolerance. 

• Patches Per Strip – Specify  how many patches are  printed per  line,  allowing the use of  existing target 
standards, such as the Fogra Media Wedge. 

Spectrophotometer 

• Spectrophotometer – Choose a supported spectrophotometer to read colour values directly into the Calcheck 
Chart. 

• Configure – Select the measurement condition and/or other options available to the connected instrument. 
This option is only available to instruments with configuration options.

To measure colours: 

1. Select an instrument from the dropdown menu and click Activate. The device must be connected and turned 
on. 
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2. Follow the onscreen instructions, as some devices require calibration before measuring. 

3. When complete, click the Turn Off button. 

4. If the Lab text option is chosen, a prompt will appear to select a file to import. The format must be Lab values, 
space, or tab delimited, and no header information. 

Note: If importing characterisation data from one of the ICC profile packages or colour standards, use the Import 
Patches From Files option. 

Patches 

This section of the window displays the patches in the set. Each patch shows its respective colour, name, and Lab  
values. There is also a patch type and the tolerances for each standard. The tolerances are assigned when the 
patches are created or imported and are based on the settings on the left. 

A tolerance setting can be altered by selecting the colour and entering a new value in the relevant box. 

Chart type – Select from Lab (default), CMYK, RGB, or N-Colour (Multi-channel) colour spaces to define the patch 
colour values.

Press ICC Profile (button) – Opens a popup ICC chooser window to select and assign a Press ICC profile to define  
the values for device colour (non-Lab) chart types.

Search 

Above the patches list is a search box. Enter a string to filter out any patches not required and locate those that are.  
All fields within the panel are searched. The search can be inverted using CMD+SHIFT+i (Mac) or CTRL+SHIFT+i  
(Win). The box will appear black when the inverted search is enabled. 
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Camera 
The camera data type is used to define an RGB (or camera) ICC profile colourspace for use when viewing RGB 
images in the SoftProof application. 

Users can configure whether the default camera profile or image embedded ICC profile is automatically selected and 
applied to an RGB image when opened in SoftProof. See Applications > SoftProof > SoftProof Settings for further  
details. 

Colour Management 

• Profile – Select the Camera ICC profile to assign. 

• Rendering Intent – Select the rendering intent to be used. 

• Black Point Compensation – Enable or disable black point compensation. 

• Calcheck  Chart  –  Assign  a  calcheck  chart  for  camera  colour  verification  checks  using  the  Displays 
application. 

Gradation Curve 
A gradation curve is used to adjust colour in a job by applying a curve to the individual process colours. The gradation 
curve can be applied to a Media, either as a linearisation curve or as a correction curve. A linearisation curve is  
normally applied as part of the early calibration stage and is recommended. A correction curve is applied if a small 
amount of fine-tuning is required after normal calibration procedures. 

Toolbar Options 

• Trace Saved Curve – A green line appears, showing where the curve was last saved and where the curve 
has been edited. 

• Invert Curve – Invert the selected curve. 

• Gradation Table – Enter values manually to adjust or create a curve. 

• Preview Curves – Displays a window with all curves in their respective colours so they can be assessed in  
relation to each other. This is updated dynamically as changes are made. 

• View Linearisation – Load a linearisation curve directly into the Lineariser application. 
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ICC Tweak Set 
Build up a library of colours that need tweaking (adjusting) for accurate output with the ICC Tweak Set data type. A 
tweak set alters colours during the ICC mapping stage from input to output profile and is selected on a per Media  
basis. The ICC profiles are not edited in any way and the tweak set can be selected as desired. Each colour requiring  
alteration is selected and adjusted by adding to or subtracting process colours from it, or making it lighter or darker.  
An accurate visual representation is shown onscreen and the point in the colourspace can also be viewed. Colours  
can be created manually or by entering CMYK or Lab values, or input automatically using a spectrophotometer. 

The interface is split  into two parts – the left  side shows the input  values and the right  side shows where any  
adjustments (tweaks) have been made. 

Options 

• Colourspace – Select between Input Profile or Lab input. If the profile selected is RGB, the sliders will change 
to RGB. If CMYK, the sliders will change accordingly. 

• Influence – Choose the area around the specified colours to be affected. This is determined as a scale from 1 
to 5, with 1 being the least influence and 5 the greatest. 

• Tweak Value – Use the CMY sliders to add or subtract from the colour being adjusted. 

• Rendering Intent  – Select  the rendering intent  that  the colour is to be altered in from either perceptual, 
colourimetric, or saturation. This must match the rendering intent of the Jobticket for the mapping to work. 

• New Tweak – Create a new tweak in the rendering intent selected. 

• Copy – Available via the right-click menu. Copy the selected tweak. 

• Paste – Available via the right-click menu once an item has been copied. Paste the copied tweak from the 
clipboard to the rendering intent selected. 

• Change White Point – Change the white point of the paper. Select the button and enter the X,Y,Z points. If a  
spectrophotometer is connected, the white point can be measured directly into the system. 

• Zoom – Zoom in and out of the Lab colourspace to see the point being tweaked in relation to the whole 
space. 

• L-value – Move up and down the L-value to see the point being tweak in relation to the lightness. Reset the 
value by clicking the ReCentre button. 

• ICC Profiles – Select the input and output profiles being used to tweak. These must match the ones selected 
in the Media, as they are stored with the tweak set and are used during the mapping process. 

• Spectrophotometer – Select an online spectrophotometer to read values directly into the tweak set. Once 
selected, press the Activate button to connect and take measurements. If the device is being used by another 
application (including a Serendipity application), it will fail to connect. Quit or disconnect all others first. 
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Jobticket 
The Jobticket consists of configurable options used to manipulate an incoming job for the desired output. A Jobticket 
can be linked to a specific Pagesetup configuration or created on-the-fly via the submit dialog window. 

Colour Management Panel 

Manage 

• Always  Use  ICC –  Enable  to  always  use  the  assigned  ICC profile  for  jobs  submitted  to  the  Jobticket, 
Pagesetup  and  media  combination.  If  this  is  not  enabled,  the  ICC  profiles  selected  are  only  used  in 
colourspace conversion. This is the default option for any new Jobtickets created. 

• Honour Embedded ICC Profiles – Enable to use an ICC profile embedded in a submitted TIFF, JPEG, or EPS 
file as the input match profile. When enabled, the embedded file profiles will always take precedence over  
any match ICC assigned. 

• Process Grayscale as Black – When enabled, this option converts and processes grayscale PDS, JPEG, 
BMG, TIFF, and PNG files submitted to the Jobticket as process black (K). 

Note: The TIFF Image output driver has an option to embed an ICC profile into TIFF files that are output by Megarip. 

• Black Point Compensation  – Designed for use when processing input from large gamut sources such as 
photographs and RGB images. Black Point Compensation enhances shadow details in these images; assists 
when viewing shadowed areas in non-ideal or everyday lighting conditions; and prevents flooding in CMY 
gray areas. 

This setting only functions when using colourimetric rendering intent and when Always Use ICC is enabled. Black  
point compensation should not be used for normal CMYK proofing jobs which are generally well within the gamut of  
an output device (inkjet printer). 

• Retain Pure Black – When ICC profiles are used, all colours – even solids – are made up of a mix of different  
colours. Selecting this option uses only black for areas containing just black. When enabled, the following 
options become available: 

◦ All – Uses black ink only in areas defined as black. 

◦ Text – Uses black ink only in elements defined as black text. This can improve the clarity and sharpness 
of the text. 

Note: This option is not always suitable for use with printers using light black inks, as many of these inks tend to  
have a non-black hue. 

• RGB Input Profile – Select an RGB input ICC profile. This is used to convert data input from an RGB source 
to Lab for colour management. 

• RGB Input Rendering Intent – Select the rendering intent to use. Options include: 

◦ Perceptual – All colours are moved proportionally to each other so the eye perceives the colours to be  
correct (i.e., colours out of gamut move into gamut, and those in gamut move proportionally to those out 
of gamut).

◦ Relative Colourimetric – Those colours out of gamut are moved into gamut, and those in gamut are left  
untouched. 

◦ Absolute Colourimetric – The colours are left alone so those out of gamut cannot be reproduced. Adjusts  
the white point of the media to match that in the input ICC profile. 

Serendipity Megarip Product Manual – Version 9.1
53



◦ Saturation – Those colours out of gamut move into gamut, but all colours increase in saturation as a  
result. 

• Press Input – Select a press profile. This is a match ICC profile and is used to convert input data from CMYK  
to Lab. This can be a multicolour profile or CMYK. 

• Inks – Define a press ink set for a multicolour press ICC profile if  the selected profile does not contain  
process ink names. Selecting this option displays a special colour set chooser to select a pre-defined press 
ink set, or to create a new set. 

Important Note: For multicolour profiles to work, you must create the same colour names used in the ICC and have 
them in the same order. The order for the ICC is specified during ICC creation. This is independent of the actual 
press order. Change the order by dragging the colours around the set. The order is specified as the colour (left 
column), order descending. 

• Press Input Rendering Intent – Select the rendering intent to use. Options include: 

◦ Perceptual – All colours are moved proportionally to each other so the eye perceives the colours to be  
correct (i.e., colours out of gamut move into gamut, and those in gamut move proportionally to those out 
of gamut). 

◦ Relative Colourimetric – Those colours out of gamut are moved into gamut, and those in gamut are left  
untouched. 

◦ Absolute Colourimetric – The colours are left alone so those out of gamut cannot be reproduced. Adjusts  
the white point of the media to match that in the input ICC profile. 

◦ Saturation – Those colours out of gamut move into gamut, but all colours increase in saturation as a  
result. 

• Press Inks Preview – When a colour set is chosen via the Inks button, a preview of the colour swatches will  
appear. 

• Upload ICC – If the ICC profile is located somewhere other than the default ICC folders, use this function to  
upload it to the Server ICC folders in order for it to be used. As this is a Client-side option, use this function 
for moving ICC profiles from the machine they were created on to the Server. This can be either on the LAN 
or WAN as a remote machine. 

Verify 

• Print Calcheck – Attach a calibration strip to every job passing through this Jobticket. The calcheck results 
(green pass, red fail) will change the colour of the job information shown in the QueueManager when the job  
is processed. 

• Chart – Select the chart to use from the popup window. 

• Device – Select the instrument to be used to measure the chart. The chart will be printed in the correct format  
for the selected device. 

Note: The Calcheck Chart is a data type in the Workbench. This is where the chart is created. Use the Calcheck 
application to measure and verify the printed chart. Printer embedded spectro charts are measured immediately after 
printing and the results are stored within the Job Info in the QueueManager. 
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Process & Resampling Panel 

Processing 

• Resolution – Select either 8-bit or 16-bit processing for any incoming jobs. 

Note:  Megarip  V9.1 is  able  to  accept  files  submitted in  a  16-bit  format.  The files  are  normally  processed and 
rendered in standard 8-bit colour, which for many workflows is sufficient for proofing. 16-bit processing improves 
render quality and can be useful for finding artifacts within a job. When 16-bit is enabled, files submitted to the  
Jobticket  in  8-bit  are  upscaled  to  16-bit  for  processing.  16-bit  mode  requires  more  system  memory  for  
imaging/rendering jobs and produces larger output files. 

Resampling 

Configure the method for sampling incoming data and changing the resolution from the input to that of the output. The 
options are: 

• Nearest Neighbour – The fastest method but less accurate. Choices are made as the closest pixels from 
input to output and can result in jagged edges or stepping effects. 

• Bilinear – A medium quality sampling method and can take longer than Nearest Neighbour. Bilinear takes the 
weighted average of 4 pixels from input to output. Best for use with screened data. 

• Bicubic  –  High quality  sampling  method which takes longer  to  calculate  than Bilinear.  Bicubic  uses the 
weighted average of 16 pixels from input to output. 

• Filtered – Serendipity's own sampling method, giving the highest quality.  It  takes longer to process than 
Bicubic, and uses an averaged area from input to output. This setting provides better resampling for contone 
data, such as postscript and PDF. Filtered is the default setting. 

• Antialiasing – Choose from 2x2, 3x3, 4x4, or None. Antialiasing is designed to smooth jagged edges and is 
used when the output does not have sufficient resolution to display edges smoothly. The values increase the 
amount of pixels used for antialiasing. The default setting is None. 

Fit & Rotate Panel

Fitting 

• None – Fitting method is disabled. 

• Fit Width/Height/Width & Height – Shrinks jobs to fit within the set dimensions; proportions are maintained. 

• Scale Factor – Scales jobs by the amount specified. 

• Tiles – Tiles a job that is larger than the width & height specified. If required, an overlap can also be entered.  
Useful for large posters or billboards. 

• Best Fit Width/Height/Width & Height – As Fit (above) but will  shrink or enlarge jobs to fit/fill  dimensions 
entered while maintaining proportions. 

• Stretch Fit Width & Height – Stretch or shrink the width  and height of the job to the dimensions specified, 
ignoring the native proportions. 

Note: If the Fit or Best Fit options are chosen and the width & height fields are left at 0, the fit will default to the media 
width and height as defined in the assigned Media, adjusted by the printer Hardware Margins (see Media for details). 

• Override Media Size – When enabled, values entered in the width and height fields will override the Media  
width and height settings when the job is processed (see Workbench > Media). 
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Rotation 

Method (dropdown) – All jobs submitted via the Jobticket are rotated by the selected angle. Options include: 

• None – Rotation is turned off. Jobs are processed at the orientation of the file.

• Auto – Jobs are rotated to use the least amount of media, e.g. portrait jobs will be turned to be landscape. It  
is recommended that a Media Width be defined when using this setting to prevent jobs that will not fit across 
the media from being rotated, cutting off part of the job when printed.

• 90 / 180 / 270° - Jobs are rotated by the selected angle.

• Angle – Jobs are rotated by the positive or negative angle (###.##°) entered in the Angle field. 

Note: Auto rotation is very useful for saving media, but if a job is rotated it takes longer to process – the larger the  
job,  the  longer  the  process time.  Rotation takes place at  the beginning of  the rendering phase and will  affect  
cropping, margins and so on. If auto-rotating when nesting, it is advisable to have Sheet Auto Rotation turned off,  
otherwise the job rotation will be calculated twice, again increasing the process time. Increasing system memory can 
also improve processing times. 

Step and Repeat

Copy and place the submitted job horizontally and/or vertically below the original, separated by a distance equal to 
the spacing field. The horizontal and vertical fields are multipliers. Optionally add cropmarks to each image.

Step and Repeat will repeat a single image only. If multiple files are submitted at the same time, each will result in its 
own step and repeat job with the configured setings.

• Enable Step and Repeat – Checkbox to enable the function.

◦ Horizontal Repeat – The number of times to repeat the image horizontally.

◦ Vertical Repeat – The number of times to repeat the image vertically.

◦ Spacing – The space between each image.

◦ Cropmarks – Select from None, Default, Paper-saving, Border.

• Studio Template – This button opens the Studio Template chooser window, allowing a template to be attached 
to the Jobticket. When Step and Repeat is enabled, and a template is selected, all jobs submitted via the 
Jobticket will be placed into all template frames, at the pre-configured size, proportions and scaling for each.

This feature replaces the standard Jobticket Step and Repeat feature when used, disabling it. To cease using 
a Studio Template and re-enable Step and Repeat, press the button then select None at the bottom of the 
chooser window.

Note: Only text boxes and normal frames are honoured when using a Studio Template in Jobticket. All other 
frame types such as canvas wrap, frame with border, and markers are ignored and will not be printed.

Centre & Size Correction Panel 

Centring 

• Centre – Select  these options to centre a job vertically or  horizontally  on the printer  Media.  Centring is  
automatically adjusted for printer Hardware Margins (see Media for details). 

• Override Media Size – When enabled, values entered in the width and height fields will override the Media  
width and height settings when the job is processed (see Workbench > Media). 
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Size Correction 

• Enable Size Correction – When enabled, enter a width and height factor to compensate for media stretch or 
paper feed errors by specifying a correction amount.  An article outlining how to calculate the correction 
amount  can  be  found  on  the  Serendipity  Software  Knowledge  Base:  https://skb.serendipity- 
software.com.au/calculate-size-correction-6-0-1968/ 

Crop & Pad Panel 

Cropping 

Imaging 

• Auto Trim Whitespace – When enabled this  feature automatically  crops white  space around the image, 
stopping at the first coloured pixel encountered on each side. 

 Note: When both Auto Trim Whitespace and specific cropping values are enabled, each image side will be cropped 
by the larger of the two values. The values are not cumulative. 

 

Rendering 

• Left/Top/Right/Bottom – Apply cropping to the submitted job during rendering phase to select or all sides of a 
job. 

Padding 

Add whitespace to a submitted job by entering values in the Left/Top/Right/Bottom fields. Any padding will be applied  
to the job after the imaging and rendering cropping effects (if any). 

Padding will increase the overall size of the final job when output. 

Effects Panel 

Rendering Effects 

Various effects can be applied to jobs passing through the Jobticket. Effects are applied in order of appearance. 
Some effects have separate attributes for customisation and can be edited once they are in the Applied Effects 
column. 

The effects are: 

• Barcode (JobID) – Place a barcode containing the JobID outside a job.

• Bleedmarks – Place bleed marks around a job. Line width, length, bleed and clearance can be specified.

• Border – Place a border around the job. Line width and colour can be specified. 

• Centring – Centre the job in the specified page area. 

• Convolution Matrix  –  Design a  filter  effect  according to  a pre-defined mathematical  operation known as 
convolution. 

• Cropmarks – Place crop marks around a job. Line width, length and clearance can be specified. 

• Edge Detect – Remove all content and just leave the edges. 

• Fotoba Cut Marks – Print user-configurable cut marks around jobs for subsequent cutting/trimming by Fotoba 
Digital Print Cutter devices. 
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• Image Overlay – When enabled this effect allows a Blackmagic Image, JPEG, PNG, PPM, Photoshop, or 
TIFF file to be placed anywhere on the job. Settings include width, height, and opacity for the overlaid image  
plus options to allow it to stretch and rotate with the job. 

• Lines – Draw a line(s) at the top, bottom, left, or right of a job. Define the line thickness and colour, clearance 
from the job. A 'Draw around the original imaged page' option is available, which measures line Clearance 
from the submitted job edges, ignoring the placement of other render effects. 

• Margins – Specify margins around the job. 

• Mirror – Mirror the job. 

• Negative – Render the job as a negative. 

• Pagenumber – Place the page number in the middle of the page as a watermark. Scale factor and opacity 
can be configured, and choose between page number of the job or the page number of the signature (when  
using de- imposition). 

• Rectangle – Draw a rectangle around the job inset at the desired distance, line width, and colour. 

• Registration Marks – Add registration marks at each corner of the submitted job. Line width, inner and outer 
radius are all configurable. This is not available when using the Studio application. 

• Slugline – Place job information on the job. There are a number of options available via the Edit button. If  
using a narrow format paper and the full slugline doesn't fit, select Custom Slugline and turn all options on. 
This will show an item per line. Within custom, fields selected will only be printed if they are relevant to the  
job. The slugline can also be mirrored, a useful option when printing to film using a white ink printer. 

• ThruBlack –  Set  a  black  threshold  level  above  which  black  areas  are  removed  from an  image  during 
rendering. This is useful when printing an image containing black onto a black surface. 

• Unsharp Mask – Apply an unsharp mask to the job. The unsharp mask effects the edges within an image and 
can be controlled with the available parameters. The radius determines how large an area to affect around 
the edges. The larger the radius, the greater the effect and the longer it takes to process. If the preview  
resolution is high, a given radius will have less effect than if the resolution is lower. If the detail is quite fine, a  
smaller radius should be used. Higher radius values can also cause halos at the edges. The threshold gives a 
level that should be affected where 0 affects more of the image and 255 very little. The amount states the 
size of the change, where a higher value is a greater change at the edges. 

• Watermark – Place a watermark across a job. The scale of the watermark is proportional to the size of the  
job. 100% represents the same size as the job in the smallest direction. If the stretch option is selected, 
horizontal  and  vertical  sides  are  stretched  to  the  scale  amount.  The  watermark  will  be  scaled  in  an 
anamorphic manner. EPS files only. 

Logo 

Position a company logo, sign-off slugline, or colour bar for checking consistency anywhere around the job. The logo 
passes through the same colour management as the job and can therefore be verified. The file is not rotated during 
output (except if Auto Rotate when Nesting is enabled in the Output). If the logo file is positioned along the left or right  
sides, the EPS file should be created in the appropriate orientation. 

• Enable Logo – Turn the logo effect on or off. 

• Dimensions – Enter the print dimensions of the logo. 

• Logo File – Select to choose a logo file. 
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Imaging Effects 

Any checked effects will be applied to the job during the imaging phase of processing, before any rendering effects 
are applied. 

• Mirror – Mirror the job. 

• Negative – Invert the job colours producing a negative of the image. 

• Discard Alpha – Discard any alpha channels in the file when processed. 

Postscript/PDF Options Panel 

The following options are only used for incoming postscript data. 

• Use Bounding Box for Page Size – Some postscript jobs do not place a page size in the job information.  
Checking this will use the bounding box as the page size. 

• Fail on RGB Images – Causes a job to fail if it contains RGB images. If this is not checked, the jobs will  
process but RGB images will be ignored and not printed. 

• Antialiased Subsampling – Used to assist in the rendering of some fonts. 

• Disable PDF Autoseparation – Turn off autoseparation for PDF files. 

• Render in RGB – Allow postscript file data to be processed in an RGB rendering mode, with a wide gamut 
suitable for digital photographic proofs/prints. 

• Honour Embedded Screening – Screen and LPI angles are extracted from Adobe separated postscript files 
(only) and used, overriding Media configured halftone output screening LPI and angles.

• Use CMYK Simulation from PDF for Unknown Colours – Allow the CMYK simulations from PDF files to be 
substituted for unknown spot colours. This is the default option for any new Jobtickets. 

• Use PDF filename as jobname – When submitting PDF files, the filename can be used as the Jobname 
instead of the Title tag.
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Media 
The Media data type contains all of the settings controlling the output of jobs as they pass through the Megarip colour  
management system for proofing. Settings configured here are those directly related to the output device, colour  
correction, ICC profiles, screen printing, and output screening. 

A media  can be one of  several  assigned to  a  Pagesetup,  with  an additional  Jobticket  which controls  the input 
screening, resampling, rendering effects and intents for incoming jobs. All jobs are submitted to a combination of 
Jobticket, Pagesetup, and media destinations. When submitting, the user selects the Pagesetup to be used, at which  
point a list of compatible, user- created output Media types in the database become available for selection. 

A default media is assigned to a Pagesetup, so if a job is submitted without a specifically chosen Media, the job will  
output to the default Media settings. An output data type can optionally have a Media type assigned to it, in which 
case only  jobs submitted to the output  using the assigned Media will  be printed.  All  other  jobs are held in  the  
QueueManager until the assigned Media is removed from the output, or the held jobs Media type is assigned to the 
output. 

Important  Note:  Older  version  Pagesetups  when  opened  in  version  9.1  are  automatically  split  into  Jobticket, 
Pagesetup, and Media types. Version 9.1 archives cannot be back ported. 

Output Driver Panel 

• Output Driver – Select the output driver from the popup window. Those available will depend on what options 
are enabled for the dongle. Click the Edit button for configuring any custom settings. 

Print & Media Settings Panel 

• Resolution  –  Select  or  enter  the  desired  resolution  (dpi).  If  the  output  is  a  printer  only  the  supported 
resolutions are available. If it is a file format, any value can be entered. 

• Colourspace – Select the output colourspace as desired. Selections will  change depending on the driver 
selected. 

• Override Hardware Margins – Optionally set the Top / Left / Bottom / Right margins for the selected printer.  
These values should be the hardware margins of the printer, defining the maximum limit of printable area. 
The margins are utilised by Megarip when functions such as image placement and centring are used. 

The fields are auto-populated with the printer default  margins when the information is available from the  
driver. 

• Media Width/Length – Set the width and length of the media. Only jobs submitted with a width and length  
equal  to  or  less  than  the  assigned  values  will  be  printed.  Jobs  of  greater  size  will  be  held  in  the 
QueueManager until an appropriate Media or new values are assigned. 

Note: Media Width/Length values override the width/length settings in the Nesting section of the Output, meaning 
jobs will not nest or print until within the width/length settings of the Media they were submitted to. 

• Cut Sheet – Enable this if the Media being printed to is cut sheet. The Media to be used is selected from the  
dropdown menu. 

◦ Manage Custom Sizes – Create and manage custom page dimensions for use. Any page sizes created 
here will also appear in the Studio application > Media panel > Page Size section. 
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Note: Borderless Printing – If available to the printer model, users can choose borderless printing in the custom 
settings. If selected, media width (and the image fit setting) needs to be set to 6mm wider than the actual paper  
width. When using borderless printing, up to 3mm of the image will be lost from the left and right sides of the image,  
and 1mm lost from the top and bottom of the image. 

• Total Sheets – Enter the number of cut sheets loaded in the printer. Jobs will stop printing to the Media and 
be held in the QueueManager when MediaStatus has tracked that the assigned number of sheets has been 
used. A total sheets value of zero assumes an unlimited sheet availability for tracking. Sheet count is reset  
using the Reset Counter button in the Usage panel. 

Colour Management Panel 

ICC Profiles 

ICC profiles are used to match colours from one device to another, for example, a press to an inkjet. It does this by  
mapping an input to an output colour. 

• Output ICC Profile – Select an output profile. This is the printer or other output profile and is used to convert  
Lab data to the output colourspace. This output could be RGB, CMYK, CMYKOG, or N- colour, depending on 
the output device and the selected colourspace. 

• Output ICC Tweak Set – Select a tweak set from the available list. Lists can be previewed, edited, or new 
ones created. 

• Device Link Profile – Select a device link profile. If the job passing through does not match the colourspace of  
the device link profile, the standard input and output profiles selected will be applied. 

Upload ICC – This option is available on all of the ICC profile choosers, and is used to upload an ICC profile from a  
local or network folder to the internal Megarip ICC folder. 

To upload an ICC profile: 

1. Click the Upload File button. 

2. Browse to the location of the ICC file. 

3. Open the file. 

4. Select the location to save the file (lib/icc is the default). 

5. Click OK. 

6. Save the setup once the file has been uploaded. 

Colour Correction 

There are three (3) options for use to manipulate or fine-tune the colour to achieve the desired results: 

• Paper Profile – Select a paper profile to be applied. If the output is to a printer, this is also part of the standard  
calibration process. 

• Linearisation LUT – Select a linearisation LUT to be applied in the form of a gradation curve. This is normally  
done as part of the standard calibration process with the use of the Lineariser. Preview, edit, or create new 
curves. 

• Correction LUT – Select a correction LUT to be applied in the form of a gradation curve. Preview, edit, or  
create new curves. 
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Output Screening Panel 

Apply screening to the output file if desired. This is only available if the output driver selected supports screening. 

• Method – There are two (2) methods available – FM Screening, or Halftone. 

FM Screening

FM Type 

• Stochastic – Standard stochastic screening. 

• Stochastic-2 and 3 – Stochastic screening with progressively increasing amounts of noise mixed in. This is 
done to overcome some artifacts caused by inkjet printers. 

• Stochastic Fast – A fast version of the stochastic screening mode. Slightly lower quality than stochastic. 

• Error Diffusion – May enhance edges within images. 

• Ordered Dither – Applies a threshold map on the pixels displayed, causing some of the pixels to be rendered 
at a different colour. 

Note: When Screen Print Mode is enabled, Stochastic is the only FM screening type available for use.

Plates List 

The list on the left of the panel displays the process colour plates and special plates (8 by default) available.

The number of special plates available for use can be configured in the Colour Tab of Client Preferences (see the 
System Settings > Client Settings section of this manual).

Defaults

• Plates Column – Lists the plates that have been selected for screening. 

• Type – Lists the selected screening FM type for the plate.

• Dot Scale - Size (Microns) – Lists the plate dot scale and corresponding dot size (in Microns) as configured 
via the Edit button.

• Edit – Edit screening options for the selected plate. Double-clicking on the plate in the list will also open the  
edit options window. 

◦ Exclude Plate – Enable to exclude the selected plate from separations. Excluded plates are indicated in  
red. 

◦ FM Options: 

▪ Dot Scale x (1-10) – Sets the scale factor for FM screen dot size (higher number = coarser screen, 
larger dots). The dot size (in microns) is inversely related to the printing resolution (dpi). Default is 1. 

▪ Dot Size:  Shows the resulting dot size in microns for the chosen Dot Scale at the current output  
resolution. 
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Halftone Screening  (Traditional Rosette Dot) 

• Dotshape –  Choose  the  dot  shape  to  suit  requirements  from round,  inverted  round,  elliptical,  inverted 
elliptical, diamond, euclidean, or line. This is applied to all plates in the Defaults panel and can only be edited 
via the Output Screening Overrides section. 

Defaults

• Plates Column – Lists the plates that have been selected for screening. 

• Type – Lists the selected screening (Halftone) type and the set angle & frequency for the plate.

Halftone Options

• SuperCell – Choose SuperCell screening instead of standard halftone. Produces a much better quality output 
than standard halftone. This is the default option for halftone screening when enabled. 

• Defaults – Use this to select the default values based on the output resolution. 

Edit Button – Select this to manually enter values. 

• Exclude Plate – Enable to exclude the selected plate from separations. Excluded plates are indicated in red. 

• Angle,Degrees – Enter the desired angle for each plate. 

• Screen,LPI – Enter the desired screen ruling for each plate. 

Output Screening Overrides 

Screen one or more colour plates for any incoming jobs using different methods or with different characteristics than 
the defaults configured in the Output Screening panel. 

Plates List 

The list on the left of the panel displays the process colour plates and special plates (8 by default) available for 
screening override. 

The number of special plates available for use can be configured in the Colour Tab of Client Preferences (see the 
System Settings > Client Settings section of this manual).

Override List 

• Plates Column – Lists the plates that have been selected for screening override. 

• Type – Lists the selected screening type for the listed plate, along with details such as screening angle, LPI,  
dot shape, and dot scale if applicable. 

• Remove – Remove the selected plates from the override list, reverting them to the default output screening  
option. 

• Edit – Edit screening options for the selected plate. Options are detailed in the Output Screening sections  
above. Double-clicking on the plate in the override list will also open the edit options window. 

Screen Printing Panel 

The screen printing mode separates a job into single plates and prints them as black. This is designed to print with a 
halftone dot onto a clear film media. To increase the density of the output, choose a combination of inks. This option 
can be used to produce films for use in screen printing or inkjet CTP (computer to plate). 

• Enable Screen Print Mode – Turn the screen print mode on or off. 
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Note: In screen printing mode, all jobs are separated into individual channels and must use a paper profile 
where only one dot for each colour is turned on.

• Simulate Screening – When enabled, this option simulates halftone screening for output from Media using 
HTM or Printer's Screening (contone) printer drivers. Usable in both CMYK and RGB print  modes. Only  
available when an appropriate printer driver is selected.

Note:  When using simulated screening,  only halftone screening may be used. If  stochastic  screening is 
selected as part of an Output Screening Override, the submitted job will fail.

• Ink Combination – Select the inks to be combined for a single separation output. 

Note: When simulated screening is enabled in RGB print mode, Red, Green, and Blue “inks” will be available  
for selection. If these are left unchecked (recommended) all channels are used by default to produce black 
print output. In CMYK mode, ink(s) may be selected as normal.

Media Status Panel 

Usage 

The Usage panel shows the amount of media used, based on the values entered for Media Length. 

• Usage Meter – Bar showing the amount of media used. Text under the bar shows the exact amount as “Used 
x Units of Total Units” (Percentage %). 

• Logged Period – Time period (date and time, from and to) the Media has been tracked since the last reset. 

• Printed – Number of jobs and total printed area of jobs tracked since the last reset. 

• Reset Counter – Reset the usage count for the Media. 

Calcheck Info 

A Media can have its calibration status checked using the Check Media option within the Calcheck application. 

The panel displays the current calcheck calibration status of the Media, with the following information displayed: 

• Chart – The calcheck chart used for calibration. 

• Date – The date and time of the calcheck. 

• Score – An internal calcheck rating from 1 to 100. 

ΔE, ΔH, and ΔCh tabs show the following data for each of the standards (if measured): 

• ΔCyan, ΔMagenta, ΔYellow, ΔBlack, ΔGray, ΔPaper. 

• Pass or Fail – As designated by a green tick or a red cross. 

• ΔAverage, ΔMaximum, ΔStandard Deviation. 
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Output 
The Output data type determines the output format of processed jobs and where they are sent for printing (or file  
output). 

Printer & Media Panel 

• Output Driver – Select the output driver from the popup chooser window. Driver availability will depend on the 
options enabled on the dongle. The selected driver affects the options in a Jobticket and Media pointing to it. 

• Monitor Printer Status – Allow a QueueStatus module to display current status, ink levels, warnings and error 
messages for the output printer via the Show Printer Monitor Status option. Available to compatible printer  
drivers only. 

• Media – Optional. Select this to assign a Media to the Output. A chooser window will  appear with Media 
displayed matching the output driver type. The options as set in the selected Media are displayed for view, 
can be edited, or a new one can be created. 

Note: The Change Media option is used as both a safeguard against paper waste and a workflow control method. If 
a Media type is assigned to the Output, only jobs submitted to the Output using the same Media will be printed. All  
other jobs are held in the QueueManager until the Media they were submitted to is assigned. If no Media is assigned,  
all jobs sent to the Output are printed. 

Connection Panel 

• Destination Driver

The destination determines the method of delivery of the output job to the final destination. Depending on the driver 
selected, there may be some additional options available. 

A popup window will appear to select the destination. Options include: 

• Bonjour/Zeroconf  –  Output  to  a  bonjour/zeroconf  network  destination.  The  local  network  is  polled  for  
bonjour/zeroconf devices. Choose Edit and select the appropriate destination from the list. 

• Command/Script – Select a script or command to be run once a job has completed. 

• Epson FireWire (macOS only) – Windows users should use the Local Print Queue option and print to an 
installed printer, configured to use FireWire. 

• FTP – Send a completed job to a remote machine using FTP. 

• Local Device – If a printer is connected as a serial or parallel printer, send a file directly to the device with this  
option. 

• Local Folder – Choose a local folder to send the output file to. Enter the path or select Choose to browse and 
select a folder. The folder must exist and have write permissions. 

• Local Print Queue – Print to a local print queue. Use this to print to a Windows printer on another machine. In 
the path location, enter \\machine\printer where “machine” is the name of the Windows machine with the 
printer attached, and “printer” is the exact name of the printer. The printer must be shared. 

• LPR Port – Use LPR to print jobs to printers accepting it. Enter the hostname/IP address of the printer and 
the path. Not all devices require a path to be entered. This is a good option for Epson printers with a network 
card. This method is faster than TCP/IP printing for these devices. 

• Nowhere – Used for internal testing or for softproofing workflows. Files created by the print driver are not sent  
anywhere, they are left in the default raster location. A print time for simulation can be entered. 
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• Secure FTP (sftp) – Send the job to a secure server using FTP. 

• TCP/IP Port – Print to a networked device over TCP/IP. 

• USB Printer – Print to a printer connected via USB. 

Queue Control Panel 

• Status – Choose whether an output queue is active (available to print/output), or inactive (paused). This can 
also be controlled from a QueueStatus module. 

• AutoPause – Select a time duration the queue should pause after processing a job. Used for double-sided 
plotters so there is a pause in sending the next job, giving the plotter time to turn a sheet ready for the back  
side to be printed, or time to load another sheet. 

• AutoClean – Automatically  delete  printed jobs from the output  queue based on times and/or  number  of 
completed jobs in the queue. Auto-cleaning is performed the next time a job is submitted after an auto-
cleaning condition has been met. Options include: 

◦ Keep Most Recent – Set a number of jobs. Megarip will keep that number of most recent printed jobs in 
the output queue, automatically deleting any excess jobs. 

Note:  If  this is enabled and the number of  jobs is  set  to zero,  jobs will  be deleted from the queue  
immediately after printing. 

◦ Keep Jobs Newer Than – Megarip looks at the time signature of printed jobs and deletes any jobs in the 
queue older than the specified (days/hours/min) time. 

Nest / Duplex Panel 

Nest 

There are two methods of  collating available,  depending on the output  driver  selected.  If  a  driver that  supports 
duplexing is selected, the additional duplexing collation method becomes available. If not, the only option is nesting. 

• Enable Automatic Nesting – Set the queue to nest jobs automatically when the configured conditions (such as 
maximum wait time) are met. 

• Auto Rotate when Nesting – Enable auto rotation when nesting occurs. If this is enabled, make sure the 
option in the Jobticket is set to None. There is no need to spend processing time rotating a job if it is rotated  
at nesting time. 

• Minimise  Cuts –  When automatic  nesting  is  active,  this  option  will  align  the  nested jobs  in  a  way that 
minimises the number of horizontal and vertical cuts required to separate the individual jobs after printing. 
Note: This option may use more media (paper) when nesting. 

Options include: 

◦ None - Minimise Cuts is inactive, and not used for nesting calculation. 

◦ Horizontal - Standard Minimise Cuts option. Jobs are nested as described above. 

◦ Horizontal (Automatic Cutter) - Jobs are nested into rows with top edges aligned. Compatible with the use 
of automatic digital cutters. If nested jobs are of the same height, cut marks can be placed along the 
bottom edge of jobs for a clean automated cut of each row. 

◦ XY (Automatic Cutter) -  Nesting is arranged into rows compromised of jobs of the same height, and 
where possible into columns where jobs also share the same width. Suitable for use with automated 
horizontal or horizontal/vertical (XY) cutters. 
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• Group by Publication – When active, a special nesting option is applied to jobs / pages submitted as part of a  
publication. This includes: multi-page postscript / PDF documents; jobs submitted via a Pagesetup with the 
Auto Publication Name option active.

Pages are nested on the output Media in numerical order, in rows from left to right, down the media. All other  
nesting  parameters  are  respected,  except  Auto  Rotate  and  Minimise  Cuts,  which  are  disabled  for  this 
purpose. Nesting is delayed, as in Duplexing, until all publication pages have finished rendering.

• Copies – Specify the number of copies for nesting. For example, if there are 7 jobs making up a nest, and 5 
entered in the copies field, 5 copies of the 7 jobs will be nested and printed. 

• Maximum Wait Time – Specify how long to wait before nesting begins. Once reached, nesting will begin and 
any job waiting to nest will  be nested into a single job. The start time is determined by the first job that  
appears waiting to nest. 

• Minimum Paper Coverage – Specify the minimum paper coverage to be reached by jobs waiting to nest  
before nesting will begin. Once reached, any waiting jobs will be nested into a single job. 

• Maximum Jobs – Specify the number of jobs in a nest. If there are more jobs in the queue that the number 
specified, that number of jobs will nest and the remaining jobs will stay waiting to nest until the criteria is met 
again. 

• Media Width – Specify the media (paper) width. This is required for nesting to work. 

• Gap Between Jobs – Enter the size of the gap between jobs in the nest. 

• Minimum Total Height – Specify the minimum total height of a nest i.e., if the combined height of the jobs  
waiting to nest reaches this value, nesting will begin. 

• Maximum Total Height – Specify the maximum total height of a nest i.e., if the combined height of the jobs  
waiting to nest reaches this value, nesting will begin. 

Note: If a maximum height is set, the nesting algorithm will look at all the jobs waiting to nest and fit the most jobs  
between the minimum and maximum heights. If the available jobs can not cover the defined paper coverage (if set) 
of paper without exceeding the maximum height, jobs will not nest. If no paper coverage minimum is set, any job that  
would make the nest exceed the maximum height will be left in the queue – the other jobs will be nested. Any single  
job exceeding the maximum height will also not print. If a job is too large, the nesting parameters and/or the printer  
media must be changed. This makes it possible to effectively and efficiently nest using cut sheet media. 

Duplex 

Duplex jobs with multiple pages to form double-sided printing. This is only available for printers supporting duplexing 
modes. 

• Add Separator Page – Add a blank page between duplexed sets. This is useful when duplexing perfect bound 
jobs. A blank page is inserted after the maximum jobs is reached for duplexing to begin. 

• Top Page – Determine if the top page is an odd or even number. 

• Maximum Wait Time – Set the time to wait before duplexing begins. If the maximum wait time is reached and 
the back side of the pages has not yet been processed, the queue will begin to duplex any available pages.  
This will result in single pages where the backs are not yet completed. 

• Maximum Jobs – Set the maximum number of jobs for duplexing. If this value is reached, duplexing will  
begin. 
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Maintenance Panel 

The  maintenance  panel  allows  Megarip  to  be  configured  to  automatically  perform  printer  maintenance 
functions. This is not available for all  printer drivers. Maintenance functions can be performed at regular  
intervals; after a set number of print jobs; or after printing linearisation charts and ICC targets. 

Time-based 

• When – Select Every from the dropdown menu to activate time- based maintenance, with configurable time 
and day fields. Multiple days of the week can be selected. 

◦ Perform Actions: 

▪ Calcheck – The printer will print a calcheck chart as specified. 

▪ Clean Print Head – The printer will clean the print head. 

▪ Print Nozzle Pattern – The printer will print a nozzle check pattern to verify all print nozzles are clean 
and functioning. 

▪ Nozzle Check – The printer will perform a nozzle check. 

Job-based 

• Every – Enter a number in the field or use the arrows to set the selected maintenance to be performed after  
the defined amount of print jobs. 

◦ Perform Actions: 

▪ Calcheck – The printer will print a calcheck chart as specified. 

▪ Clean Print Head – The printer will clean the print head. 

▪ Print Nozzle Pattern – The printer will print a nozzle check pattern to verify all print nozzles are clean 
and functioning. 

▪ Nozzle Check – The printer will perform a nozzle check. 

Calibration-based 

• After Printing: 

◦ Linearisation Chart – The printer will print a nozzle check pattern immediately after printing a linearisation 
chart. If the pattern is incomplete, the print head will need to be cleaned and the chart reprinted. 

◦ ICC Chart – The printer will print a nozzle check pattern immediately after printing an ICC target chart. If 
the pattern is incomplete, the print head will need to be cleaned and the chart reprinted. 

Calcheck Settings 

• Chart – Specify the calcheck chart to be printed when the above Calcheck option is selected.

Note: The calcheck chart will only print if there is a valid Media attached to the Output via the Change Media button. If  
the calcheck fails, the output will be made inactive automatically. 

• Pagesetup – Select the Pagesetup to use when processing the calcheck chart maintenance option. 
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Manual 

• Command - Select a command from the dropdown menu to manually perform the maintenance function on 
the selected Output device. This will only appear for any printer drivers with this capability. Only commands 
supported by the specific printer driver will be shown. 

◦ Refresh  Media  Library  –  This  feature  allows  immediate  retrieval  of  updated  driver  media  library 
information from the printer, without waiting for the scheduled 24-hour update check.

• Execute – Initiate the selected printer maintenance function or print. 
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Pagesetup 
A Pagesetup is where the desired Output, Media, and alternative job submission methods are assigned. 

Output Options Panel 

• Output – Select the output method and assign its configured properties to the Pagesetup. 

• Media – Select the default media settings and assign its properties to the Pagesetup. If a job is submitted to  
the Pagesetup without the specific Media, the job will output using these default settings. 

• Jobticket – Select the default Jobticket settings and assign its properties to the Pagesetup. 

Options 

• Priority – Assign a priority to a Pagesetup. All jobs submitted via the Pagesetup have this Priority assigned to 
them. Priority ranges from -100 (highest) to (100) lowest, with 0 being the default. As jobs pass through each 
queue – Imaging, Rendering and Output – they are processed in order of priority, highest to lowest. Job 
priority can be changed during processing using the Change Priority and/or Rush Jobs options. (See Modules 
> QueueManager for further details).

• Auto Publication Name – Create unique publication names for each job passing through the Pagesetup. Use 
this feature for duplexing from PDF or PS files. Submitting a multi-page document as one job will allocate all 
pages with the same publication name. 

Publish Panel 

This section allows a Pagesetup to be published on a network as a DropFolder, or as a network print destination for  
printing from a third-party application. To publish a Pagesetup it is necessary for the Serendipity Megarip PPD to be  
installed on the same system as the Megarip Server (Server menu > Download PPD). 

• Publish DropFolder – Allocate a folder where files can be dropped for processing. Valid file types include 
postscript, PDF, JPEG, TIFF Image, Serendipity Blackmagic Image, EPS, PNG, PSD. 

• Location – Set a folder as a DropFolder location. The folder must exist and have read/write permissions. 

• Default  –  Reset  the  DropFolder  location  to  the  default,  i.e.,  Serendipity  Megarip  installation 
directory/drop/”Pagesetup Name”. 

• Parse filenames for metadata – When enabled, this function parses files placed in the DropFolder, searching 
for certain defined metadata strings appended to the end of the filenames. Each string automatically applies 
one of three (3) submit window functions to the file. Any combination of the three (3) strings can be added to  
a job filename. The useable strings are:

◦ #rotate - which rotates the file 90 degrees for printing.

◦ #copies=X - where X is the number of copies of the file to be printed.

◦ #pages=X-Y - where X and Y are the lower and upper pages in a page range to be printed within a multi-
page job.

◦ #media=media name - where 'media name' is the Item name of a specific compatible Media, allowing the 
job to be printed using defined Media, rather than the Pagesetup default.

◦ #jobticket=jobticket name - where 'jobticket name' is the Item name of a specific Jobticket, allowing the 
job to be printed using defined Jobticket, rather than the Pagesetup default. 
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Examples  of  renaming  a  file  named Testfile.pdf  prior  to  placing  it  in  the  Dropfolder  are  as  follows:
Testfile.pdf#rotate
Testfile.pdf#copies=4
Testfile.pdf#pages=2-5
Testfile.pdf#rotate#copies=5#pages=3-4

Testfile.pdf#media=SatinPhoto260
Testfile.pdf#jobticket=A1poster
Testfile.pdf#jobticket=A1poster#media=SatinPhoto260#rotate 

• Printer  –  Publish the Pagesetup as a  network  print  destination,  allowing third-party  applications to  print  
directly to it. 

◦ Mac  –  Publish  the  Pagesetup  as  a  bonjour/zeroconf  network  destination  for  macOS  and  Linux.
Note: When adding a new printer through System Preferences on macOS, select the bonjour address 
(Pagesetup name@computer name) as the printer and Serendipity Megarip PPD as the driver. 

◦ Windows – Publish the Pagesetup as a Windows local printer port destination. 

◦ TCP Port – Publish the Pagesetup to a TCP port, allowing it to be setup as an IP printer destination, or as 
a destination for other Serendipity Megarip Servers. 

▪ Port Number – Enter the TCP port number the Pagesetup will publish to. It is necessary for the port 
number to be 10000 or above, and for each Pagesetup to have a unique port. 

Note: When adding a new printer through System Preferences on macOS, select IP printer, HP Jetdirect-socket for  
the protocol. The address should be in this form: computername:10063. Select Serendipity Megarip as the driver. 

When adding a new printer through Windows: 

1. Select Create a new Port – Standard TCP/IP port. 

2. Enter the computer network name in the Host ID field. 

3. When Windows requests additional info for the port, select Custom Settings. 

4. Rename the port if required. 

5. Set the Protocol to Raw and the Port Number to match the one set in the Pagesetup to be published. 

6. Select Serendipity Megarip as the driver. If the driver is not already installed, choose Have Disk and get the  
driver (megarip.inf) from the Serendipity installation DVD, win\”OS Version” directory. 

Flow Control – Select whether to hold the submitted file after imaging or rendering in order to prioritise jobs, make 
rendering attribute changes before releasing, or nest jobs. Flow Control options are only applied to jobs submitted via  
a DropFolder, a Published network destination, or a DropSpot.

Options include: 

• Hold After Imaging – Hold jobs submitted to the published Pagesetup after imaging has completed. Held jobs 
can be released to continue processing via the QueueManager toolbar or right-click menu. 

• Hold After Rendering – Hold jobs submitted to the published Pagesetup after rendering has completed. Held 
jobs can be released to continue processing via the QueueManager toolbar or right-click menu. 

• Nest – Nest jobs submitted to the published Pagesetup according to the criteria defined in the output used by 
the Pagesetup/Media. 
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Note: The nest function only requires that the output used has nesting configured. The output itself can have  
nesting disabled for normal use. This makes it possible to create multiple nesting or non-nesting published 
Pagesetups to print via the same output. 

• Duplex – Duplex jobs submitted to the published Pagesetup using the settings configured in the Outputs used 
by the Pagesetup/Media.

Note:  The Next and Duplex functions only require that the Output used has nesting and/or duplexing (if  
available) configured. The Output itself can have nesting or duplexing disabled for normal use. This makes it  
possible to create multiple nesting/duplexing or non-nesting/duplexing published Pagesetups to print via the 
same Output.

Options

• Default Copies – Enter the default number of copies to be output for each job submitted via a DropFolder or 
Published network print destination.

Asset Queue as a Published Pagesetup 

The asset queue automatically publishes itself on the network in multiple ways: 

• Drop Folder – Files placed in the Asset dropfolder are automatically placed in the Asset queue. The drop 
location is /Serendipity Megarip/drop/asset drop. 

• Printer  –  The  Asset  queue  is  published  as  a  bonjour/zeroconf  network  destination  address  (asset 
drop@computername). Jobs printed to this bonjour destination are placed in the Asset queue. 

• TCP Port – The Asset queue publishes itself to TCP port number 9104. Jobs printed to this TCP port are 
placed in the Asset queue. 
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Pagesetup Pool 
The Pagesetup Pool  data type is used for  printing to one or more Pagesetups.  Load balance between multiple  
Pagesetups, or print to multiple Pagesetups simultaneously. These can be published in the same way as an individual  
Pagesetup. 

Pagesetups Panel 

Display all Pagesetups configured in the system. The sort columns show the Output, Jobticket, and Media used by 
each Pagesetup. Tickboxes are available to select which Pagesetup will be included in the pool. A right-click, context 
menu for each Pagesetup in the list allows the user to edit any or all selections of the highlighted Pagesetup, its  
assigned output or Media. 

Load Balancing Panel 

Load balancing is ideal for printing to multiple printers of equal quality, using the same Media with the priority being to 
proof jobs to the next available printer. Each printer is calibrated separately to ensure quality. 

“By Print Area” is more efficient, as the larger the print area the longer it will take to image, render, and print. Queue  
loading is determined at the time of imaging. If a print queue is paused, jobs will be sent to active queues. 

• Load Balance by Print Area – Calculate the area of each job and the queue with the least amount of print 
area queued is sent the next job. 

• Load Balance by Job Count – The queue with the least number of jobs is sent the next job. 

• Print to All Pagesetups – Print to all Pagesetups selected in the pool. 

This option is ideal to print a job locally and remotely. One Pagesetup can be configured to drive a local  
printer and another can create a JPEG image and transmit it to a remote Serendipity Megarip. Alternatively, 
create a PDF file to send to a customer at the same time as printing a hardcopy. 

• Pool Priority – Assign a priority to a Pagesetup pool. The lower the number the higher the priority. Numbers  
can be negative for a higher priority. The default is 0. Jobs waiting to image or render will be processed by a 
higher priority Pagesetup pool over jobs submitted to lower priority pools. 

Publish Panel 

Publish Pagesetup pools on a network as a dropfolder or as a network print destination for printing from a third-party  
application. To publish a Pagesetup pool it is necessary for the Serendipity Megarip PPD to be installed on the same 
computer as the Megarip Server runs. 

• Publish DropFolder – Allocate a folder where files can be dropped for processing. Valid file types include 
postscript, PDF, JPEG, TIFF Image, Serendipity Blackmagic Image, EPS, PNG, PSD. 

◦ Location – Set a folder as a DropFolder location. The folder must exist and have read/write permissions. 

◦ Default  –  Reset  the  DropFolder  location  to  the  default,  i.e.,  Serendipity  Megarip  installation 
directory/drop/”Pagesetup Pool Name”. 

• Parse filenames for metadata – When enabled, this function parses files placed in the DropFolder, searching 
for certain defined metadata strings appended to the end of the filenames. Each string automatically applies 
one of three (3) submit window functions to the file. Any combination of the three (3) strings can be added to  
a job filename. The useable strings are:

◦ #rotate - which rotates the file 90 degrees for printing.
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◦ #copies=X - where X is the number of copies of the file to be printed.

◦ #pages=X-Y - where X and Y are the lower and upper pages in a page range to be printed within a multi-
page job.

Examples  of  renaming  a  file  named Testfile.pdf  prior  to  placing  it  in  the  Dropfolder  are  as  follows:
Testfile.pdf#rotate
Testfile.pdf#copies=4
Testfile.pdf#pages=2-5
Testfile.pdf#rotate#copies=5#pages=3-4

Publish As 

• Printer – Publish the Pagesetup pool as a network print destination, allowing third-party applications to print  
directly to it. 

◦ Mac – Publish the Pagesetup pool as a bonjour/zeroconf network destination for macOS and Linux. 

Note: When adding a new printer through System Preferences on macOS, select the bonjour address 
(Pagesetup pool name@computer name) as the printer and Serendipity Megarip PPD as the driver. 

◦ Windows – Publish the Pagesetup pool as a Windows local printer port destination. 

◦ TCP Port – Publish the Pagesetup pool to a TCP port, allowing it to be setup as an IP printer destination,  
or as a destination for other Serendipity Megarip Servers. 

▪ Port Number – Enter the TCP port number the Pagesetup pool will publish to. It is necessary for the 
port number to be 10000 or above, and for each Pagesetup pool to have a unique port. 

Note:  When adding a new printer through System Preferences on macOS, select IP printer,  HP 
Jetdirect-socket for the protocol. The address should be in this form: computername:10063. Select 
Serendipity Megarip as the driver. 

When adding a new printer through Windows: 

1. Select Create a new Port – Standard TCP/IP port. 

2. Enter the computer network name in the Host ID field. 

3. When Windows requests additional info for the port, select Custom Settings. 

4. Rename the port if required. 

5. Set the Protocol to Raw and the Port Number to match the one set in the Pagesetup Pool to 
be published. 

6. Select Serendipity Megarip as the driver. If the driver is not already installed, choose Have 
Disk and get the driver (megarip.inf) from the Serendipity installation DVD, win\”OS Version” 
directory. 

Flow Control – Select whether to hold the submitted file after imaging or rendering in order to prioritise jobs, make 
rendering attribute changes before releasing, or nest jobs. Flow Control options are only applied to jobs submitted via  
a DropFolder, a Published network destination, or a DropSpot.

Options include: 

• Hold After Imaging – Hold jobs submitted to the published Pagesetup pool after imaging has completed. Held 
jobs can be released to continue processing via the QueueManager toolbar or right-click menu. 

• Hold After Rendering – Hold jobs submitted to the published Pagesetup pool after rendering has completed.  
Held jobs can be released to continue processing via the QueueManager toolbar or right-click menu. 

• Nest – Nest jobs submitted to the published Pagesetup pool according to the criteria defined in the output  
used by the Pagesetup/Media. 
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Note: The nest function only requires that the output used has nesting configured. The output itself can have 
nesting disabled for normal use. This makes it possible to create multiple nesting or non-nesting published 
Pagesetup pools to print via the same output.

• Duplex – Duplex jobs submitted to the published Pagesetup using the settings configured in the Outputs used 
by the Pagesetup/Media.

Note: The Next and Duplex functions only require that the Output used has nesting and/or duplexing (if  
available) configured. The Output itself can have nesting or duplexing disabled for normal use. This makes it  
possible to create multiple nesting/duplexing or non-nesting/duplexing published Pagesetups to print via the 
same Output.

Options

• Default Copies – Enter the default number of copies to be output for each job submitted via a DropFolder or 
Published network print destination.
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Paper Profile 
Configuring a paper profile is a fundamental part of calibrating a printer for optimum colour output. 

The  profile  is  assigned  to  a  Media  and  matches  paper  and  ink  characteristics  to  the  output  driver,  resolution, 
colourspace, and custom settings of the Media. 

The user interface for paper profile comprises of a toolbar containing options and functions to assist in creating the 
profile;  and a tabbed panel  where the printers  dot  sizes (density  patches),  ink limits,  and separation control  (if  
available) are configured. 

Toolbar Options 

The following options are available via the toolbar at the top of the panel (Spanner icon hides/shows the toolbar). 

Any option can be shown or hidden by tick/unticking it in the right-click menu within the toolbar. The Configure Toolbar 
option in the menu also allows the order of the buttons to be set. 

• Measure Patches  – Measure a printed density chart using a supported spectrophotometer. After selecting, 
choose an online instrument via the popup list. When the device is ready the measuring window becomes 
available. If instructed, calibrate the instrument and begin patch measurement. 

• Change Media – Change the Media currently assigned to the paper profile. 

• Print Density Chart – Print a density chart containing the patches currently turned on. There will be a space 
on the printed chart where any patches are turned off. 

• Print Density Chart (All Patches) – Print a density chart containing all patches irrespective of their on/off  
status. 

• Print Inklimit Chart – Print an ink density chart containing all enabled limits as one job to the selected Media 
and Pagesetup. 

• Print Inklimit Chart (Separate Jobs) – Print an ink density chart for each enabled ink limit colour combination  
as a separate job using the Media and Pagesetup selected. 

• Configure Inklimit Chart – Configures the combinations of inks to be tested for ink limits. Select which colours  
will be printed, the start and end ink percentage points, and step increments. 

Note: If a combination is selected, but insufficient patches to fill the row, an empty chart will be printed. For example,  
a selection to print 3 ink limit and have 2 colours selected, only the chart border will be printed. 

• Preview Graph – A graph of the patches currently turned on. 

• Channel Info – Show or hide the channel info sidebar. 

• Reorder Inks – Change the order of the inks in the paper profile to match the order used in the ICC profile. 
Often used for n-colour profiles. Highlight the ink channel in the list and move using the up and down arrows, 
or drag and drop inks to the required position. 

• Configure Ncolour – Available for n-colour paper profiles. Access the Ncolour Ink Configuration interface to 
customise a printer ink set. This allows the user to profile printers loaded with non-standard replacement ink 
sets. 

• Upgrade – Upgrade a legacy (pre version 9.1) paper profile to the current version. 

Serendipity Megarip Product Manual – Version 9.1
76



Contextual Menu (right-click) Options 

All of the above options are available via the right-click menu, including: 

• Downgrade – Downgrade the paper profile to allow compatibility with earlier software versions (v3, v4.0.01, 
v5.1, v5.2-5.4, 6.0.01). 

Density Patches 

This area displays the patches making up the paper profile. Each patch represents a dot size or combination of dots  
available to the printer being profiled. 

The number of ink channels shown and the number of patches shown for each channel will  vary, depending on 
whether the printer has variable dot capability; if it has light inks; and if the light inks are configured to be treated as  
separate or combined channels. These options are selected in the output and custom settings of the Media when 
creating the paper profile. 

Before densities have been measured, all patches will be turned on and will have default (L-value) densities. These 
are updated by data input from the Measure Patches option. 

• Patches can be turned on or off by clicking on the top half of the patch. 

• Click the lower half of the patch to manually enter L-value densities for that patch number. Pressing Enter or 
TAB stores the value and moves to the next patch for entry. 

• Hovering the mouse over the patch number displays a tooltip, providing information about the patch including 
default or measure Lab values. 

Sift and Sort Options 

Sift and sort options for each channel allow users to set the maximum ink coverage for the channel and display the 
channel name. For legacy paper profiles created in previous versions of Megarip using patches with density values 
rather than Lab values, this option also allows users to set the patch order and sift for the optimal combination of dots  
for the ink channel. 

• Sift – This is a legacy option, available to older paper profiles created in previous versions of Megarip. Sift  
uses one of several intelligent algorithms to select a suitable dot combination based on the density readings 
taken  and  the  output  device  selected.  When  used,  the  popup  dotsieve  algorithm selector  presents  the 
available device/ink sift  options.  The sift  selected patches can be switched off  or  changed if  alternative 
patches are more appropriate. 

• Maximum Ink –  Set  an ink  coverage limit  for  the ink  channel  by  introducing white  space into  areas of  
coverage higher than the set limit. The default setting is 100% (no limiting). Maximum ink is a “low level” 
setting applied during screening. 

• Sort Order – This is a legacy option available to older paper profiles created in previous versions of Megarip.  
Options include: 

◦ Patch Number – Sort the patches in patch number order. 

◦ Colour Density – Sort by the density of the colour, sometimes called real density. It is the colour content  
of the patch. 

◦ Visual Density – Sort by how dark the colour is, i.e., how much light the colour is absorbing, measured as  
black. This sort option is not available for black, where colour and visual density are the same. 
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Note: Turning off an Ink Channel 

When “Treat Light Inks as Separate Channels” or n-colour options are enabled, the user has the option to turn off  
one or more of the printer ink channels. Some inks, often cyan and magenta, produce patches with a high colour 
density while not being very dense visually. During the process of calibrating a printer, if you find that even the small 
dot (patch 2) of an ink has a colour density too high to enable that colour to pass a calibration standard, turn off that 
ink channel by de-selecting all the density patches for that ink. This should only be done where multiple inks of a 
particular colour are available. For example, if patch 2 of cyan is still colour dense, switch cyan off and use only light  
cyan. 

Switching off an ink channel will have effects through the calibration process, in particular when configuring ink limits. 
When configuring the ink limit  chart,  the number of available inks will  need to be reduced and the disabled ink 
channel should not be used in any combination on the ink limit chart. 

Ink Limits 

The ink limits tab has controls for limiting the ink mix of the channels applied in the paper profile. The number of ink  
channels varies depending on whether the printer has light inks, and whether they are being treated as separate or 
combined channels. The window to the right displays a summary of the driver configuration from the selected Media. 

Options 

• Yule Nielsen Number - Set the YN number for the paper being profiled (if known). The default is 2. 

• Ink Limits – Set the ink limits for the paper profile. These are determined after printing a chart and observing  
the percentage of coverage at which the mixture of  inks causes problems. Enter the value for  each ink 
combination. 

• Algorithm – Choose the type of ink limiting from: 

◦ Standard – Simple ink limiting based on ink percentages. 

◦ Enhanced – Like Standard, but optimised for variable dot printers. It uses intelligence to calculate the ink 
limits based on dots used. 

◦ Linear 3.0 – Add the ink coverage for any area, then proportionally limit according to the ink limit range it 
falls within. For example, with 3-ink set to 300% and 4-ink set to 400%, if a 6-ink area of an image has a 
coverage of 320% it will limit the area according to the 3-4 ink range. 

◦ Linear 4.0 (default) – Limit inks based on the number of inks being used for an area. For example, if 5-ink  
is set to 390%, any time 5 inks are laid down their coverage will be limited to 390%. 

◦ Linear, favour Black – As more ink is laid down and a colour area approaches black, this method limits  
CMY proportionally more than black, preventing wetness and inversion in shadowed areas. 

◦ Lowpass – No limiting is imposed until the coverage for combined number of inks reaches the set limit, at  
which point any higher ink coverage is clipped to the ink limit. 

◦ Lowpass, favour Black – The same as Lowpass, but favouring black, limiting it proportionally less than 
CMY as colours approach black. 

• Media Information – This side of the screen displays information about the driver and Media configuration 
important to the paper profile. 
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Separation Control 

The separation control tab displays a graph describing the interaction of light and standard inks within the process 
CMYK ink channels. The graph shows the proportion of each ink used at ink coverage levels, ink start points, and 
crossover within each colour channel. 

Ink separation control is available when the paper profile is linked to a printer Media with the “Use Light Inks” and 
“Treat Light Inks as Separate Channels” options enabled. To view individual inks on the graph, click the colour box at 
the bottom of the screen. Double-click an ink to toggle all graphs on and off. Shift+click to display multiple selected  
graphs. 

The inks for which separation control is enabled are listed on the left of the panel. Fields beside each ink allow the  
user to adjust the influence each ink has within its colour channel (e.g. the light cyan and cyan inks within the cyan 
channel). These numbers are set to 0 by default, in which case the separation control is controlled automatically. 

Increasing the influence of a light ink increases the amount of light ink used at higher coverage levels, and pushes 
up the start (and crossover) point of the standard ink. 

Increasing the influence of a standard ink increases the amount of ink used at lower coverage levels, lowering its 
start (and crossover) point, and pushes down the end point of the light ink. 

Ncolour Ink Configuration 

The ncolour ink configuration interface is used to customise a printer ink set, change ink names, define ink colours, 
light inks, and device spot inks. 

Used in conjunction with the  Reorder Inks  function, this option allows the user to profile printers loaded with non- 
standard replacement ink sets. 

The interface contains two panels – the Ink List Panel, and the Ink Configuration Panel. Ink List Panel 

The ink list panel displays a list of the inks available for customisation in the n-colour paper profile. Each of the  
printers inks is defined in three columns: 

• Name – The user-defined name for the ink channel. This defaults to the original name. Click in the text field to  
rename the ink. 

• Original – The name of the standard ink channel for that ink slot. 

• Type – The process, light, or custom (n-colour) ink channel type the ink occupies for the purpose of creating 
an ICC output profile for the printer. 

Contextual Menu Options: 

• Revert All – Revert all ink channels to the printer defaults. 

• Revert Channel – Revert the currently selected ink channel to the printer default. 

Ink Configuration Panel 

The ink configuration panel is used to display and edit the properties of each of the printer ink channels for the n- 
colour paper profile. Click on each ink to view or edit. 

The upper part of the panel has two dropdown menus, allowing the user to select what channel the ink occupies for 
ICC profiling the printer. The lower half is a colour picker panel, allowing the ink display colour to be defined. 

• Colour is a... - This is a dropdown menu to select the ink type from Cyan, Magenta, Yellow, Black, Custom (n- 
colour), Light, Light Light, and Device Spot Colour. 
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• Light Ink – This dropdown menu activates when a light ink option is selected in Colour is a...  Select an ink 
from the list. 

• Spot Generation – This dropdown menu activates when  Device Spot Colour  is selected in  Colour is a...  
Select  a  generation  mode  for  the  printer  device  spot  channel  from  Fill,  Auto  (Opaque  Media),  Auto 
(Transparent Media), None. 

Colour Picker Panel 

This section is used to change the colour of the ink channel as it is displayed in the Serendipity Client interface.  
Altering the ink colour to one closer to the custom ink in the printer aids in identifying the ink when measuring patches  
for the paper profile; when linearising; or when examining ink channels in the SoftProof window. 

Select from Lab, CMYK, or RGB colourspaces. Use the sliders or type in the number fields to define the ink colour.  
Double-click in the colour swatch to select a colour from a special colour set. 

RGB has the option of using the Pick from Screen button, allowing the user to click a colour anywhere on the display 
to define the ink colour. 

Note: Device Spot Colours and Spot Colour Mapping 

Some printers (or custom ink sets) feature inks such as metallic and white, intended for signage and display; to 
replicate  a  press  process  or  substrate;  to  act  as  a  primer;  or  for  printing  on  transparent  media.
These device spot inks and handled outside the normal colour management process and are not included in the 
output ICC colourspace for printing. These colours are printed in one of two ways: 

1. Automatically, according to the spot generation method assigned to them in the dropdown menu; or

2. As a spot colour mapped to a plate in an incoming job. 

Mapped plates will always override the automatic spot generation method when printing, i.e., a job with a spot colour  
configured  in  Media  to  be  remapped  as  “white”  will  only  print  white  in  the  areas  defined  by  the  spot  plate.
N-colour mode allows any ink in the printer to be assigned and printed as a device spot colour. 

Paper Profile Graph 

The graph shows the dots selected for each colour. The position on the graph gives a proportional representation 
showing where the dot starts to turn on or off, and their relative proximity to other dots. 

Turn the individual colour graph plots on or off by checking the tick boxes under the graph. Hovering the mouse over  
a point on the graph displays a tooltip with information about the dot. 

If a colour is not shown on the graph but the check box is ticked, the dots selected are most likely a poor choice and  
may not be valid; or the ink channel has been turned off by not choosing any of its dots (separate ink channels only). 
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Press 
The Press data type is used to emulate the properties of a press for softproofing. Each press configuration can be  
assigned a press ICC profile, press sheet dimensions, the number of ink keys, and ink and paper characteristics, all  
combining to produce accurate onscreen soft proofs. 

The press can be switched on-the-fly while softproofing to instantly show how a job will look if printed on a different  
press or on different stock. 

Press Standard Panel 

Press Colours 

• Press ICC Profile – Select a press ICC. This can be one created on the press or a printing standard ICC used 
as the target or match profile. 

• Paper Colour – Three options are available: 

◦ None – Do not change the paper colour. 

◦ ICC Profile – Use the white point from the press ICC profile and apply as the paper colour. 

◦ Custom – Enter a value for the paper colour.  Use a spectrophotometer to measure the paper white 
directly into the configuration. 

• Spectrophotometer – Select a supported spectrophotometer or file format to read, or import a measured 
custom paper value. 

◦ Configure  –  Select  the  measurement  condition  and/or  other  options  available  to  the  connected 
instrument. This option is only available to instruments with configuration options.

Verify

• Calcheck Chart – Select a chart to verify the SoftProof application's calibration status. 

Press Sheet Panel 

Dimensions 

Enter the size of the printable sheet area of the press and its number of ink keys. The key width is calculated from 
these values. 

Ink and Paper 

Configure the ink and paper properties of the press to simulate their effects on the screen in the SoftProof application. 

• Maximum Ink Weight – Enter a value for the maximum ink weight. This value is used by the InkKeyViewer to 
show excess ink. 

• Stretch Factor – Enter a compensation factor to allow for stretch. It can be used for distortion simulation or  
anamorphic scaling, where one direction will distort more than the other. 

Note: The easiest way to calculate stretch is to draw a rectangle 1m x 1m and print it. Measure the rectangle and  
enter the value. If the size is 98cm, enter 0.98. If the size is 102cm, enter 1.02. 

• Back Page Opacity – Enter a value between 0 and 100%. This controls the amount of show-through of the 
back page through the front page when reverse page viewing in SoftProof. 

• Back Page DotGain Curve – Select a dotgain curve to apply to the back page when using the Show Back 
Page option in SoftProof. 
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• Back Page Rotation – Select the relative orientation of back page when using Show Back Page in SoftProof. 

• Top Page – Choose Even or Odd. This is used to determine which page backs onto which, so the correct  
back page is shown when requested. 
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Screen Printing 
The screen printing functionality within the Media data type is designed for printing film separations on an inkjet  
printer. Files submitted for processing are separated into individual plates. Each plate is printed as a black separation 
with a halftone dot applied at the colours respective screen angle. 

Printing to film generally requires the output density to be higher than that for normal proofing. Higher densities are 
achieved by increasing the print resolution, or by assigning one or more inks to be laid over the black dots. 

Configuration 

The configuration is very similar to a standard setup to print to a device. The Output configuration is the same and the 
appropriate  Media  and  Jobticket  are  created  to  control  the  page  parameters.  A very  basic  Paper  Profile  and 
Linearisation are also created to complete the setup. 

Output Configuration 

1. Assign an Output Driver. 

2. Select a Destination Driver and configure settings. 

3. Enable Collating options if required. 

4. Save the configuration. 

Media Configuration 

1. Assign an Output Driver (same as setup in the Output) for the screenprinting configuration. 

2. Select an appropriate Resolution. A higher density can be achieved with a higher resolution however, it is  
slower to process and print. A lower density may produce sufficient density depending on the printer and 
media used. 

3. Select CMYK colourspace. If using the Black Ink Combination only, choose Gray as the colourspace as this 
may result in slightly faster processing. However, in this mode inks cannot be mixed to produce a denser 
output. Selecting CMYK and configuring a Paper Profile will allow the choice to use black only of a mix of  
colours at a later stage, without having to recreate a Paper Profile. 

4. Select the appropriate media in Custom Settings, Uni or Bi-directional and turn the Use Light Inks option OFF. 

Bi-directional is faster but may produce slight banding, or may not be as dense as printing Uni-directionally. 
Using light inks will affect the patches in the Paper Profile. In screen printing mode, only one patch can be on  
per colour. 

5. Enable Screen Print Mode and select Black for the Ink Combination (and any others required). 

Once this option is selected, jobs submitted to this Media will always be separated and printed using the 
selected colours. One or more inks must be selected from the available choices. If Gray is selected as the 
colourspace, only black will be shown as a choice. 

6. Select Halftone output screening and tick the SuperCell option. Choose the preferred dot shape and enter the 
screen angles and rulings. 

SuperCell gives a better-shaped dot and the round dot tends to be more commonly used. The default angles 
of 15, 45, 75, and 90 are shown by clicking the Defaults button, however, these can sometimes produce 
undesirable effects, mostly caused by the yellow plate. To counteract this, offset all angles by 7.5 degrees to  
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make them: Cyan (22.5 degrees), Magenta (82.5 degrees), Yellow (97.5 degrees), Black (52.5 degrees), 
Special (52.5 degrees). 

Paper Profile Configuration 

In Screen Print mode only one patch can be turned on per colour. The value for the patch does not matter, which one  
chosen does. 

For a variable dot printer, when the Use Light Inks option is turned off, there will be four (4) patches for each colour. 
The first patch represents the media and the other three the dot sizes (small, medium, and large). A dot size for each  
colour must be chosen. 

If the colourspace is Gray, black will be the only available ink. 

There is no need to measure the value for the patches, the defaults are sufficient. Comparative densities are not 
relevant when only using one dot (patch). 

In testing, it was found that a combination of large black (patch 4) and small magenta (patch 2) produced good  
results. If too much is used, for example, large black+large cyan+large magenta, the result is wet output and the dots 
tend to “fill in” the shadow area. Large dots of a colour like cyan will produce film looking blue instead of black. Black  
should always be the dominant colour. 

Ink Limiting 

There is no need to enter any ink limiting as the plates are separated, so there is no mixing of 2, 3, and 4 inks. 

Linearisation 

As screen printing mode prints only black separations, the creation of a simple linearisation (gradation) curve to be 
applied to the Media is all that is required. 

The linearisation curve can be created in one of two ways: 

Method 1 – Using the Lineariser application and a supported spectrophotometer. 

1. Open the Lineariser application. 

2. Select the Media used for screen printing and print a chart for the spectrophotometer to read. Only the black 
channel patches will be printed and measured. 

3. Measure the values using a connected instrument and save the chart. 

4. The linearisation curve will be automatically assigned to the selected Media. Check this by viewing the Media  
in the Workbench to make sure the curve is assigned to the configuration. 

Method 2 – Manually Creating a Linearisation Curve. 

1. Select the Gradation Curve data type in the Workbench item list. 

2. Create a new curve, selecting the screen printing Media to be used. 

3. Edit the curve by selecting the black curve. Click on the curve and drag it to the desired shape, adding more  
curve points if required. 

4. Save the curve. 

5. Select  the screen printing  Media  in  the  Workbench item list  and assign  the Gradation Curve using  the 
Linearisation LUT button in the Colour Correction panel. 
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Summary 

The above is a guide to configure a setup to print film separations for use in the Screen Printing industry. 

Run some test jobs to choose the most suitable patches, ink combination and resolution for the device and media 
being used. If a different resolution or colourspace is selected or the light inks are used, a new Paper Profile will need  
to be created. Trying different dot sizes will mean adjustment of the Paper Profile – changing which patch is turned on  
in each channel. 

During the testing period many combinations of ink (colours), dot sizes and resolution were tried. Different output 
devices and media will produce varying results, so a combination of patches and ink mixing may work better. 

The higher resolution (1440dpi) produced the most dense output at around 4.18D, but takes longer to RIP and print.  
By running at a lower resolution (720dpi), the jobs processed quicker but the density drops to just under 3 at around  
2.8D. This is often acceptable for many applications, but will vary depending on the media and device used. Testing 
will prove the most suitable setup. 

The most commonly used settings were CMYK colourspace, with an ink combination of black and magenta. This  
used the large black (dot 4) and the small magenta (dot 2) in the Paper Profile and gave a slight reddish tinge to the  
black, which is desirable in the Screen Printing industry. 
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Modules 
Modules are informational windows used for managing jobs as they pass through the system and to monitor Server 
and Client activity. 

Modules are arranged and utilised in a pre-configured format in the Jobs application; are able to be added and 
configured  to  a  tabbed window as  part  of  a  Monitor  layout  via  the  Layout  menu;  or  started  up  individually  as 
standalone windows from the Module menu. 

The following modules are available: 

• ClientLog – Displays a log of Client messages that may be generated during normal Client operations. 

• ClusterStatus – Monitors the progress of Imaging and Rendering tasks on the Server and any active Cluster 
Nodes. 

• DropZone – A place to drag and drop files for processing. 

• MediaStatus – A window showing the current calibration status of a Media data type and a progress bar 
showing the amount of media (e.g. Paper) used. 

• QueueManager – View and manage jobs after they have been submitted for processing. 

• QueueStatus – A progress meter showing the current status of active jobs on the selected queue. 

• ServerLog – Displays any system, error and polling messages from the Server. 

• Status – Shows the disk status (usage) of the Server processing areas. 

• Thumbnail – Displays a thumbnail of jobs as they image or render. 
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ClientLog 
The ClientLog displays any messages that  pop up during normal  Client  operation.  There are different  levels  of  
message, from informative to serious errors. All messages are held for a user-determined length of time. 

• Fetch Back Log – Display the log for the time specified. 

• Trim Older Lines – Trim the log based on the time selected in Fetch Back Log. If this is set to 60 minutes, the 
log is trimmed so only the last 60 minutes remain. 

• Export – Export the log to a file. 

Note: When exporting the log file you can choose to export everything in view or select entries to export. Use the  
filtering options and Fetch Back Log choice to limit the view before exporting. Selecting Export displays a chooser, to  
enter a name and select the location to save the file. Choose to save the file as html or as a tab delimited text file. 

Filtering Options 

Choose which messages to display in the log and which to hide by ticking checkboxes for  one or more of  the 
following filters. All messages are saved to the log, even if filtered. 

• Question – Used for messages that ask questions, for e.g., “Job contains unassigned colours. Do you want to 
add them to VirtualPress.” 

• Information – Used for messages that tell you something, for e.g., “Job has a duplicate plate.” 

• Warning – Used where the message has a higher importance and (usually) the Client failed to do something, 
but operation can continue, for e.g., “Failed to save new password. Old password will continue to be used.” 

• Critical – Used for serious errors that will most likely affect operation, for e.g., “Failed to load rendering .dll.” 
You will normally be required to take action to rectify these errors before continuing. 

• Search – You can search the log for jobs or messages. Enter the text of characters you want to search for 
and the ClientLog only displays the lines that match the search. 

Display Options 

The following sort columns can be selected using the right-click menu on the sort column header bar in the log: 

• Type – The level of the message reported. For e.g., Question; Information; Warning or Critical. 

• Date – The time the message was reported. 

• Source – The module or application that reported the message. 

• Summary – A summary of the message that was reported. 

• Message – Displays the log entry message text inline.

• Command – Internal command used to communicate messages to and from the Server by the Client. 

• Error – An error code reported by the Server. This is useful for de-bugging problems. 

• Action –  The action taken by the user  relating to  the message.  For  e.g.,  the button pressed when the  
message popped up. 

The order of the columns can be changed by clicking and dragging them to the desired position, or by using the  
Configure Headers option under the contextual (right click) menu. The columns can be manually resized by dragging 
the header divider bar to the desired width, or resized to fit content by double-clicking the divider bar. 
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ClusterStatus 
The ClusterStatus is a monitor allowing you to see the current imaging and rendering status of jobs on any active 
Master Servers or Cluster Nodes. A contextual (right-click) menu has the following options: 

• Clustering – Open the Clustering application to manage the Cluster. 

• Refresh – Update the status. 

• Increase Inset (+) – Increases the gap between the list items. 

• Decrease Inset (-) – Decreases the gap between the list items. 

• Font Options – Allows you to change the size of the text. 

DropZone 
A DropZone is a place where you can drag and drop files for processing. The user selects Pagesetups with Media 
and Jobticket information, Pagesetup Pools or the Studio application Asset queue to add to the DropZone as a  
DropSpot. 

These DropSpots accept the same file formats as the DropFolder (Postscript, PDF, JPEG, TIFF Image, Serendipity  
Blackmagic Image, EPS, PNG, PSD). The available contextual menu options are: 

• Add DropSpot – Select one or more Pagesetups/Media to add to the DropZone. Selecting this displays a 
chooser window, showing all available Pagesetups/Media. 

• Add Asset DropSpot – Adds a DropSpot for the Asset queue. Assets are then manually laid out, nested and 
printed using the Studio application (See Applications – Studio for more information). 

• Reorder DropSpots – Displays a reorder window. Select one or more DropSpots in the list and drag them to a  
new location, or use the up and down arrow keys to move the position. Click OK when finished. 

• Increase DropSpot Inset (+) – Increases the size of the DropSpot. 

• Decrease DropSpot Inset (-) – Decreases the size of the DropSpot. 

• Font Options – Allows you to change the size of the text.

Additional contextual menu options are available for individual DropSpots: 

• Remove DropSpot – Remove the selected DropSpot. 

• Edit Pagesetup – Edit a section of the selected Pagesetup, all sections or create a new one. 

• Edit Media – Edit a section of the selected Media, all sections or create a new one. 

• Edit Jobticket – Edit a section of the selected Jobticket, all sections, or create a new one. 

• Change DropSpot – Allows you to change an existing DropSpot. 

• Set Copies – Set the number of copies for every job dropped on the DropSpot. 

Note: This feature can also be accessed by double-clicking on the DropSpot. 

• Set Colour – Select a colour from the list for the currently selected DropSpot. 
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MediaStatus 
The MediaStatus module has two (2) functions: 

1. To show the current calibration status of a selected Media data type. For the calibration status to be shown or  
updated for a Media, it must have been calchecked using the Calcheck Media menu option (see below) or the 
Check Media option in the Calcheck application. 

2. To show how much of the media (e.g. Paper) has been used. A meter is displayed graphically, detailing the 
percentage used. For the Usage meter to function, values for the Media Length or the number of sheets 
loaded must be entered in the Output section of the Media data type. 

Each Media displayed in the MediaStatus window has the following information: 

• Media Name. 

• Calcheck Status – Toggled via the Calcheck Info option (see below). Displayed as one or more Ticks/Crosses 
to the right of the Media name, showing a Calcheck Pass or Fail against the user-defined ΔE, ΔH, or ΔCh. 
Hover the mouse over each to show a tooltip displaying the ΔMax and ΔAvg values. 

• Usage Meter – Bar showing the amount of media used. Text under the bar states the exact amount used as a  
percentage of the total units. 

• Reset Counter – Resets the usage count for the Media. 

• Logged Period – Time period (date and time, from and to) the Media has been tracked since the last reset.  
This information is shown/hidden using the Show Extended Info option. 

• Printed – Number of jobs and total printed area of jobs tracked since the last reset. 

• Calcheck Info – Displays the complete Calcheck summary information for the selected Media resulting from 
the last Calcheck. Includes the Calcheck Chart used, internal Calcheck score, Date/Time of Calcheck and 
Δvalues. 

A contextual (right click) menu has the following options: 

• Change Media – Change the selected Media for display in the status window. 

• Edit Media – Edit all or part of the selected Media. Copy it, or create a new one. 

• Calcheck Media – Opens the Calcheck application. Once a chart has been printed and measured, the results 
are saved to the Media and the Calcheck Info for the Media is updated in the MediaStatus window. 

• Media Order – Allows you to configure which queues are viewed by the MediaStatus window. Move Media 
between the Available and Showing columns in the popup chooser. 

• Show Extended Info – Show/Hide the Logged Period and Printed information for the selected Media. 

• Show Calcheck Info – Show/Hide the full Calcheck Info summary for the selected Media. 

• Metric Units – Toggle between Metric or Imperial units for measurements shown in the MediaStatus window. 
This is enabled by default. 

• Increase /Decrease Status Width – Increase or Decrease the width or all Media panels in the window. 

• Font Options – Allows you to change the size of the text in the window. 
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QueueManager 
The QueueManager displays information about submitted jobs and the jobs’ current status. Queues can be viewed 
simultaneously,  showing job progress through  Imaging  (where the incoming file  is  interpreted and its  resolution 
sampled for conversion to the print resolution); Rendering (where colour management, cropping, rotation and effects 
are applied for printing); and Printing (output). 

The QueueManager also allows jobs to be manipulated in a number of ways, such as holding, promoting, deleting 
and reprinting. 

View Options 

The following sort columns can be selected using the contextual (right click) menu on the column header bar in the 
QueueManager display panel when in Jobs view: 

Name – Job name Thumbnail – Show a thumbnail of the job.

Process Time – Time taken to run the last process on the job. Job ID – The internal Blackmagic ID number for the job. 

Status – The jobs current status. Node – The Server or Cluster node the job was processed on.

Source – The source of the submitted job. Page – The page number of the job. 

Date – The date and time the job was processed. Publication – The publication name. 

Jobticket – The Jobticket used to process the job. Notes – The number of notes saved with the job. 

Media – The Media used to process the job. Section – The section of the publication. 

Pagesetup – The Pagesetup used to process the job. Comment – Indicates by displaying a speech bubble whether a 
job has an attached comment. 

Queue – The output queue the job was sent to for processing. Edition – The edition of the publication. 

Size – The size of the job (disk space used). Copies Printed – The total number of times the job has been 
printed. 

Width – The width of the job. Copies – When multiple copies of a job are sent for printing, 
this column counts down the number of jobs left to print. 

Height – The height of the job. Priority – Displays the current priority assigned to the queued 
job.

DPI – The imaged resolution of the job. Imaging Time - The time it takes for the job to be imaged.

Output Colourspace – The colourspace of the output file. Rendering Time - The time it takes for the job to be rendered.

Screening – The screening applied to the job.

The columns can be manually resized by dragging the header divider bar to the desired width, or resized to fit content  
by double-clicking the divider bar. 
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Toolbar Options 

The following options are available via the Toolbar at the top of the panel. Any option can be shown or hidden by 
ticking/unticking it in the contextual (right-click) menu within the Toolbar. The Configure Toolbar option in the menu 
also allows the order of the buttons/options to be set. 

• Queue Order – Allows you to configure which queues are viewed by the QueueManager – Available & 
Showing.

• Render Queue Thumbnails – Enable or disable thumbnails for the Render Queue in the Thumbnails view of  
the QueueManager. 

• Show Idle Queues – Show/Hide entries in the QueueManager for idle processing queues. 

• Group by Queue – Enable/Disable the grouping of jobs by Queue before other column sorting is applied. 

• Queue Icons – Display the pre-Output queue to which the job currently belongs. These include Autodetect, 
Spooling, Imaging, Rendering, Wait and Asset. 

There are a number of actions that can be performed on a job. Options become available when one or more jobs are 
selected. Only actions valid for the job status are shown. For example, the action to Nest Now is only available if the 
job has a status of Waiting to Nest. 

The following are available in the Toolbar or by selecting job(s) and right clicking to access the context menu: 

• Job Info – Shows information about the currently selected job (or jobs). The Job Info contains all details of  
how the job was processed and displays a thumbnail preview of the job and its configuration. A dropdown 
toolbar at the top of the Job Info window has the following options: Print Portrait, Print Landscape, Print to  
PDF Portrait, Print to PDF Landscape. Prev/Next buttons at the bottom of the Job Info window are used to 
display the info for the previous or next job in the QueueManager. 

Note: Job Info & thumbnail can also be displayed by double clicking on the job. If multiple jobs are selected, double 
clicking will display info about all in the window. Holding the control key (Win) or command key (Mac) will allow the 
font size to be adjusted via the mouse wheel for easier viewing. 

• Job Ownership – Opens a popup window displaying General and Ownership information for the selected job.  
The General panel displays created and modified timestamps for the job. The Ownership panel displays its  
User and Group permissions. 

Note: The User and Group will be listed as “admin” for normal installations. If Secure Mode is active (see Server  
Settings and Accounts Admin), a user with sufficient privileges can make changes to the job permissions with respect 
to other users. When in Secure Mode, the admin user login is able to change the user or group to which a job 
belongs. If multiple jobs are selected, the admin user can make a mass change to the permissions of all jobs. 

• Modify – Allows various attributes of the job to be modified. These include: 

◦ Name – Change the name of the job. 

◦ Publication Name – Change or add a publication name. 

◦ Page Number – Change the page number of the job. 

◦ Copies – Change the number of copies of a job. 

◦ Change Media – Change or assign a Media associated with the job. 

• Render with  new Jobticket  – Resubmit  a  job with  status “Done”  to  be rendered again using a  different 
Jobticket configuration. 

• Comment – Opens a popup window allowing the user to enter comments about the job. When the Comments 
sort column has been selected in the View options, a speech bubble in the column indicates the job has a  
comment. Opening the Job Info will display the comment directly below the thumbnails. 
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• Reprint – Displays a window to reprint a job or jobs. 

• Cancel – Cancels the currently processing jobs. 

• Delete – Deletes the currently selected jobs. 

• Hold – Holds the currently selected job. Only available when the status is “Waiting”. 

• Release – Releases a currently selected Held job. 

• Retry – Retries a failed job. 

• View Errors – Views the errors of the selected job if the status is listed as Failed. 

• Rush Jobs –  Changes the assigned priority  of  the selected job(s)  to  -99,  effectively  giving the  job first 
(highest) priority in its current queue and all subsequent processing queues. Multiple “rushed” jobs will be 
processed in timestamp order as normal. 

• Change Priority – Opens a pop-up Change Job Priority window allowing the priority of the selected job(s) to 
be changed mid-processing. 

• View Original – Views the Original/Imaged file for selected jobs in the SoftProof application. 

• View Printed – Views the Printed/Rendered file for selected jobs in the SoftProof application. 

• Render Again – Submits the selected jobs to the rendering queue for processing. Only available when the 
status is “Done”. 

• Move to Pagesetup – Moves the selected jobs to another Pagesetup. This will send the jobs to the rendering 
queue again with the attributes of the selected Pagesetup. View the Pagesetup, edit it, or create a new one 
prior to submitting the job. 

• Copy to Pagesetup – Copies the selected jobs to another Pagesetup. This will send the jobs to the rendering 
queue again with the attributes of the selected Pagesetup. View the Pagesetup, edit it, or create a new one 
prior to submitting the job. 

• Move to Queue – Move a job with a “Done” or “Waiting to Print” status to another output queue with the same 
print driver. 

• Nest Jobs – Submits the selected jobs to be nested. This sends the job to the rendering queue to re-render  
for a nest. The Collating section of the Output is used for the nesting parameters. 

• Nest Now – This is available when the selected job has a status of Waiting to Nest. Only one job needs to be 
selected and all jobs with a Waiting to Nest status will be nested. 

• Duplex Now – Duplexes any job that has a status of Waiting to Duplex. Only one job needs to be selected 
and all jobs with a Waiting to Duplex status will be duplexed. 

• View FlipBook – Opens the selected job or publication in FlipBook. If the selected job is part of a publication, 
all pages will be shown. 

• Select Publication – Selects all the pages/jobs in the QueueManager belonging to the same Publication as 
the selected job. 

• Refresh All Queues – Updates the queues. 

• Export – Allows you to export data from the selected job. The available formats are: 

◦ CIP3 – Exports job information to a file in CIP3 format at the selected resolution. You can also select the  
orientation before exporting. Further options are: 

▪ Version 2.1 

▪ Version 3.0 
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▪ Rotations 

▪ Surface – Choose front or back. 

▪ Compress Preview – Choose if  the preview should be compressed. Some presses are unable to 
handle files in compressed format. 

◦ PDF – Exports the selected job in PDF at the resolution entered. Further options are:

▪ Compressions – JPEG, ZIP or LZW. For JPEG and ZIP you also have control on the level and quality 
of compression. 

◦ Photoshop – Exports the selected job as an Photoshop (.psd) file at the resolution entered with an option  
of Packbits or no compression. 

◦ Postscript (separated) – Exports the current job as a separated PS file. 

◦ Tiff Multichannel – Exports the current file as a multichannel Tiff. 

• Export Job History – Exports the job history information to a CSV, XML, or JSON file. Select from Today, 1 
Week, 1 Month, or a specific date range. Available when Job Statistics are enabled via the Server Settings. 

• Calcheck Job – Launches the Calcheck application to check a job’s calibration status. The jobname is stored 
and the results can be exported or printed. Measurement results from the Calcheck are stored in the Job Info. 
The Job information shown in the Queue will change colour to match with the result of the Calcheck once 
completed (green pass, red fail). 

• Calculate Ink Weight – Displays the Ink Weights window with the selected jobs ink weights and coverage 
shown. 

• Pause/Resume Printing/Processing – Pause or Resume the output queue of the selected job at their current 
stage of processing or printing (Imaging, Rendering, Nesting or Printing). Incomplete jobs in paused queues 
will display in red. 

• Change Output Media – Change the Media assigned to the output queue for the selected job. Once re-
assigned, all jobs held awaiting the new Media will begin processing. 

Configuration Options 

The following options are available from the right click (contextual) menu within the QueueManager window: 

• Queue Colour – Select a colour for the currently selected Queue for easy identification. 

• Queue Order – Allows you to organise the queues into your preferred order, or adjust any settings. 

• Joblist View – View the queue in Joblist mode. This is the same as selecting Show > Jobs. 

• Publication View – View any publications in the queue. This is the same as selecting Show > Publications. 

• PrintGallery View – View the jobs as thumbnails. This is the same as selecting Show > Thumbnails. 

• Edit Output – Allows you to edit the Output and not the job. For changes to be effective, resubmit the job for 
printing or rendering, depending on the attribute changed. 

• Edit Media – Allows you to edit the Media the job was processed with. For changes to be effective, resubmit 
the job for imaging or rendering, depending on the attribute changed. 

• Edit Pagesetup – Allows you to edit the Pagesetup the job was processed with. For changes to be effective,  
resubmit the job for imaging or rendering, depending on the attribute changed. 

• Edit Jobticket – Allows you to edit the Jobticket the job was processed with. For changes to be effective, 
resubmit the job for imaging or rendering, depending on the attribute changed. 
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• Auto Queue Order – When this option is enabled, the QueueManager displays jobs for all existing process 
and output queues. Any new queues created will be shown automatically. 

Important Note:  When editing any of the items from here, it is editing the queue for all future jobs, not just the 
currently selected job. 

The bottom of the screen contains the following options: 

• Show – Show certain jobs in the QueueManager. Select any or all of the options to filter jobs. Choose from: 

• Jobs – Display all jobs as text line entries. 

• Thumbnails – Display all jobs as thumbnails. This is the same as the Print Gallery mode. 

• Publications – Displays any publications to which jobs belong. When viewing in this mode the bottom of the 
QueueManager list panel displays a Page Index (See SoftProof > Page Index Panel for more information). 

For any of the above display modes, further filtering is available: 

• Active – Jobs currently processing. 

• Waiting – Jobs with a status of Waiting. 

• Done – Completed jobs. 

Search – Find jobs that are in the queue. All jobs matching the search text will be displayed. All elements of the jobs  
are searched against,  not just the name, so this can be a useful filtering tool.  The search can be inverted with  
cmd+shift+I (Mac) or ctrl+shift+I (Win). The search box will turn black to indicate when the inverse search is selected. 
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QueueStatus 
The QueueStatus module is a progress meter that shows the current status of active jobs on the selected queue. The  
Printer Status Monitor option is also available within the QueueStatus module for specific printers. 

Note: Not all options listed are available on all QueueStatus windows. Some are only available while the job is in  
progress. 

• Cancel Job – Cancels the currently active job and is only available when a job is active. 

• Job Info – Displays info about the currently active job. 

• Pause Printing/Processing – Pauses the queue so no further jobs will process. Any job currently active in the 
queue will finish. The text in the window changes to red, showing the paused state. 

• Resume Printing/Processing – Takes a queue out of a paused state. Any waiting jobs will now be processed. 

Note: The Pause/Resume function can be toggled using the tick box to the left of the progress bar. This function also 
affects the Output for the queue, changing the status to Active/Inactive. Inactive Output’s are displayed in red in the 
Workbench > Output > Items list. 

• Change Output Media – Change the Media assigned to the Output using a chooser window listing compatible  
Media. Options for each Media are displayed for view, can be edited, or a new Media can be created. Only  
jobs sent via the selected Media will  print. Other jobs will  be held in the QueueManager with a status of 
“Waiting for Correct Media” until their Media is selected. If No Media is assigned – the “None” option - all jobs  
sent to Output are printed. 

• Change Queue – Allows you to choose which queue the status window will show. 

• Edit Output – Allows you to edit the output or create a new one. You can only edit if the queue is showing an 
output. If the queue is set to Spooling, Auto Detect, Imaging or Rendering you can only make a new output. 

• Thumbnail – Turns on/off a mini thumbnail on the printer queues only, which gives an indication as to how 
much of the current job has printed. 

• Show Printer Status Monitor – Displays the printer status, ink levels, warning and error messages for the 
selected queue. Printer status is checked and the QueueStatus is updated: 

◦ Every 60 seconds – Printer Idle. 

◦ Every 15 seconds – Printer Busy (Printing). 

◦ Every 5 minutes until connection restored – Printer disconnected from network or turned off. 

Note: This feature is only available to compatible printer drivers and when the “Monitor Printer Status” option in the  
Output is enabled. 

• Font Options – Allows you to change the size of the text. 

• Queue Order – Select which queues you wish to view. Selecting this presents you with a chooser window 
showing two lists – The Available queues on the left and the Showing queues on the right. To move queues 
between lists,  select  one or  more and drag from one list  to  another.  Alternatively,  double click  to  move 
between lists. The order of the queues in the Showing list determines the order of display. Queue Order can 
be used to show multiple Queues in a single QueueStatus window. 

• Increase/Decrease Indent – Increases or decreases the size of the QueueStatus in view. 
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ServerLog 
The ServerLog shows messages from the Server. 

• Fetch Back Log – Displays the log for the time specified, e.g., it retrieves and displays the last 4 hours of  
messages. Choose the time period from the dropdown list. 

• Loglevel: - Choose the level of log messages to be displayed from the dropdown list, in order of priority from 
Fatal (most critical) through to Debug (all log messages). Fatal and Error messages appear in red in the 
ServerLog, Warning messages appear in gold.

• Trim Older Lines – Trims the log based on the time selected in Fetch back log. If this is set to 60 minutes, the  
log file is trimmed back so only the last 60 minutes remain. 

• Export – Export the log to a file. Selecting this displays a window with further options as detailed below: 

◦ Destination File – Choose the filename and location where the file is to be saved. Use the Browse button 
to navigate to the preferred location. 

◦ Message Lines – Choose to save all messages in the log window or only those that are highlighted. 

◦ Format – Choose the format to save the file in, either html or plain text. The plain text file is saved with 
tab characters between the columns. 

◦ Cancel – Revert to the Server window without saving any changes. 

◦ Save – Save the file based on the settings selected. 

• Configure Filter – You can filter messages in the log. Choose between the following options: 

◦ Completed Jobs – Shows messages about completed jobs. 

◦ Polled Jobs – Shows messages about polled jobs. 

◦ Errors – Shows errors from the Server. 

• Search – Search the log for messages. Enter the text of characters to search for and the ServerLog will only 
show lines matching the search. 

Display Options 

The following sort columns can be selected using the contextual (right click) menu on the column header bar in the 
ServerLog:

• Module – The Server function that generated the message. 

• Routine – The operation within the Server function. 

• Date – The time the Server called the module. 

• Message – The message resulting from the routine. 

• Loglevel  –  The  severity  level  of  the  log  message,  from  critical  (Fatal)  through  to  general  operational 
messages (Debug).
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Status 
Status shows the current disk status (usage) of the Server processing areas, such as spooling, temporary directories  
and DropFolders. Editing the ss.conf file in the installation directory (in the etc folder) can change disk locations. 

Options are: 

• Update – Check the disks and update the view. 

• Preferences – Set the Status window preferences. A further option available is: 

◦ Update Interval – Set the time between updates. 

• Colour Scheme – Changes the colour of the Status window. 

• Font Options – Change the size of the text. 

Thumbnail 
This module displays a thumbnail of jobs as they are imaging and rendering. Thumbnail progress is updated at the 
same time as the Imaging or Rendering QueueStatus is updated. 

The following options are available from the contextual menu (right click): 

• Show Imaging – Show the Imaging thumbnail, denoted by “gears” in each inset. 

• Show Rendering – Show the Rendering thumbnail, denoted by a “paintbrush” in each inset. 

• Normal Thumbnail – Displays the default size thumbnail. 

• Large Thumbnail – Displays a large thumbnail. 

• Small Thumbnail – Displays a small thumbnail. 
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Applications 
The applications available within Serendipity Megarip add functionality to the Client and provide additional tools for 
managing the Server and your jobs. 

All  are accessible via the Applications menu in the Client.  Some, such as Calcheck, can be launched via other 
Applications or Modules. 

The available Applications are listed here with further details on each following: 

• Archives – Make partial or complete backups of your Workbench configurations. 

• Calcheck – Verify the calibration status of a printer. 

• Clustering – Allocate and manage Imaging and Rendering tasks across multiple computers and networks. 

• Densitometer – Measure and display density readings taken with a Densitometer or Spectrophotometer. 

• Displays – Create ICC profiles for system monitors for accurate onscreen colour softproofing. 

• FlipBook – Display a publication as a 2D or 3D virtual book. 

• Jobs – Display jobs before, after and during processing and allows users to manage jobs through the system 
to plot their progress with a pre-configured user-interface. 

• Lineariser – Create a Linearisation curve for use with a Jobticket or Media. 

• Monitor – Display and manage jobs as they pass through Megarip (see the “Monitor”  section for  more 
information). 

• SoftProof – Proof jobs onscreen. 

• Spectro – Display, compare and/or save colours measured using a Spectrophotometer. 

• Studio – Designed for the manual nesting or tiling of jobs. 

• Workbench –  The  principal  configuration  tool  for  Megarip  (see  the  “Workbench”  section  for  more 
information). 
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Archives 
The Archives application allows you to make backups or archives of your Workbench configurations. Individual items 
or  complete  systems can  be  archived  for  safekeeping.  Stored  items can  be  loaded for  adding  to  the  Megarip  
database.  This  can  be  used  for  copying  a  database  to  another  Server,  or  for  recovery  from failure  or  corrupt 
configurations. You can configure the Archives app to automatically backup your settings on a regular basis. 

Important Note: Archives cannot be back-ported to previous versions, i.e., version 9.1 archives cannot be used with 
version 6. Version 6 archives can be used with Version 9.1 however, and will  be automatically allocated to their 
respective databases when loaded. 

File Menu Options 

• Open Archive – Open a previously saved archive. A chooser window allows you to browse and select an 
archive (.sdb) file. 

An archive can also be opened: 

◦ By dragging the .sdb file into an open Archives application. 

◦ Double-clicking an .sdb file. 

◦ Right-clicking on an .sdb file and selecting Open with > Serendipity Client; or the Preview (Serendipity 
Client) option. 

• Save Archive – Saves the archive to a compressed (.sdb) file. 

• Close Archive – Closes the currently opened Archive. 

• Perform Full  Backup – Adds all  Workbench data types to a new Archives window. Once done,  you are 
prompted to choose a name and location to save the file. Once saved, the Archives window is dismissed. 

• Automatic Backup Preferences – Allows you to configure the frequency, time and location that a system 
backup is performed. The options are: 

◦ What Day – Choose a day of the week, every day, every number of days or never. 

◦ What Time – Choose the time the backup is performed. 

◦ Location – Choose the location the archive should be saved to. 

A check is  performed when the  Client  is  first  started and every  hour  afterwards to  see if  a  backup should  be 
performed. The Client must be running for a backup to take place. The table gives a guide as to when a backup would 
occur in different scenarios: 

Auto Backup Time Client Started Client Quit Time Backup Performed 

Mon 2am Mon 9am No When Client is started – 9am 

Tues 12:10pm Tues 9am No Tues 12:30pm 

Everyday Midnight Tues 8:20am No When Client is started – 12:20am each day 

Wed 11pm Thurs 8:30am No The following Wed at 11:30pm 

Sun 10pm Mon 8am Fri 8pm Never
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Edit Menu (and contextual menu) Options 

• Add to Archive (All) – Select everything or all of a particular data type, for e.g., All Pagesetups. 

• Add to Archive (Selection) – Allows you to select individual items from the database to add to the Archive. 
Selecting the type, for e.g., Gradation Curves, displays a chooser with all the Gradation Curves allowing you  
to choose one or more to add to the Archive. 

• Add to Database – Choose to add items from the Archive to the database. You can add the whole Archive or 
selected items. 

• Remove from Archive – Remove the selected items from the Archive. 

• Collapse – Collapses the selected items if they are expanded. 

• Expand  –  Expands  selected  items  if  the  item  contains  references  (denoted  by  a  ‘+’).  For  example,  a 
Pagesetup will contain at least a Media and an output. Expanding the Pagesetup will display the other items 
connected with it. 

• Open/Save/Close Archive – Open, save or Close the Archive as mentioned previously. 

• Export C5 Media Pack – Export the archive for use with the C5 Client. 
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Calcheck 
The Calcheck application is used to verify the calibration status of a printer, ensuring proofs are printed accurately.  
Calcheck Charts are generated by either manually defining or importing Lab or CMYK values. Each chart represents  
print/press standards against which the printer and media are to be checked (see the Workbench > Calcheck Chart  
section for more information). 

The selected Calcheck Chart is printed from the Calcheck application to the Pagesetup and Media being used to 
proof jobs. Alternatively, the chart can be assigned to a Jobticket to print with each proofing job. The chart is then  
measured, using a supported Spectrophotometer. 

After measuring the chart, the results are displayed in the Calcheck window. A pass (green tick) or fail (red cross) is 
determined by whether the measured patches fall inside the tolerances defined in the Calcheck Chart. The results  
can be printed as a label or a complete report to a system printer. If a Media or job was loaded into Calcheck before 
measuring, the results will be saved to the Media Calcheck Info, or stored in the job’s Job Info (see below). The 
Calcheck application is made up of a Summary Panel, Measurements Panel, optional Info and Calcheck History 
panels, and a Device/Spectrophotometer dropdown menu. 

Summary Panel 

This panel is viewed by selecting the (left)  cross/tick button at the top right of the Calcheck window. It  displays 
Summary  information  about  the  completed  Calcheck.  This  information  is  also  available  for  view  within  the 
MediaStatus module, the Calcheck Info section of a Media, or the Job Info window of jobs that have been calchecked. 
The following information is displayed: 

• The panel title bar shows the Calcheck Chart used for the check. 

• ∆All / ∆e / ∆H / ∆Ch – These buttons switch between summaries of the respective ∆ standards. The buttons 
available depend on which ∆ standards are defined in the chart for the Calcheck. The ∆e summary values 
listed are CIE76 by default. This can be changed to CIE94, CIE2000, CMC(1:1) or CMC(2:1) by setting the 
measurement standard in the Calcheck Chart. 

• Job / Media – The Job or Media being calchecked. The field displays N/A if  a Calcheck is done without  
assigning a Job or Media to it. 

• Date – The date and time the Calcheck was completed. 

• ∆Cyan / ∆Magenta / ∆Yellow / ∆Black / ∆Gray / ∆Paper – The ∆ values for the significant CMYK process, gray 
and paper (substrate) patches are displayed here. 

• Pass / Fail – Displays a green tick (pass) if all the measured patches fall within the ∆ tolerances as defined in  
the Calcheck Chart. A red cross (fail) is displayed if any patches measure outside the defined tolerances. 

• ∆ Average – The average delta of the patches measured in the Calcheck. 

• ∆ Maximum – The maximum delta measured for any patch in the Calcheck. 

• ∆σ – The standard deviation of the patches (from the ∆ Average). 

• Score – The relative quality of the printed Calcheck as compared to the reference values. Rated from 1-100. 
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Measurements Panel 

The  Measurements  panel  contains  the  detailed  reference  and  measurement  data  for  each  colour  patch  in  the 
Calcheck Chart used for the check. Colour patches that pass are shown in black, those that fail are shown in red. 

The following sort columns are available, depending on the ∆standards defined in the Calcheck Chart: 

• Name – The name of the colour patch. 

• Colour (ref) – A colour swatch of the reference colour in the Calcheck Chart. 

• Colour (meas) – A colour swatch of the measured colour. 

• Lab (ref) – The reference Lab values of the colour patch in the Calcheck Chart. 

• Lab (meas) – The measured Lab values of the colour patch. 

• ∆e max – The maximum ∆e (CIE76, CIE94, CIE2000, CMC(1:1), CMC(2:1)) tolerance value for the patch as 
defined in the Calcheck Chart. 

• ∆e – The measured ∆e (CIE76) of the colour patch. 

• CIE94 – The measured ∆e (CIE94) of the colour patch. 

• CIE2000 – The measured ∆e (CIE2000) of the colour patch. 

• CMC(1:1) – The measured ∆e (CMC(1:1)) of the colour patch. 

• CMC(2:1) – The measured ∆e (CMC(2:1)) of the colour patch. 

• ∆H max – The maximum ∆H tolerance value for the patch as defined in the Calcheck Chart. 

• ∆H – The measured ∆H of the colour patch. 

• ∆Ch max – The maximum ∆Ch tolerance value for the patch as defined in the Calcheck Chart. 

• ∆Ch – The measured ∆Ch of the colour patch. 

Device/Spectrophotometer Panel 

This panel allows you to choose which measuring instrument is to be used. 

• Spectrophotometer – Select the spectrophotometer to be used for measurement from a list  of supported 
instruments. 

• Configure – Select the measurement condition and/or other options available to the connected instrument. 
This option is only available to instruments with configuration options.

• Measure – Initialises the chosen instrument and opens a popup window to select which Calcheck Chart is to 
be measured. Measurement begins after the chart is selected. The data from a chart measured by a third 
party software package can be loaded for a Calcheck be selecting CGATS/ISO12642 file from the instrument 
list. The file must have been saved in an appropriate format. 

• Print Chart – Opens a chooser window to select the Calcheck Chart for printing, and the Pagesetup, Media 
and Jobticket combination to submit the chart to. The chart will  be printed in a configuration suitable for 
reading by the chosen instrument. 
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History Panel 

When Calcheck History is enabled in Server Settings, the History panel can be accessed via the hourglass button in 
the top right of the Calcheck application window. This panel displays all Job and Media Calcheck results stored in the 
historical database. Calcheck measurements that passed verification are displayed in green, those that failed are 
shown in red. Calcheck histories can be exported as .csv files for use in reporting. 

Options 

• Back – Returns the application to the Summary, Measurement, or Info panel (the last panel viewed). 

• Refresh – Refreshes the History panel, updating the listed items to reflect recently added items or a changed 
date range. 

• Job/Media – Drop down toggle. Switches the History panel between Job and Media History views. 

• Time Period – Drop down menu. Choose the time period – Today, 1 week, 1 month, or Date Range – of 
Calcheck results to display in the History panel. If Date Range is selected “from” and “to” date fields will 
become available. 

• Search – Enter text to search for specific history items from those currently displayed. 

The following sort columns can be selected using the contextual (right-click) menu on the column header bar in the  
History item list: 

Job View Only 

• Job ID – An internally assigned ID number of the job. 

• Job Done Date – Date and time the job was printed. 

• Pagesetup, Media, Jobticket and Output – Database items used to print the job. 

Media View Only 

• Media – The Media for which the calcheck was performed. 

• Output Driver – The output driver used to print the calcheck chart. 

Job and Media View 

• ID – Calcheck record number. 

• Calcheck Date – Date and time the calcheck was performed. 

• Chart – The calcheck chart against which the Job/Media was measured. 

• Score – Calcheck score (from 0-100). 

• Pass – the pass or fail status of the Job/Media. 

• ∆e Type – the ∆e formula used in the Calcheck chart (Delta E, CIE94, CIE2000, CMC(1:1), CMC(2:1)) 

• ∆e Cyan / ∆e Magenta / ∆e Yellow / ∆e Black / ∆e Gray / ∆e Paper / ∆e Average / ∆e Max / ∆e σ (std 
deviation) 

• ∆H Cyan / ∆H Magenta / ∆H Yellow / ∆H Black / ∆H Gray / ∆H Paper / ∆H Average / ∆H Max / ∆H σ (std  
deviation) 
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• ∆Ch Cyan / ∆Ch Magenta / ∆Ch Yellow / ∆Ch Black / ∆Ch Gray / ∆Ch Paper / ∆Ch Average / ∆Ch Max / ∆Ch  
σ (std deviation) 

The bottom of the History panel has the following options: 

• – (Delete item) – Deletes the currently selected item(s). A warning message will appear to confirm as deletion 
from the database is permanent. 

• Load  –  Loads  the  details  of  the  history  item,  switching  the  view to  the  last  selected  panel  (Summary, 
Measurements or Info). Double-clicking on a job will also load details. 

• Export All / Export Selection – Export all or selected history items from those currently displayed to a .csv file.  
A Choose Columns window will pop-up to select which of the available columns to export, followed by a file 
window to name and save the file. 

Backing up Calcheck History

Important Note: The calcheck history database is backed-up as part of the Backup Server operation (Server window 
> Help menu > Backup Server). It is not included in (.sdb) backups performed using the Archives application. 

Info Panel 

When Calcheck History is enabled in Server Settings, an Info panel can be accessed via a button at the top right of  
the Calcheck window. 

When Job details are loaded from Calcheck History, this panel displays the complete Job Info (see QueueManager) 
for the job. If the job still exists in the QueueManager, imaged and rendered thumbnails are also shown. 

If Media details are loaded, relevant details of the Media database item are displayed. 

Menu Options 

The following options are available from the Calcheck menu or the contextual menu (right click) from within the 
Calcheck application: 

• Load Media – Select a Media to load into Calcheck. Any Media that have been calchecked previously will  
display complete results of their last Calcheck. A new chart can be printed and/or new measurements taken 
and the results updated to the Media. 

• Check Media – Select a Media to be measured. This option assumes a Calcheck Chart for the Media has 
been printed. It immediately opens a window to select the chart for measuring and initiates measurement on 
the selected Spectrophotometer. On completion, results are saved to the Media and previously calchecked 
Media will be updated. 

• Load Job – Select from a list  of previously calchecked Jobs sitting in the QueueManager. Once loaded, 
complete  results  of  the  job’s  last  Calcheck  are  displayed.  A  new  chart  can  be  printed  and/or  new 
measurements taken and the results updated to the Job Info. 

• Check Job – Select any job currently in the QueueManager to be measured. This option assumes a Calcheck 
Chart for the job has been printed. It immediately opens a window to select the chart for measuring and 
initiates measurement on the selected Spectrophotometer. On completion, results are saved to the Job Info 
and previously calchecked jobs will be updated. 

• Print Label – Print a summary label of the currently displayed Calcheck results to a system printer. 
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• Print Report – Print a Calcheck report on the job / media, or choose to save as a PDF. 

• Page Setup – Allows the user to configure the label printing properties for the Print Label option above. 

• Show Graph – Displays a representational graph of the ∆e for each patch of the currently loaded Calcheck 
result. Checkboxes toggle pass/fail views. Results can be displayed in one of three formats, selected via 
dropdown menu: 

◦ Show Error Bars – Shows two (2) coloured spheres, joined by a bar for each patch positioned in a 3D 
Lab colourspace.  The dull  sphere represents the reference value for  the patch;  the shiny sphere is 
positioned based on its Lab values in the colourspace. The relative distance between spheres shows the 
∆e between them. 

◦ Error Plane – Shows a line of coloured spheres representing each patch, lined up in order. The larger the 
sphere, the higher the ∆e. 

◦ Error Spheres – Shows a coloured sphere for each patch position in a 3D Lab colourspace. The larger 
the sphere, the higher the ∆e. 

• Export Calcheck as SVF – Exports the Calcheck information as an SVF file. Any additional tags added to the 
file may not be supported. 

• Export Calcheck as standard SVF – Exports the Calcheck information as a standard SVF file (as per spec)  
with no extra tags added. 

• Export Calcheck as ISO28178 – Exports the Calcheck information as an ISO 28178 xml file. 

• Export Calcheck – Opens an Export Swatches as…? pop-up window. Select from one of the following file 
formats in which to export Calcheck reference and measurement data: 

◦ ISO12642 –  Exports the patch data as CGATS text file, able to be imported into ICC profiling software.

◦ Tab Delimited – Exports the patch data as a generic tab delimited text file. 

◦ X-Rite CxF – Exports the patch data as a CxF file. Note: When exporting non-Lab colour swatches, 
measurements are added as additional patches in the file. 

• Show History – When Calcheck History is enabled this toggles to the History panel of the Calcheck window 
application. 

Contextual Menu Options 

• Export – Export the colour patch data from the display panel to a text file. 

• Import – Import colour patch data into the Calcheck application from an exported text file. 
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Clustering 
Clustering is the ability to share the workload of processing jobs across multiple devices. Slaves or cluster nodes can 
be installed on other machines on the network and jobs can be sent to them from the Master for processing. The 
Clustering application allows you to add and manage these cluster nodes. They can be enabled for use in imaging, 
rendering or both. 

As a node device starts up, its speed is calculated. When a job is submitted for processing, the Master machine has 
priority as no network traffic is required. If the Master is busy processing another job, the job can be sent to the  
fastest available node. The node processes the job and once completed, sends it back to the Master. It is then ready 
to accept another job. Nodes can be installed on any machine on the network. 

Running a Cluster Node requires a separate Megarip dongle. If you have extra Megarip dongles, any Server can act 
as a node if it is started as a Cluster Node (see “The Megarip Server” section for more information). 

Note: In this mode, the Server can only be used as a Node (slave) for another Server. It is recommended that the 
database be backed-up and job queues cleared before a Megarip Server is started as a Cluster Node. This avoids 
any conflicts with existing job IDs or settings. 

Master Panel 

This panel displays information about the Master Server machine. 

• Product – The Serendipity Megarip software in use. 

• Version – The Server software version. 

• Hostname – The network name of the Master Server. 

• IP Address – The network IP address of the Server. 

• Speed – The relative speed of the Server, calculated by Megarip. 

• Processors – The number of CPUs in the Server machine. 

• Platform – The operating system/kernel version of the software. 

• Process Imaging/Rendering/Schedule Last – Check whether the Master Server is to perform any Imaging or 
Rendering Jobs. The Schedule Last option allows nodes to have priority over the Master when jobs are  
processing.  This  is  advantageous  when  polling  large  RIPs,  as  it  allows  the  Master  to  concentrate  on 
gathering the list of jobs and displaying them. 

Cluster Nodes 

This list shows nodes that are available and running on the network. Information about each node is displayed in the  
window. Online nodes are displayed in green; offline nodes in red. 

The following sort columns can be selected using the contextual (right click) menu on the column header bar in the 
Cluster Node panel. Columns can be reordered by dragging and dropping them into the desired order, or by using the 
Configure Headers option in the contextual menu. The sort options are: 

• IP address – The network IP address of the Node. Checkboxes become available to enable the node and 
select if it is to be used for Imaging and/or Rendering tasks. Once enabled, the Master handles the clustering 
in the most efficient manner possible. 

• Hostname – The network name of the Node. 

• Speed – The relative speed of the Node calculated by Megarip. 
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• Platform – The operating system/kernel version of the Node machine. 

• CPUs – The number of CPUs in the Server machine. 

• Product – The Serendipity Megarip software being used for the Node. 

• Version – The Server software version of the Node. 

• Processing Pool – Optionally choose a Pagesetup Pool (see the Workbench – Pagesetup Pool section) for 
which the Node will perform image and render tasks. 

• Image – Shows the number of simultaneous Imaging tasks that can be performed by the Node. Click on the 
field to change the number. 

• Render – Shows the number of simultaneous Rendering tasks that can be performed by the Node. Click on 
the field to change the number (see the Server Settings for details on Imaging and Rendering task settings). 

• Refresh – The Refresh button polls the network for active Nodes and registers any Nodes in the list that are 
offline. 

Cluster Node activity can be monitored in the ClusterStatus module (see the Modules – ClusterStatus section for  
more information). 

Menu Options 

The following options are available from a contextual (right click) menu within the Cluster Node panel: 

• Add Node – Add a Cluster Node that cannot be seen. Sometimes Nodes on subnets cannot be detected. 
Selecting this allows you to enter the hostname or IP address of the Node and add it to the list manually. The  
Node to be added must be running. 

• Add Processing Pool – Select, change or remove the current Pagesetup Pool for which the Node performs 
Image and Render tasks. 

• Remove All Offline Slaves (Nodes) – Remove a Node from the list that has gone offline. 

• Remove Node – Available for offline Nodes only. This option removes the selected Node from the list. 
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Densitometer 
The  Densitometer  application  allows  you  to  measure  and  display  density  readings  with  a  supported 
Spectrophotometer. When measuring a patch, the densities of all four process CMYK colours making up the patch 
are read. 

The Last Measured panel in the top half of the application window shows the density and dot percentage values for 
the dominant process colour of the measured patch, with the values of the other three colours to the right. The values  
can be recorded and saved to a file if desired. 

Note: The Densitometer application is a utility allowing you to use a Densitometer or Spectrophotometer that does not 
have a display to read values. This can be as a one-off reading to compare densities, or you may want to read values  
and export them for plotting on a graph. There is no requirement to use this for the normal operation of Serendipity  
Megarip. 

Densitometer/Measurement/Paper Options 

• Yule Nielsen Number – Enter the YN number for the paper you are reading (if known). The default is 2.0. 

• Densitometer – Choose one of the supported instruments from the available list. 

• Instrument Default Density Standard – Select your desired density standard from the available list. 

• Activate/Deactivate – Connect or disconnect the chosen device. 

• Add – Add the measured values to the list. This appears after the Densitometer has successfully connected. 

To begin measuring: 

1. Select a Densitometer from the dropdown list and click the Activate button. 

2. The status field is shown when the device connects without error. 

3. Follow any instructions when prompted – Calibrate, Measure Cyan Solid, etc. 

Measure Targets 

In order to read percentage tint values of any plate, you must first read the paper white and the solid density value for  
that colour. The Measure Targets menu or contextual (right click) menu allows you to measure the solid reference 
densities for the process colours and the paper white. With these values stored, colour percentages can be calculated 
and displayed. You can measure or update an individual Solid density or Measure All Targets. 

Colour List 

This is a list of readings taken if the Add is enabled. Each reading is appended to the list and the values measured  
are displayed. The columns can be resized or reordered as required by dragging the header to the preferred position.  
The columns are: 

• Name – The name of the colour read. Defaults to “Untitled” but can be changed by selecting the name and 
entering a new one. 

• Colour – Shows the dominant colour read, i.e., the one with the highest density value. This may not be the 
colour you perceive it to be, but the contents making up the colour are recorded and the colour is calculated  
and shown. 
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• Density – The density value for the colour. This is the highest density read from C, M, Y and K. It shows the  
density of the colour stated in the Colour column. 

• Cd/Md/Yd/Kd – The C, M, Y and K densities of the colour read. 

• Dot% – The dot percentage of the colour shown in the Colour column. 

• C%/M%/Y%/K% – The C, M, Y and K percentage values for the colour measured. If any of the % columns 
are blank, the reference paper white or solid density for that colour has not been measured. 

Export 

You can export the values from the Colour List to a file. The available options are: 

• All – Saves all entries in the list. 

• Selected – Save the selected entries in the list only. 

Selecting either of these options displays a window allowing you to choose the values to be saved. The choices are: 

• Name – Save the name of the colour. 

• Colour Density – The highest density reading regardless of colour. 

• Cyan/Magenta/Yellow/Black Density – The density reading of the chosen colour. For e.g., if Cyan is selected,  
the Cyan density for each reading is taken. This is the value displayed in the Cd column of the list. 

• Colour Percentage – The percentage reading of the highest density read as displayed in the Dot% column. 

• Cyan/Magenta/Yellow/Black Percentage – The percentage reading of the chosen colour. For e.g., if Cyan is 
selected, the percentage of Cyan for each reading is taken. This is the value displayed in the C% column of 
the list. 

The percentage values must be present for the values to be exported. If they are not, the exported file will show a 1%  
value in place of the reading. 

• Order Values – Choose whether to export the file in CMYK or KCMY order. 

• Separate Values With – Choose to separate the values with either a tab character or a space. 

• Cancel – Cancels the Export action. 

• Export – Displays a file chooser allowing you to enter a name and select a location to save the file to. 
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Displays 
The Displays application uses a supported Spectrophotometer to calibrate and create an ICC profile for a selected 
monitor or light booth. Suitable graphics monitors can be calibrated to match a chosen print gamut, allowing colour 
accurate softproofing of print material and can be verified at any time to ensure correct colour output. 

Creation  of  a  profile  is  very  simple,  requiring  a  supported  instrument  and  a  few  minutes  of  time.  The 
Spectrophotometer is placed on the screen to be calibrated. A series of adjustments are made to the screen gamma, 
white point and brightness (if available). Measurements are taken, from which an ICC profile is created and saved in 
Megarip and the operating system as the native display ICC profile. 

Note: The Displays application creates a profile for use with the Match ICC profile assigned to the monitor in Server 
Settings. Ensure the correct match profile is set before creating the monitor profile (see the Server Settings – Colour  
section for details). 

The Displays interface comprises of a function list (left) and a multi-purpose display area (right) that will  change 
depending on the function selected. 

The function list is made up of the following selectable items: 

• Calibration – Lists each connected display available for calibration. 

• Calcheck – Lists each connected display available to calcheck. 

• History – Lists the calcheck history (reference only) of each connected display. 

• Ambient – Measure the ambient and white point of the light source. 

• Light Booth – Appears only when a light booth is connected and will list each connected device. 

Calibration 

The Calibration function displays currently connected monitors and their calibration status. 

By clicking on the Calibration header, each connected monitor shows the following details: 

• The name of the Display, viewable screen dimensions in mm x mm, and its identification number (in a multi-
display environment). 

• Pixels (width/height). 

• Resolution (DPI). 

• ICC profile. 

• Calcheck Status. 

• Last Calibrated (time). 

• Calibration Expires (time period). 

• Hardware Calibration (supported or not for the particular display). 

By clicking on the Display name, calibration options and settings available for the monitor are shown. These include: 

• Brightness – Only available if hardware calibration is supported and selected for the monitor (see below).  
Choose to set the brightness level in either: 

◦ Candela – Brightness in cd/m2. 

◦ Set the level from 0-100%. 
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• Calibration Tolerance – Enter a value in this field or use the slider to set the tolerance (in cd/m2) for monitor 
or light booth brightness calibration. 

• Measure – Click to use a connected Spectrophotometer to measure and display the brightness (cd/m2) and 
white point (K) of the monitor. Follow any onscreen instructions for the selected instrument. The reading is  
constantly updated, allowing the user to manually adjust the brightness using the monitor’s own controls. This 
option is only available if the Use Software Calibration option is selected or is the only mode available (see  
below). 

• White Point – Select the white point temperature for the monitor. Choose from: 

◦ Custom – Type in the field provided or use the slider to enter a custom temperature in Kelvin (K). 

◦ D50 – Sets the white point to D50 (5003 K/Horizon Light). 

◦ D65 – Sets the white point to D65 (6504 K/Noon Light). 

◦ Native – Sets the Displays application to use the monitors native white point. 

• Gamma – Select the gamma correction to be used for the monitor. 

• Custom – Type in the field provided or use the slider to enter a custom gamma value between 1.0 and 2.6. 
The Custom button will auto-select if a non-standard gamma setting is chosen. Note: If either 1.8 or 2.2 are 
chosen, the 1.8 or 2.2 buttons will auto-select. 

◦ 1.8 – Select this to set the gamma correction value to 1.8. This button will auto-select if 1.8 is chosen via 
the Custom field/slider option. 

◦ 2.2 – Select this to set the gamma correction value to 2.2. This button will auto-select if 2.2 is chosen via 
the Custom field/slider option. 

Options 

• Use  Hardware  Calibration  –  When  supported,  this  option  uses  the  monitors  own  internal  hardware  for 
calibration, allowing the screen brightness to be adjusted automatically. 

• Use Self  Calibration  –  Available  on  some high-end  graphics  monitors.  Uses  the  monitor’s  own internal 
hardware and calibration routines for calibration. 

• Use Software Calibration – Calibration is performed using the Displays application software. 

• Instrument (offline/online) / Instrument Name – Displays the currently activated instrument. 

• Instrument – Select from the list of supported Spectrophotometers to use for display calibration. 

• Display Type – Select the type of display being calibrated from LCD, CRT or RAW. 

• Monitor Identification Number – Click to popup an identification number in the centre of the screen for the  
display to be calibrated. 

• Calibrate – Click this button to start calibrating the selected display to the chosen settings and create the 
display ICC profile. Follow any onscreen instructions for your instrument. When calibration is complete, a file  
chooser will popup to name and save the ICC profile. The profile will be saved as the operating system native  
ICC profile for the display and will appear as the Native Profile in Serendipity Client Preferences > Colour 
Management (see System Settings for more information). 

• Save Profile – Opens a file chooser (as above) to save or rename the ICC profile. 

• Information Panel – Appears while the ICC profile is being generated, showing the progress and final results 
of the calibration process. 
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Calcheck 

The Calcheck function displays Calcheck status summaries for all attached monitors, as compared to the values 
defined in the Calcheck Chart assigned to the SoftProof Default Press and Camera setting. Clicking on the Calcheck 
header allows users to quickly view whether a display is currently calibrated for softproofing a particular press profile.  
See Applications > SoftProof; or Workbench > Press for details. 

Note: If a Calcheck summary is blank, this means: 

No Calcheck data exists for the monitor; That the current Calcheck for the monitor was measured against a different  
Calcheck Chart than the one assigned to the SoftProof Default Press; or No Calcheck Chart has been assigned to  
the default Press. 

The top section of the display area shows: 

• SoftProof – The currently selected Default Press or Default Camera configuration. 

• Calcheck Chart – The Calcheck Chart assigned to the above configuration. 

The  remainder  of  the  display  area  shows  the  current  Calcheck  status  of  each  connected  monitor.  Information 
includes: 

• Process Colour/Gray/Paper delta values. 

• Average/maximum/standard deviation delta values. 

• Display name (top left). 

• Timestamp of the last Calcheck (top right). 

• Chart and Instrument used (bottom left). 

• Overall Calcheck score (bottom left). 

Note: In cases where multiple areas of a screen have been calchecked, the summary will display the worst results 
from across all calchecked areas. 

Clicking on a Display name under the Calcheck header (e.g., iMac) will allow the user to perform a Calcheck on the 
chosen monitor. 

The main part of the display area (white box) will show the detail or summary of the Calcheck as it is performed. The  
top section above the main area has the following options: 

• Δ All – Shows all of the Δ results measured, as defined in the Calcheck Chart. 

• Δe – Shows all of the Δe results only. The Δe standard used (DeltaE/CIE94/CIE2000/CMC(1:1)/CMC(2:1)) is 
selected in the Calcheck Chart (see Workbench > Calcheck Chart for details). CIE2000 is a recommended 
standard to use for display verification. 

• ΔH – Shows all of the ΔH results only. 

• ΔCh – Shows all of the ΔCh results only. 

• Summary button – Shows Calcheck summary results. 

• Detail button – Shows results for each measured patch of the Calcheck Chart. 

The lower section of the main display area contains the following: 

• Screen Area buttons – These buttons enable the user to look at results from one of the nine (9) defined areas 
of  the monitor  screen.  The buttons are grayed out  (cannot  be selected)  if  a  screen area has not  been  
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calchecked. Areas that have been checked will enable the button and show whether the area passed (green) 
or failed (red) a Calcheck. 

• Instrument (offline/online) / Instrument Name – Displays the currently activated instrument. 

• Instrument – Select which supported Spectrophotometer is to be used for the Calcheck. 

• Measurement Type – Select which area of the screen to Calcheck or Calcheck the whole (3x3 grid) screen.  
The middle centre of the screen if the default option for standard Calchecks. 

History 

By clicking on the History header, users can see at a glance the Calcheck summaries for all attached monitors. This 
is useful for keeping track of any changes in your monitor’s performance (i.e., drifting). 

Information includes: 

• Process Colour/Gray/Paper delta values. 

• Average/maximum/standard deviation delta values. 

• Display name (top left). 

• Timestamp of the last Calcheck (top right). 

• Chart and Instrument used (bottom left). 

• Overall Calcheck score (bottom left). 

These summaries show Calcheck results for the monitor(s) in relation to the Calcheck Chart used at the time of 
checking (shown at  the bottom left  of  the summary).  The summaries are independent of  the currently  assigned 
SoftProof Default Press / Calcheck Chart although, in most cases they will match the current Calcheck summaries 
(see above section). 

Clicking  on a  Display  name under  the  History  header  (e.g.,  iMac)  will  allow the  user  to  review past  results  of  
Calchecks for the monitor. The window shows a sort list of previous Calcheck results, with the time and date the 
Calcheck was performed and the Calcheck Chart used. Selecting a history item will display a summary or the detailed 
results. Calcheck history within the Displays application is only kept for a period of 30 days from creation for each 
history item. 

The Displays menu has the following options available for Calcheck related tasks: 

• Page Setup – Allows the user to configure the label printing properties for the Print Label option below. 

• Print Label – Print a summary label of the currently displayed Calcheck results to a system printer. 

• Print Report – Print a Calcheck report on the job / media, or choose to save as a PDF. 

• Show Graph – Displays a representational graph of the ∆e for each patch of the currently loaded Calcheck 
result. Checkboxes toggle pass/fail views. Results can be displayed in one of three formats, selected via 
dropdown menu: 

◦ Show Error Bars – Shows two (2) coloured spheres, joined by a bar for each patch positioned in a 3D 
Lab colourspace.  The dull  sphere represents the reference value for  the patch;  the shiny sphere is 
positioned based on its Lab values in the colourspace. The relative distance between spheres shows the 
∆e between them. 

◦ Error Plane – Shows a line of coloured spheres representing each patch, lined up in order. The larger the 
sphere, the higher the ∆e. 

◦ Error Spheres – Shows a coloured sphere for each patch position in a 3D Lab colourspace. The larger 
the sphere, the higher the ∆e. 
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• Export Calcheck as SVF – Exports the Calcheck information as an SVF file. Any additional tags added to the 
file may not be supported. 

• Export Calcheck as standard SVF – Exports the Calcheck information as a standard SVF file (as per spec)  
with no extra tags added. 

• Export Calcheck as ISO28178 – Exports the Calcheck information as an ISO 28178 xml file. 

Ambient 

By  clicking  on  the  Ambient  header,  the  option  to  select  a  supported  Spectrophotometer  becomes  available  to 
measure the ambient (cd/m2) and white point (K) of the light source, e.g., a light booth or room. 

• Instrument (offline/online) / Instrument Name – Displays the currently activated instrument. 

• Measure – Select from the list of supported ambient-mode spectrophotometers to use for measurement. 

Note: For some spectrophotometers, after initial instrument calibration, an ambient light filter will need to be attached 
before measurement. 

The lower, white area displays constantly updated measurements. 

Light Booth 

By clicking on the Light Booth header (when available), any currently connected light booths will be shown. 

Each connected light booth shows information on: 

• Name/Model. 

• Driver. 

• Driver Version. 

Clicking on a light booth name under the header will make calibration options available for the booth. These include: 

• Brightness – Choose to set the brightness level in either: 

◦ Candela – Brightness in cd/m2. 

◦ Set the level from 0-100%. 

• Instrument (offline/online) / Instrument Name – Displays the currently activated instrument. 

• Instrument – Select which supported Spectrophotometer is to be used for the light booth calibration. 

• Adjust – Click this button to calibrate the brightness of the selected booth. Follow any onscreen instructions. 

Note: For some spectrophotometers, after initial instrument calibration an ambient light filter will need to be attached  
before placing it in the booth and commencing the booth adjustment. 
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FlipBook 
The FlipBook application allows you to view a publication as a virtual book. In Megarip, a publication is defined as a 
group of pages with the same publication name. This is a collection of book or magazine signatures that have been 
de- imposed, but a publication may consist of any number of pages. 

FlipBook allows you to load the publication and flip through pages as you would with a real magazine or book. This 
enables you to check that your de-imposition has worked correctly, that pages are in the correct order, orientation and  
if there are any duplicates. Larger views of the pages can be called up and the whole publication can be exported to  
PDF or as a QuickTime movie. 

FlipBook can be opened: 

1. From the Application menu of the Serendipity Client. Publications can be dragged and dropped from the 
QueueManager into the FlipBook window and will open automatically. 

2. From the QueueManager application by selecting a job and choosing View Flipbook. The View FlipBook 
option is only available if the job has a publication name. 

The FlipBook window comprises of four (4) main panels – Publication, Pagination, Page View and Page Index. 

Publication Panel 

This panel contains the name of the Publication being viewed. 

Pagination Panel 

• Start – Enter the page number for the starting page or use the arrows to select the first page number of the  
FlipBook. If the first page loaded is page 1, you cannot alter the start page number. If the first page loaded is 
greater than 1, you can enter a lower value as the start page number. This can be used if you are viewing a 
part publication where the first pages have not been processed. 

• Top Page – Choose whether the top page of the FlipBook is Even or Odd. 

Page View Panel 

This panel is where the FlipBook pages can be viewed. When a FlipBook is opened, the pages of the publication are 
loaded and displayed in 2D (two-dimensional) view. There are various ways to navigate through the publication: 

• Clicking on the page of the image – If you click on the right page, you move forward through the publication.  
Clicking on the left page moves backwards. 

• Clicking on the pages in the Page Navigator Panel – displayed below the Page View panel. The view jumps 
to the page (pair) you select. 

• Space Bar – The space bar moves forward to the next pair of pages. Hold the shift key and press the space 
bar to move backwards. 

• PageUp/PageDown – Use these buttons on the keyboard to navigate forwards and backwards through the 
publication. 

• Arrow Keys – Use down or right arrow keys to move forward through the publication and left or up to move  
backwards. 

• Scroll Bar – Moving the scroll bar below the image moves forwards or backwards through the publication. 

Serendipity Megarip Product Manual – Version 9.1
115



Page View (Contextual Menu) 

There are various options available from the context (right click) menu: 

• Open Publication – Opens a QueueManager showing all  jobs processed in  the system. Select  a job or 
publication job to load and click OK. 

• Reload Publication – Reloads the current publication with files from the queue. This is used if additional files  
have been processed as part of the publication, or changes have been made and the publication needs to be 
updated. 

• Choose Press – Select a Press configuration to apply to the job currently (and subsequently) loaded into the 
FlipBook. (see Workbench – Press for details). 

• Job  Info  –  displays  the  Job  Info  information  about  the  currently  selected  page.  (see  Workbench  – 
QueueManager for details). 

• Swap Page with – This allows you to swap the page currently selected with another page from the same 
(currently loaded) publication. 

• View Original – opens and views the imaged file of the selected page in the SoftProof application. 

• View Printed – opens and views the rendered file of the selected page in the SoftProof application. 

• View 3D – toggles between a 3D or 2D view of the publication. Three dimensional viewing shows the page 
turning as you navigate through. The turning speed can be adjusted FlipBook Settings. 3D mode adds 2 
sliders on the right side of the Page View. The first alters the angle at which the 3D virtual book is viewed, the 
second zooms the view in and out. 

Note: The performance of the page turning may vary depending on the size of the thumbnail being viewed and the 
performance of the graphics card. 

• View as Calendar – Only available in 3D mode. Changes the flip axis to horizontal so pages flip up and down  
in the same manner as a calendar. 

• Export  –  Exports  the  FlipBook  as  a  PDF.  Select  the  resolution,  compression  type  and  quality.  Choose 
between exporting the whole book or a range of pages. 

• Export as Spreads – Exports the FlipBook as a PDF but as spreads. The same options as above apply. 

• Render Queue Thumbnails – View the rendered thumbnails in rather than the default imaged thumbnails. 

Page Index Panel 

The Page Index displays a numbered box for  each page making up the loaded Publication.  It  allows for  direct  
navigation to any page by clicking on it. 

The page boxes are colour coded: 

• Light green indicates the pages are loaded into the FlipBook and can be viewed. These show as dark green  
when selected. 

• Purple indicates there are duplicate pages, i.e., they have the same publication name and page numbers. 
Dark purple indicates the pages are selected.  Clicking on these pages allows users to select and view the 
alternative page. 

• Light red indicates the page is not in the FlipBook. This occurs when there are other pages greater than the  
numbers displayed. This could be due to the imposition signature not being rendered yet. As they render, 
reload the publication to update the pages. 

The status colours are updated whenever Reload Publication is selected. 
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A bar directly above the Page Index displays the job name for each currently viewed page on the left and right sides 
respectively. Pages with more than one version will show a dropdown to select which version to view. The page  
numbers being viewed are shown in the centre of the bar. 

Menu Options 

The following are available from the FlipBook File Menu: 

• Open Publication. 

• Reload Publication. 

• Export. 

• Export as Spreads. 

• Export as Movie.

• FlipBook Settings – Configure the FlipBook viewing options and press configuration. 

View Options 

• Allow Multiple  Windows  –  Enable  or  disable.  Allows  multiple  Publications  to  be  opened  and  viewed  in 
separate FlipBook windows. If  disabled, a newly opened Publication will  replace the one currently being 
viewed. 

• Page Order – Choose between reading left to right or right to left. 

• Flip Time (3D) – Select the speed for the flipping of pages when in 3D mode. 

• Render Queue Thumbnails – Enable or disable render queue thumbnails. 

• Show Borders (2D) – Enable or disable the borders when viewing in 2D mode. 

Press Configuration 

This panel allows you to view or change the Press configuration FlipBook uses to display Publications. 

View Menu 

These options are also available from the FlipBook View Menu: 

• View 3D. 

• View as Calendar. 

• Ink Weight – Opens the Ink Weights window displaying the FlipBook publication’s ink weights and coverage. 
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Jobs 
The Jobs application is used to display jobs before, after and during processing and allows users to manage jobs 
through the system to plot their progress. 

The Jobs application consists  of  an easy to navigate user-interface,  with  tabs and layouts available for  various 
monitoring functions. Tab layouts may be added or managed according to individual preferences and are saved at the  
Client level, allowing different users to display information appropriate to their location and workflow. 

Jobs is the default monitoring application and will be run automatically on launch of Megarip after the initial software  
installation. 

Menu Options 

Tabs Menu 

• Add Tabs–Add a new tab to the Jobs main window. Select from a list of factory default layouts. New tabs can 
be imported for use via the Manage Tab Library option. 

The factory default tab layouts available are: 

• Job Queues (default loaded view). 

• QueueStatus – Adds a tab with multiple QueueStatus modules. 

• Status and Drop – Contains the MediaStatus, Status, QueueStatus, DropZones and ClusterStatus modules. 

• Logs – Contains the ServerLog and ClientLog modules. 

• Jobs – Contains the QueueManager module with the Jobs view selected. 

• Jobs and Drop – Contains the QueueManager module, a DropZone and a QueueStatus module. 

• Assets – Contains the QueueManager module with the Assets queue selected. 

• Drop Area – Contains the DropZone module with Assets dropspot added by default. Right-click to add any 
additional dropzones to the Drop Area tab. 

• ServerLog – Contains the ServerLog module only. 

• Rename Tab – Rename the selected tab. 

• Manage Tab Library – Add, remove or preview tab layouts for the Jobs application. 

• Close Tab – Close the currently selected tab. 

View Menu 

• Previous Tab – Open the previous tab window. 

• Next Tab – Open the next available tab window. 

• Titlebars – Show or hide the titlebars for each module within the Jobs application tabs. This will show or hide  
all titlebars in all tabs and is not limited to the currently selected tab. 
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Job Queues Tab

The default tab layout (Job Queues) for the Jobs application contains the following modules: 

• QueueManager (See QueueManager section for further information on features and use). 

• Thumbnail – Imaging Preview. 

• Thumbnail – Rendering Preview. 

• QueueStatus – Imaging Queue. 

For information on each module, see the Modules section of this manual. 
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Lineariser 
The Lineariser application creates a Linearisation Curve for an output device (printer). Assigned to a Media after 
paper profiling, it brings the output device to a known (linear) state. This means a 50% Cyan will print at 50%. 

The user first prints a stepped wedge chart for a selected Spectrophotometer/Densitometer to the output device in the 
colourspace specified by the Media. The chart is measured and the resulting curve is saved, assigned to the Media 
and a History recorded. 

At this stage, ICC profiles can be created and applied for accurate colour representation. If the printer output varies 
due to ink batches or head wear, a quick re-linearisation process is all that’s required to get back to the same linear 
state initially created. The original ICC profiles can be re-applied to achieve the same colour output. 

The Interface 

The Lineariser window is made up of a Toolbar and a number of panels – Available Media, Linearisation History, 
Measurement, Advanced Options, Spectrophotometer or Densitometer information and Curves display. 

Toolbar 

The following options are available via the Toolbar at the top of the panel. Any option can be shown or hidden by 
ticking/unticking it in the contextual (right-click) menu within the Toolbar. The Configure Toolbar option in the menu 
also allows the order of the buttons/options to be set. 

• Customise Patches – Allows for the selection of patches to be used in the Linearisation Chart. Choose which 
Patch Percentages using the numbered buttons. Total number of patches selected is displayed. 

• Restore Defaults – Restore the patch selection to the default 23 patches per channel. 

• Use Lab – Toggles between Density and Lab measurement modes. Lab mode for linearisation is required for 
printers with built-in Spectrophotometers. 

• Measure Patches – Initialises the connected Spectrophotometer. Follow any instructions in the status bar to 
measure the chart. 

• Submit Linearisation – Save the data in the Measurement panel to the Media being linearised. A popup will 
request a name for the curve. 

• Reset Linearisation – Regenerates the linearisation chart to match the loaded Media’s colourspace and paper 
profile. Normally only used in the event of a channels mismatch popup warning when printing a linearisation 
chart. 

Note: If viewing curves loaded from a Version 3.x or earlier database, the options will be unavailable until the Update 
Legacy  Curves  option  is  selected  from  the  Measurement  panel  contextual  menu  (see  below).
There is no need to update Version 3 curves if your printer is performing satisfactorily. However, there have been 
significant improvements made to the Lineariser so it is worth considering re-linearising with Version 9.1. 

Available Media 

This panel displays a list of available Media. Select a Media to view its current linearisation curves and data, or to  
linearise a new Media. Any changes made are applied to the currently selected Media. 

Serendipity Megarip Product Manual – Version 9.1
120



Linearisation History 

Shows a list of all the linearisations performed for the selected Media, allowing the user to track the performance of  
the output device. 

The following sort columns can be selected using the contextual menu on the column header bar. Column order can 
be changed by dragging and dropping the columns into the desired order, or by using the Configure Headers option in 
the context menu: 

• Date – Date and time the linearisation was measured. 

• Type – Shows whether each linearisation curve was measured in Density or Lab mode. 

The panel has one (1) button: 

• Trim To – Trims the number of stored histories to the value shown from oldest first.

The following options are available from the context (right click) menu within the History list: 

• Show Charts – Launches a separate window that plots the linearisation history of the Media/Gradation Curve 
on various charts (See below for further information on the available charts). Checkboxes at the top of the 
window allow you to choose which ink channel to view. Shift+click to view another channel at the same time.  
Double click a channel to see all. 

• Revert  to  this  Date  –  Reverts  the  linearisation  curve  assigned  to  the  Media  to  the  selected,  historical 
(previously measured) curve. 

• Unload – Unloads the historical curve data being viewed in the Measurement panel and loads the currently 
assigned curve. Measurement 

• Curve Name – Displays the name of the Linearisation Curve currently selected. This can be the saved curve 
assigned to the Media or a selected History item. 

• Last Linearised – Located top-right above the measurement panel, Last Linearised displays the date and time 
the printer/media combination was last linearised. 

The display shows the colour-coded linearisation patches for each ink channel. The patch number and the Dot % it 
represents are listed across the top of the panel. Measured Values (Density or Lab) are shown within each patch. If  
no values are present, the Media has not yet been linearised. 

Advanced Options (Density) 

• Yule Nielsen Number – Enter the YN number if you know what it is for the media in use. The default is 2. The  
Yule Nielsen number or N-Factor is used to compensate for dot spread on different media types. This is 
basically a “fudge factor” added to the standard Murray-Davis formula used to calculate dot area from a 
density reading. An N-Factor of 1 means no compensation is made and just the Murray-Davis equation is 
used. An N- Factor of 2 seems to work well with most media types. As adjustments are made, the curve 
preview on the graph will change, showing the effects of the value entered. Further information on the Yule 
Nielsen Number can be found below. 

• Maximum Densities Override – Enter a value to limit the top end density for each of the process colours. The 
default is 0 (no override). As adjustments are made, the curve preview on the graph will change, showing the  
effects of the value entered. Further information on Maximum Densities Override can be found below. 
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Advanced Options (Lab) 

Choose from three (3) ink limiting options for each channel: 

• Default – Standard option, the gradation curve is graphed per the measured ink % patches. 

• Max. Chroma – The end point of the gradation curve is set to the point at which the chroma (a* and b* values) 
of the measured patches stops increasing. This option is suitable for C, M, Y or any other non-black (K)  
channel. 

• Min. L – The end point of the gradation curve is set to the point at the lightness (L*) of the measured patches 
stops decreasing. This option is suitable for Black (K), Light Black or gray channels. 

Densitometer/Spectrophotometer 

• Device – Select the appropriate instrument from the pull down list of devices.

Note: The Embedded Printer Spectro option is only available when in Lab measurement mode (Use Lab enabled). 

• Configure – Select the measurement condition and/or other options available to the connected instrument. 
This option is only available to instruments with configuration options.

• Instrument Standards – Choose from the list which instrument standard is to be used for measurement. This 
will only appear when Use Lab is not enabled. 

• Measure – Connects to the selected instrument and prepares to read patches. The patch window changes to  
a measuring window and the instrument list changes to a text field where instructions are displayed. 

• Print  Chart  –  Print  the appropriate chart  for  the selected instrument  to  the Media  selected.  You will  be 
prompted with an options window with the following: 

◦ Cancel Printing – Cancels the action and returns to the previous window. 

◦ Don’t Apply. Print to Linearise – This will disable all colour management except for Paper Profile. Use this  
to make a Linearisation Curve. 

◦ Yes. Print to check Linearisation – This applies all colour management so you can check a Linearisation. 

Curve 

This panel shows the Linearisation Curves for each ink channel. 

Select individual channel checkboxes to view a channel. Shift+click to add more channel curves to the view. Double 
click a channel to show all curves. 

Show Charts 

Selecting Show Charts will display another window with a chart for each channel in the linearisation curve. At the top 
of the window is a series of tick boxes, one for each colour. Selecting one displays the single colour and hides all 
others. Selecting another box changes the graph to that colour. Select the same colour again and all graphs will be  
displayed. Use SHIFT+Click to show more than one graph. 
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Chart Types 

There are five (5) chart types available for selection: 

• Density / History – Plots the date of the curve on the X-axis and the density values for each patch on the Y-
axis. If the density begins to drop off, it will be displayed in the chart. 

• Density / Patches – Plots the patches along the X-axis and the density on the Y-axis. For each patch in the 
history, a point is placed on the graph. If the density for a given patch does not vary greatly, the points will  
appear on top of each other. Where there is some change, a line will appear between points. 

• Dot % / History – Plots the date of the measurements on the X-axis against the dot percentage on the Y-axis.  
The points on the chart represent the patches. For any patch, the effective dot % and how it varies across the  
history is shown. 

• Dot % / Patches – Plots the patch number along the X-axis against dot percentage on the Y-axis. A diagonal  
line from 0 to 100 is shown as a guide to a linear curve. This graph will show if the patches are generally 
higher or lower than a linear measurement, as well as differences over the course of time. 

• Dot % Delta / Patches – Plots the patch number along the X-axis against the dot percentage delta on the Y-
axis. It shows the percentage difference from the target. For example, if the target is 40% and the measured  
value for that patch is higher or lower, the error is shown in the graph. 

Yule Nielsen Number 

The  Yule Nielsen Number is essentially a “fudge factor” applied to the standard Murray-Davis formula used when 
calculating dot percentage area from density. 

The value is used to compensate for various media types, as some react differently to others in the way a dot will 
spread on a particular media and thus affect the dot percentage value. It is sometimes helpful to change the YN  
number (and some manufacturers will quote a YN number for a given media) but this is rare. 

The YN formula used for calculating the dot percentage is:   

dot is the value of the density being measured. 

solid is the density of the solid patch. 

Therefore, a YN value of 1 has no effect on the dot percentage area. A 
value other than 1 will compensate for the dot spread on the media. If the YN is greater than 1, the Dot % decreases 
and if the YN is less than 1, increases. 

This can be seen from the graph on the Lineariser. 

The  curves  display  the  compensation;  therefore  if  the  YN 
number  is  less  than  1,  the  dot  percentage  calculated  is 
increased so the curve applied will go down. The reverse is true 
for a YN number greater than 1. 

For  most  of  the  testing  done  during  initial  development,  the 
value of 2 (the default setting) seemed to work well. It was also 

noted on occasions, better results were obtainable by setting different values for each process colour. 

Note: As the ICC profiles are created after Linearisation, any value entered will be used for printing the ICC chart and 
will affect the output. This means when the ICC profiles are applied, the same YN number must always be used in 
the Lineariser to obtain correct results. 
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Maximum Densities Override 

The Maximum Densities Override allows the user to cap the top end density to any value less than the maximum 
value read. 

If a value less than the highest value measured is entered, the curve will change. The top end will move down and the 
rest of the curve will adjust to compensate for the new end position. The values in the middle of the curve will also 
change. 

Pros and Cons 

There are various arguments for and against setting a maximum density override. In general, the Match ICC profile 
would set the maximum density values so there should be no need to set them here. However, some users have 
found it to be an advantage to set the values to the target densities required for the final proof output and in doing so,  
have achieved very good results. 

Reducing the density of the output used to print the ICC chart will affect the gamut. However, as the gamut of a press  
is generally smaller than that of a proofing device, this may not have any noticeable effects. 

It is desirable to drop the top end densities of the output prior to ICC creation, as sometimes there is a need to boost  
the values after ICC is applied. This should only be used as a last resort and is not desirable as a general rule. If the  
top end densities drop, the ICC profiles are generally to blame and therefore should be corrected. 

Note: It is the Match ICC profile that has the biggest bearing on the output and sets the output top end densities. 
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Monitor 
The Monitor application is an alternate user-configurable version of the Jobs application, central to the Serendipity 
Client interface (see Applications > Jobs). Like Jobs, it displays jobs before, during and after processing and allows 
users to manage jobs through the system to plot their progress. The Monitor provides feedback from the Server and 
Client via logs. Modules can be added and configured to suit specific requirements. See the Modules section for 
further information. 

The Monitor  consists  of  one or  more user-defined tabs.  Modules are added,  positioned and sized according to 
individual preferences. Settings are saved at the Client level, enabling Serendipity Clients on different systems or
in different departments to display information appropriate to their location. 

The Monitor can be in one of two modes – Edit or Use. 

Edit 

This mode allows the user to move and resize modules on a tab. The mouse pointer changes to a cross when in Edit  
mode. Resize a module by grabbing the corners or sides and dragging to the preferred size. Click anywhere in the 
modules and drag it to the desired position. Modules close together will snap-to each other. 

While in Edit mode, all Modules have a contextual menu available (right-click) with the following options: 

• Remove (Module) – Removes the module from the Monitor tab. 

• Set Size For (Module) – Allow the user to enter a width and height (in pixels) for the selected module via a 
resize popup. 

• Duplicate (Module) – Duplicates the selected module. The duplicate has all the size, layout and configuration 
options of the original. 

• Use Layout – Switches the Monitor to Use Mode. 

Use 

This is  the normal user mode. It  locks the module sizes and position and allows you to configure the modules 
preferences and manage jobs. Select this after Editing to use the configured layout. 

Menu Options Layout 

• Edit – Switches the Monitor to Edit Mode (see above explanation). 

• Use – Switches the Monitor to Use Mode (see above explanation). 

• Dynamic Update – Enables or disables updates to the modules while in Edit mode. 

• Show Titlebars – Shows or hides module titlebars. 

• Add Modules – See the “Modules” section for further information on each module. 

• Load – Loads a previously saved Monitor configuration. 

• Save As – Saves the current Monitor configuration. 

• Search UI (User Interface) – Activates a search bar for finding buttons and functions in the current Monitor 
tab.

Note: Module Toolbar functions can only be searched if the toolbar is open. 
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Tabs 

• New Tab – Creates a new tab. 

• Rename Tab – Renames the currently selected tab. 

• Duplicate Tab – Duplicates the currently selected tab and all modules within it. 

• Choose Tab Colour – Allows the user to select a colour for the currently selected tab. 

• Choose Tab Image – Allows the user to select an image for the currently selected tab background. Valid types 
are PNG and JPEG. It is recommended a large image not be used, as it will take up memory. 

• Clear Tab Colour/Image – Reverts to the default background colour. 

• Remove Tab – Deletes the currently selected tab. 

• Remove All Tabs – Deletes all tabs. 

• Next/Previous Tab – Switches to the next or previous Monitor tab (right or left). 

Reordering Tabs 

Tabs can be moved to a new position by clicking on and dragging the tab to the desired place in the order. A red  
pointer appears, showing the drop point between two tabs. 
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SoftProof 
The Softproof application is used to proof a job on the screen. There are many tools available to check every aspect  
of  the job at  any stage of  production or  processing.  SoftProof  can be used in  conjunction with or  instead of  a  
hardcopy proof. Using a calibrated monitor and configured press settings, proofs can be viewed and verified onscreen 
with precise colour accuracy. 

All  job  plates  are  shown  and  can  be  turned  on  or  off,  or  changed  as  desired.  Colour  attributes  and  plate 
characteristics can be changed to see the effects of different printing processes, including paper types and the effects 
of show-through from the reverse side. 

The data can be exported to various file formats, including CIP3 and PDF. An Ink Key Viewer can display a job as it  
would be on the press, with the values for each key shown. 

The ink weight can also be calculated and over-ink areas identified. The proof can also be verified using the Displays 
application to give a pass or fail status in accordance with chosen colour standards. 

Layout 

The SoftProof application consists of a large, central viewing window for jobs; a visual Tools menu on the left and a  
View panel to the right; a Navigation Thumbnail at the top right; and a status bar along the bottom of the window. 

TAB Key – When SoftProof is selected as the current active window, the TAB key will show/hide the Toolbar, the  
Navigation Thumbnail and Panel, and the Status Bar. 

Navigation Thumbnail 

This thumbnail shows the entire image loaded for softproofing. The area currently shown in the main viewing area is  
represented by a rectangle on the thumbnail. Mouse over and left-click to view a new area of the proof. 

Status Bar 

This  bar  shows  the  information  about  the  currently  loaded  proof,  the  SoftProof  Press  Setting  and  the  current 
calibration status of the monitor in relation to the Press Setting (see Applications > Displays for more information on 
screen calibration). 

The left of the bar displays:

• Jobname (Original/Printed Preview) and current zoom level % 

The right of the bar displays: 

• Current Press or Camera settings, along with the Embedded ICC Profile for the image (if applicable). Use the 
tick box to override the currently selected Press or Camera profile and enable the embedded ICC Profile. 

Clicking on the Press or Camera profile button will popup a menu with the option to choose another Press/Camera 
setting if available. 

When Calcheck Managed is enabled (Client Preferences > Colour) a small tick or cross representing the Calcheck 
status will be displayed in the status bar at the bottom right of the SoftProof window. 
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Hovering the mouse pointer over the cross or tick shows a tooltip (when Tooltips are enabled) displaying information 
including: 

• The ICC Profile used by the monitor (normally created using the Displays application, Calibrate option).

• The Calcheck Chart  assigned to the Press/Camera Settings currently  used in SoftProof  and the current 
calcheck status of the monitor.

Click on the Tick/Cross to popup a menu with the following options: 

• Calibrate – Begin calibration of the monitor using the current settings and Spectrophotometer assigned in the 
Displays application. Once calibrated, the monitor ICC profile is automatically saved as the operating system 
default replacing the previous ICC profile. 

Note: When calibrating or calchecking, the Spectrophotometer assigned in the Displays application for either tasks 
should be connected and ready for use. If the instrument is different to the assigned one an error will occur, ceasing  
the operation. It is recommended to check the appropriate Spectrophotometer has been assigned before using the 
Calibrate or Calcheck Monitor functions (see Applications > Displays). 

• Calcheck Monitor (Chart Name) – This option will open the Displays application and begin a Calcheck of the 
softproofing monitor using the Calcheck Chart assigned to the current Press settings. The chart is named in 
brackets. The pass/fail status may change as a result of the check. Detailed results can be viewed in the 
History area of the Displays application. 

Tools 

• Show/Hide Tools – Available from the Tools menu and also activated by pressing the Tab key to toggle the 
show/hide function. This will hide all Tools, Buttons, and the Status Bar in the SoftProof interface.

• Pan (H) – Navigate around the image by clicking and dragging the job around the screen. 

• Zoom (Z) – Zoom in or out of the job. Clicking the mouse zooms twice the current percentage factor. 

• SHIFT+Click will zoom out half the percentage factor. Click and drag over an area to zoom it. 

• Note (N) – Create, manage and delete notes. 

• Measure (I) – Take a measurement on the image. Use the shift key to draw straight horizontal or vertical  
lines. Also displays the angle of the line. This tool can be used to measure approximate screen angles. 

• Crop (C) – Crop an image and resubmit it. 

• Guide (G) – Display guide lines on the image to check for alignment. Change the orientation by pressing 
SHIFT. ESC will remove the guides. 

• Spectro (X)  –  Take measurements of  the job being viewed.  A popup window will  appear displaying the 
Lab/Lch/XYZ/Density values at the point the Spectro cursor is onscreen. A note can be created at the location 
of the cursor to record colour information. 

SoftProof Widgets 

There are four (4) sliding widgets available from the left  panel of  icons in the SoftProof viewing window. These 
include: 

• Channels (Shift+C) 

• Publications (Shift+P) 

• Ink Keys (Shift+I) 

• Get Info (CTRL+I / CMD+I) 
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Channels Widget 

The Channels Viewer shows the channels or plates of the job currently being viewed in SoftProof. Plates can be 
turned on or off by clicking the relevant coloured checkbox to the left of the plate name and can be reordered by  
clicking and dragging to a new position. The plate colour and associated attributes can be changed by double-clicking  
and choosing another Special Colour Set from the library, or edited for that SoftProof instance only. 

• Name – The plate name. The checkbox indicates whether or not the plate is displayed. 

• Value – The percentage of colour at the point of the cursor in the window. Total ink displays the total amount  
of ink at the point of the colour selector, i.e., the sum of all plate percentages. For RGB it will  show the 
relative RGB values only. 

Publications Widget 

When softproofing a job that forms part of a publication, additional controls and view options are available: 

• Single Page – Display just the single page selected. Disabling this option enables the following: 

◦ Show Back Page (B) – Display the reverse side of a page through the page currently loaded, as if the 
final print was being held up to the light. The Back Page Opacity setting in the Press Settings controls the 
amount of show-through. 

◦ Show Page Spread (D) – View the spread of the selected page, for example, pages 2 and 3 as a spread.

Ink Keys Widget 

The Ink Keys icon will display the Ink Key Viewer containing the loaded image in the SoftProof window. 

At the bottom of the window will be a series of ink keys. Colour bars give a graphical display of the proportion of each 
ink contained within the job across the keys. 

For each key selected, the relative percentage of ink for each of the plates is shown. An information panel runs down 
the right side of the window. The top of the panel shows information about the currently loaded Press Settings. Job  
view and placement can be changed and ink weight can be calculated for any job. 

• Colour checkboxes – Positioned above the image, these show the inks or plates used in the job. Clicking on 
one will turn the others off and leave the ticked colour on. SHIFT+Click allows for multi-selection of colours. 
Double-click to show all. 

• Ink Keys – The keys at the bottom of the window show the inks selected to be viewed on a graph. The scale 
of the graph varies, depending on the amount of ink in the job. Hovering over or clicking on an ink key will  
display the key number and its ink values at the bottom of the information panel. 

• Press Settings – Shows the values for the currently loaded press. Click the box to show or hide the details.  
Press settings used are selected in the Default Press panel of the SoftProof Settings. 

• Show Excess Ink Weight Area – Display areas exceeding the Maximum Ink Weight setting as defined in the 
Press configuration. 

• Max Ink Key Value – Set the size of the ink keys to match your press. Ink values are calculated based on the  
size entered. If the size is 100, percentages are displayed. 

• Sheet Placement – Show the job as positioned on the press sheet defined in the configuration. The job can 
be centred (selecting the Centre checkbox),  or  offset  from the left  (X) and bottom (Y).  De-selecting this 
displays the whole job in the viewer and changes the ink keys to show total ink amounts for the job. 
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• Ink Weight Calculator – Calculate the amount of ink required to print (x) number of copies. 

• Print Run Size – How many to print. 

• Ink Weight (g/m2) – Enter the weight of the ink used in grams per square metre. 

• Calculate – Based on the values entered for ink weight and print run size, the total weight of ink for each  
colour will be calculated for the loaded job and displayed in the ink value area. 

Contextual (right-click) menu options include: 

• Show Ink Key Table – Shows a separate window, listing the ink key values of all keys for each plate. These 
can be printed using a local printer or exported to PDF. 

• Export Tab Delimited – Exports the values for the keys and ink values to a tab delimited text file. 

Get Info Widget 

The Get Info icon will display job information about the currently viewed image in SoftProof – how it was processed,  
what Pagesetup and Media were used and other useful processing information. Click the icon again to hide the panel. 

Loupe 

The Loupe is available via the sidebar menu. Once opened, the Loupe will appear with the default setting “Loupe to 
Mouse” enabled. 

Loupe Options (accessed via the Spanner icon): 

• Screening LPI – Enter the desired value for screen ruling for SoftProof in Lines Per Inch (LPI). The default is  
150. 

• Loupe to Mouse – This is enabled by default. The mouse pointer location is used as the reference point for  
the Loupe display. This allows you to position the Loupe off image and use the mouse to display the relevant 
part of the image within the Loupe for proofing. 

• Rulers – Turn rulers on or off. The rulers will appear in the Loupe window with measurement units displayed. 
The rulers are centred or at the mouse pointer location if held over the Loupe window. 

The Loupe is moved around the SoftProof by left-click and holding to drag it. 

The Loupe can be resized by clicking on the button with 3 lines (see image) and dragging outwards. The mouse scroll 
wheel will also increase/decrease the Loupe size when the mouse is positioned over the window. 

A number of display and control options are available via the buttons at the bottom of the Loupe window: 

• + (button) – Click to increase the zoom factor of the Loupe. The zoom factor is displayed at the bottom centre  
of the Loupe. Note: 100% = the resolution at which the proof was originally imaged, i.e., 1 screen pixel is 1 
job pixel. 

• - (button) – Click to decrease the zoom factor of the Loupe. 

• Spanner – Opens the Loupe Options window. 

SoftProof Menu Options File Menu 

• Open Files – Load an image file directly into SoftProof. Supported file types are Canon RAW format (CRW), 
JPEG, PNG, PPM, Serendipity Blackmagic Image, TIFF and Adobe Photoshop PSD. 
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• Open Jobs – Load completed jobs into SoftProof. The Imaged (Original) or Rendered (Printed) file may be 
viewed. 

• Save – Save the preview as a Blackmagic Image File. This can be submitted or placed in a hot folder, or on a 
DropSpot. 

• Export – Export data from SoftProof. The available formats are CIP3, PDF, Postscript (Separated) and TIFF 
Multichannel. 

• Revert – reloads the original or printed preview file, reverting any effects that have been applied to the job in 
the SoftProof application.

• Submit – Submit the current preview, including any onscreen changes, to a Pagesetup/Media/Jobticket. This 
re-images and re-renders the job at the current image preview resolution. If the resolution is restricted in  
Server Settings then the limited resolution will be used. 

• Submit  ICC  Target  –  Submit  the  current  preview,  including  any  onscreen  changes,  to  a 
Pagesetup/Media/Jobticket as an ICC Target. The preview submitted uses the Paper Profile, Linearisation 
LUT and Correction LUT in the Media but is not ICC corrected. 

• SoftProof  Settings  –  Opens  the  preferences  for  SoftProof,  allowing  for  configuration  of  default  viewing 
conditions. See below for further information. 

SoftProof Settings 

The SoftProof Settings allow you to select viewing preferences including how to load a job, and the quality and press 
settings used to produce accurate proofs. The settings window is split  into four (4) tabs – View Options, Image, 
Default Press and Default Camera. 

View Options Tab 

Window 

• Allow Multiple  Windows  –  When enabled,  allows  jobs  to  be  opened and  viewed  in  separate  SoftProof  
windows. If  disabled, each job viewed will  appear in a tab running along the top of the same SoftProof 
window. If a job is dragged and dropped into SoftProof from the QueueManager, it will replace any open 
image in the viewing window selected. 

• Status Bar Size – Select the size of the status bar text from Small, Medium or Large. 

• Rulers – Show or hide the rulers. 

• Scrollbars – Show or hide the scrollbars. 

• Image Centring – Select to align any images opened in SoftProof either Horizontally or Vertically or both. 

• Max Preview Resolution – Set the maximum preview resolution for SoftProof for both Imaged and Rendered 
options. The default is zero (0), which is the full job resolution of the output file. 

On Load 

• Honour Embedded ICC Profiles – When enabled, this will honour any embedded ICC profiles when viewing 
the image in SoftProof. 

• Rotation – Control the orientation of jobs when they first load. The option None leaves the job in its imaged or 
rendered orientation. 

• Zoom Level – Select the default zoom setting. All fitting zoom modes calculate the size based on the monitor 
resolution. This is set in the Colour Management tab of the Client Settings. 
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• Show Back Page – (Checkbox) Toggles whether publications with consecutive pages will open in SoftProof 
displaying back page show-through (based on Press settings) by default. 

• Show Spreads – (Checkbox) When enabled the publication pages open in SoftProof as part of a spread pair 
alongside the previous/next page. 

Publications 

• Enable  Pager  Thumbnail  –  Enable  or  disable  the  thumbnail  viewer  when  viewing  a  publication.  When 
enabled, a thumbnail of the page appears when the mouse pointer hovers over the page number box. 

• Enable Pager Sections – When enabled a Section label/button is displayed above the pages in the SoftProof 
Page Index panel.  This allows for  loaded multi-section publications to be viewed one section at  a time,  
displaying the page range within each section. Clicking the section label bar will open a menu to choose 
which section to view or to view all sections. 

Image Tab 

• Resampling Algorithm – Set the resampling algorithm for jobs as they are viewed in SoftProof. 

• Screening LPI – Enter the desired value for screen ruling in lines per inch (LPI). The default is 150. 

• Unsharp Mask – The Unsharp Mask feature allows SoftProof  previews to  be sharpened onscreen.  The 
sharpening applied is controlled via the following settings: 

◦ Amount  –  Choose  the  amount  (from 1-500%)  of  edge  sharpening.  The  higher  the  value,  the  more 
contrast between pixels around the edges. Default value is 180%. 

◦ Radius – Define the width (from 1-100 pixels) of the edges that the filter will sharpen. The higher the 
value, the wider the edge. The appropriate value to be used varies depending on the resolution of the 
softproofed image. Lower resolution images require a smaller radius value. Higher resolution images 
require a higher value. Default value is 3 pixels. 

◦ Threshold – Specify the difference in brightness (from 0-255) that must be present between adjacent 
pixels before the edge is sharpened. A lower value sharpens edges with minimal contrast difference. 
Higher values sharpen when adjacent pixels are very different in contrast. The default value is 15. 

Default Press 

The default press tab allows the selection of a Press configuration from the database to be applied to the loaded jobs 
and for all subsequent jobs loaded in SoftProof. 

• Press 1 – The default press used for softproofing jobs. 

• Press 2 – Assign an alternate press configuration for publications that include pages printed on a different  
stock, e.g. glossy magazine covers. 

An information window shows the settings of the currently loaded Press setup. Configurations are managed in the 
Workbench and contain information such as size, number of keys and colour information. 

Default Camera 

The default camera tab allows for the selection of a Camera configuration from the database to be applied to any  
loaded jobs using an RGB colourspace. If Honour Embedded ICC Profiles in the SoftProof Settings is unchecked and 
the RGB image contains an ICC profile, the default camera configuration will be used in its place. 
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An  information  window  shows  the  settings  of  the  currently  loaded  Camera  setup.  Camera  configurations  are 
managed in the Workbench and contain information such as the ICC profile to be used, rendering intents, black point  
compensation and Calcheck Chart reference. 

View Menu 

Select menu items are also available as icons within the SoftProof window. 

• Tabs – Control the tabbed viewing of images in SoftProof. 

• New tab – Opens a new, empty tab ready for a job. Use the Open Job option or drag and drop a job from the  
QueueManager to view it. 

• Close Tab – Close the currently selected tab. 

• Next Tab – Loads the next available tab. 

• Previous Tab – Loads the previous tab. 

• Show Tab – Show/hide the tabs listed at the top of the screen. 

• Get Info – Display information about the softproofed job and how it was processed. 

• Show Page Boundary – Display a red line around the page area of the job. 

• Show Notes – Display any notes attached to the job. 

• Ink Weights – Opens a window displaying the ink weights (source and print inks) for the job. 

• Go To Page – Opens a popup window to enter a page number to display in SoftProof. Only available for 
publications. 

• Proof  Colours  –  For  use  with  RGB images  only.  Automatically  select  a  Press  Configuration  to  display 
onscreen what the RGB image will print like using a specific Press profile. The selected Press will appear in 
the status bar at the bottom right of the screen. Clicking the status bar button will allow you to adjust which 
profile is used. 

• Zoom In/Out – Zoom in or out of the image. Holding down CMD (Mac) or CTRL (Win) and scrolling the mouse 
wheel over the image will allow for zoom in and out functions. 

• Show All – Fit the entire job into the SoftProof window. 

• Show Actual Pixels – One pixel of the screen is equal to one pixel of the job. This is shown at 100%. This 
view mode has the quickest load time as resampling for scaling is not required. 

• Show Actual Print Size – Show the print size of the job. 

• Fit Width/Height – Fit the job to the height or width of the SoftProof window. 

• 90 CW – Rotate the image 90 degrees clockwise. 

• 90 CCW – Rotate the image 90 degrees counter-clockwise. 

• 180 – Rotate the image 180 degrees. 

• Rotate – Rotate the currently viewed job by the positive or negative angle (###.##°) entered in the popup  
window Angle field.

• Revert Rotation – Undo any rotation made to the image in SoftProof. 

• Invert – Invert (negate) the image. 

• Mirror – Mirror the image. 

• Autocrop – Remove any whitespace around a job. There must be a completely clear area on any one side of  
the job. 

• Unsharp Mask – Apply an unsharp mask to the image. This will affect the edges within the image. Settings for 
the unsharp mask can be set via the SoftProof Settings. 

• Use Press 2 – Switch between Press 1 and 2 as configured in the SoftProof Settings for non-RGB images 
viewed in SoftProof. 
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• Full Screen – Switch between full screen mode and window mode. 

• Thumbnails – Select the Thumbnails tab within the SoftProof window. 

• Page Index – Select the Page Index tab within the SoftProof window. 

• Notes – Select the Notes tab within the SoftProof window. 

• Loupe – Display a virtual loupe on top of the loaded image. The loupe can be resized and magnification level  
changed if required. The current magnification is shown at the bottom of the Loupe; 100% means 1 screen to  
1 job pixel. 

Thumbnail Panel 

The thumbnail panel displays a small image of any jobs currently open in SoftProof. Clicking on the relevant image 
will switch the SoftProof preview to that window. 

Notes Panel 

Notes gives users the ability to draw a text box on the imaged or rendered SoftProof to make a note. The note is 
attached to the job file and remains attached until it is either deleted or the job is removed from the system. There is 
no limit to how many notes can be created, and they can be shown or hidden as required. 

Notes cannot be attached to files opened in SoftProof via File Menu > Open Files. The file needs to be submitted as a  
job before any embedding of notes can take place. 

When creating a note with the Note Editor, a configurable arrowhead pointer option is available along with the existing  
area marker for a more precise commentary on the job. The User and Group of the note creator are also displayed 
(see Secure Mode). Notes can be edited or the anchor adjusted by double-clicking on the Note. 

The Note panel displays any notes attached to the job currently selected in the main viewing window. There is also a  
Note column in the QueueManager showing the number of notes attached to a particular job. The Notes icon on the 
left menu bar is used when adding Notes to the softproofed image. The Notes icon in the right panel is used to 
display or hide any notes on the image. 

• Show Notes – Show or hide the notes on the preview. Notes can also be toggled by clicking the icon on the 
right panel. 

• Text – The text making up the note. 

• User / Group – The User and Group responsible for the note. 

Page Index Panel 

The Page Index panel displays a numbered box for each page making up the loaded publication. This allows for  
direct navigation to any page by clicking on the page number. Hovering the mouse over a page number will pop-up a  
thumbnail for the page. The “T” hotkey toggles the thumbnails on or off. 

The page boxes are colour coded: 

• Light green indicates the publication pages are loaded and can be viewed. These show as dark green when 
selected. 

• Purple indicates there are duplicate pages, i.e., they have the same publication name and page numbers. 
Dark purple indicates the pages are selected. Clicking on these pages allows viewing of the alternative page. 

• Light red indicates the page is not yet available for viewing in SoftProof. This normally occurs when there are 
page number gaps if pages have not yet imaged or rendered, or when processing a de-imposed publication 
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with  known  (signature  defined)  page  numbers.  As  the  missing  pages  image/render,  close  and  re-open 
SoftProof to update the publication pages. 

Spectro 
The Spectro application allows for  the measurement  of  colours with a  Spectrophotometer.  The accuracy of  the  
measured value can be viewed against an imported value when mapped through a selected ICC profile. 

The window is split into two sections. The right side allows for the import and viewing of a Special Set, which is used 
as the comparison base. The left side displays the measured values. Selecting a particular measured value matches 
the closest colour of the imported set, giving it relative deltaE values. These can also be filtered to only show the 
closest matches for better viewing. 

Options 

• Spectrophotometer – Select a device from the list of supported spectrophotometers. 

• Configure – Select the measurement condition and/or other options available to the connected instrument. 
This option is only available to instruments with configuration options.

• Activate – Connect to the selected device. Once connected, the pull down device list will change to display  
any status messages from the device and the values measured. 

• Turn Off – Disconnects the connected spectrophotometer. Alternates with the Activate button. 

• Add – Select this to append to the list for each reading. If this is not selected, the last reading is updated. This 
is available after the device has successfully connected. 

Measurement / Loaded Set Panels 

The Measurement and Loaded Set panels show the following information: 

• Colour – A swatch visually representing the colour. 

• Name – The name of the colour. This can be edited by clicking in the name field. 

• Values – the Measured (Lab) values of the colour or the (colourspace specific) values of the Loaded Set 
colour. 

The Measurement Panel displays these additional data fields: 

• Lch – the Lch values of the measured colour. 

• Lab (above the list) – shows the Lab values of the currently selected measured colour. 

• Xyz (above the list) – shows the xyz values of the currently selected measured colour. 

In addition, the Loaded Set panel displays the following: 

• Δe/CIE94/CMC (1:1)/CMC (2:1)/Delta L/Delta a/Delta b – These columns list the relative deltas of the loaded 
set colours when compared to the selected, measured colour. 

• Space – The colourspace of the colour (Lab or CMYK). 

• Mode – The paint mode of the colour. 

• Tint – The tint value of the colour. 

• DotGain – The dotgain curve assigned to the colour (if any). 
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Export Menu 

The Export menu allows for the measured values to be exported to a space or tab delimited file. Save all or only  
selected entries and select the format for export: 

• Lab – Export just the Lab values. 

• XYZ – Export just the XYZ values. 

• Lab XYZ – Export the Lab values followed by the XYZ values on the same line. 

• XYZ Lab – Export the XYZ values followed by the Lab values on the same line. 

• Separate Values With – Choose if the values are to be separated with spaces or tabs. 

A contextual (right-click) menu in the Measurement / Loaded Set panels has the option to Delete (a selected colour);  
Delete All (measured colours); Print (the measured/loaded set to a system device); and Font Options. 
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Studio 
The Studio application allows for the manual nesting or tiling of jobs that are processed and output by Megarip. Any 
jobs to be nested or tiled are submitted to an asset queue before they can be used in Studio. 

Unlike other queued jobs, assets exist only as placeholder thumbnails until a nest or tiled job is submitted for printing 
from Studio. 

Submitted assets are visible in the Asset Queue in the QueueManager and remain, even after printing, until deleted 
via Studio or the QueueManager. 

Studio Interface 

Studio is made up of four (4) main sections: 

• Asset Panel – Displays any submitted asset files available for nesting and/or tiling. 

• Media Panel – Define the printable media (paper) area for nesting and access tiling options. 

• Layout Area – Where any jobs (assets) are placed for nesting and/or tiling. 

• Additionally, the Box Properties can be set to appear in the left section at the bottom. Default is set to be a  
floating box. To lock it into the Side Panel go to the Studio menu > Studio Settings and un-tick the Floating 
Box Properties checkbox. When the blue and white [i] icon is selected from the Toolbar, the box properties will 
load into the panel. 

A toolbar is available for quick access to a range of options and functions listed in the Studio menus. The toolbar can  
be toggled on or off and may be positioned at the bottom or to the right in the Studio screen (see Studio Settings). 

Sections of the toolbar can be hidden by right-clicking on the toolbar and unticking the appropriate section. 

Asset Panel 

The Asset panel displays all jobs that have been submitted as an asset to the Asset Queue. Any assets that appear  
may be used in Studio for nesting or tiling. The assets are low resolution placeholder thumbnails until such time as  
the nest is submitted for print. Place assets in the Layout area by selecting from the list and drag+drop. Assets can be 
selected singularly or in multiples. 

The Asset header bar has the following view options: 

• List View – Display assets in text form (filename/jobname). A thumbnail preview of the image will appear at 
the bottom of the panel when highlighted in the list. 

• Small Thumbnail – Display the assets as small thumbnail images with the jobname listed beside them. 

• Large Thumbnail – Display the assets as large thumbnail images only.

Right-clicking in the Asset panel shows the following options: 

• New Folder – Create a new folder to place assets in. 

• New Folder with Selection – Create a new folder containing any currently selected assets. 

• Rename Folder – Rename the selected folder. 

• Remove Folder – Remove the folder from the list. Any assets in the folder will not be removed but will move 
to the top level. 

• Remove From Folder – Remove the selected asset from the folder and move it to the top level. 
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• Move to Folder – Move the selected folder to another folder, selected from the dropdown. 

Asset Folders are opened: 

• In text view – Double-click on the folder name. 

• In text and icon view – Double-click on the folder. The name will appear to the right of the folder. 

• In Icon only view – Double-click on the folder. The name of the folder will not be visible in this view, however  
mouse hover over the folder will display the folder name. 

To exit/close a folder: 

• In text view – Double-click on the up arrow. 

• In text and icon view – Double-click on the folder icon. An up arrow will appear next to it. 

• In Icon only view – Double-click on the folder icon. 

Folders can be backed-up with a Client backup. The contents (assets) are not included but folder location will be  
remembered when the Client backup is restored, and any assets will be moved to their folder location. 

A searchable field is available at the bottom of the panel. Enter text to find a jobname containing the text string. Non-  
relevant assets are temporarily filtered out of the view as the string is typed. This search field will not be available  
when Large Thumbnail view is selected. Clear the search box to view all assets again. If you are in a folder, it will only  
filter within that folder. 

Sort – A dropdown menu is available to sort any assets by Name (Ascending / Descending) or Date (Ascending /  
Descending). 

Media Panel 

The Media panel is used to configure the onscreen representation of the printer media as a guide for job placement in 
the Layout area. 

• Page Size – Select a pre-configured page size from the dropdown menu or enter custom dimensions. 

• Manage Custom Sizes – This option allows users to create and manage custom page sizes for use in Studio. 
Any page sizes created here will also appear in the Media > Cut Sheet page size options in the Workbench 
and in the Signature Groups > Grid page size section. 

• Width – The width of the media being used for printing. If Tiling mode is enabled, this is also the tile width. 

• Height – The height (length) of the media being used for printing. If Tiling mode is enabled, this is also the tile 
height.  Note:  The Height  can be left  at  zero (0)  when using  roll  media  as  the  Layout  paper  guide  will  
automatically adjust the length as assets as placed. If set to 0 when tiling, the height will snap to the image 
placed in the tiling area. 

• Template – Displays the name of the template (if any) currently loaded in Studio. The name will be italicised if 
a change is made to the template, for example removing a frame, and it has not been saved. The field will be  
blank if no template is loaded. 

• Tiling – Enable / disable Tiling mode. Click the Settings button to configure options. 

◦ Settings – Opens document settings which must be configured when using Tiling mode. 

• Width – Total width of the area to be tiled. This is a required field. 

• Height – Total height (length) of the area to be tiled. 

Note: The height can be left at 0 in which case the document height will snap to the image placed in 
the tiling area. 
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• Tiling Overlap – Enter the image overlap amount for each tile. 

Layout Area 

The Layout area is where any jobs (assets) are placed for nesting or tiling. 

The area is surrounded by a ruler, marked with the user-defined measurement units and appropriately scaled to the 
current zoom level. All assets and frames are shown at accurate, relative size. 

The dark gray area is the work surface onto which assets are placed and positioned. The lighter gray area is the 
defined, printable media area (see Media panel). When Tiling mode is enabled, the edges of the total area to be tiled 
appear on the work surface as a red outlined box. 

Menu Options 

Studio Menu 

• Load New Template – Opens the Load Template Window. A list of available templates will appear to the left  
with a visual representation of the template on the right. Select the template to load and click OK. 

• Save New Template – Saves the current frame layout to the template library. Only empty frames are saved, 
not the images within them. A popup will appear to enter a name for the template. 

• Save Template – Opens the Save Template window. This option saves the current nesting layout to the 
selected template in the library, overwriting any existing data. 

• Remove Template – Opens the Remove Template window. Remove the selected template from the library list. 

• Template Info – Opens a window to display a list of available templates. Selecting a template will show a 
visual representation of the template to the right. Selecting OK will display the template permissions, date the 
template was modified and the date created. Permissions can be changed by an administrator if required. 

• Export Template – Export a saved template or templates to a user-defined location. 

• Import Template – Import saved templates. The imported template, or templates if multiple layouts exist in the 
file,  will  appear  in  the  Template  list  when loaded.  Select  Load  New Template  after  import  to  view any 
templates. 

• Print / Print Tiles – Displays a chooser window to select a Media and Pagesetup combination to send the job  
to for processing. The option to enter a Job Name when submitting to print is available in the Submit window.

Studio Settings 

• Cloak  Submitted  Frames  –  Locks  images  and  frames  after  they  have  been  submitted  for  processing, 
preventing changes. Cloaked images will appear shadowed. 

• Auto-place – Allows for automatic placement of assets on to the Layout area when dragging and dropping  
them. The default position is top left (0,0). If a job has already been placed in the area, the auto position will 
align with the left side of the frame. 

• Frame Spacing – The distance (gap) between jobs being auto-placed in the Layout area. 

• Minimise  Cuts  for  Auto-arrange  –  Aligns  auto-arranged  frames  in  a  way  that  minimises  the  number  of 
horizontal and vertical cuts required to separate the individual jobs after printing. This option may use more 
media (paper) when nesting. 

• Snap to Grid – Allows for assets to snap to a user-defined grid spacing, measured from the left ruler. The 
asset frame will snap to the closest defined grid position, taking into account any auto-place spacing settings. 

• Grid Size – Define the snap-to-grid size for frame placement in the Layout area. 
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• Cropmark Type – Select the type of cropmark to apply to any cropmark enabled frames. Choose from Default  
(Standard), Paper-saving or Border. 

• Visual Warning – Enabled by default. Options include: 

◦ Overlap – Display a dashed line around any assets placed in the Layout area that have overlapping 
frames. 

◦ Out of Bounds – Display a dashed line around any assets placed in the Layout area that are outside the 
defined media. 

• Toolbar – Set the location of the toolbar to either bottom (default) or right side of the Studio screen. 

• Floating Box Properties – Enable or disable the Box Properties as a floating box or locked in the left panel  
when open. 

Edit Menu 

• Undo – Undo the last change made. The amount of available undo levels is configured via the Client Settings 
(0 = Operating System default level). 

• Redo – Redo the last  undone change. The amount of  available redo levels is  configured via the Client  
Settings (0 = Operating System default level). 

• Revert Template – Reloads the last opened template in the Layout area. Any changes made to the previous  
layout are removed. Useful if using the same template for different assets. 

• Cut – Cut the currently selected frame to the clipboard. 

• Copy – Copy the currently selected frame to the clipboard. 

• Paste – Paste the frame/s in the clipboard to the Layout area. Paste is centred at the current mouse pointer 
position. 

• Delete Assets – Delete any selected assets from the Studio application and the Asset Queue. 

• Delete Layout Assets – Delete any assets currently in the Layout area from the Studio application and the 
Asset Queue. 

• Create Frame(SHIFT+0) – Create an empty frame in the Layout Area. Default size is 7x5in.

• Create Crosshair (SHIFT+1) – Create a frame in the Layout area containing a configurable crosshair. Click on 
the ... box within the Frame panel in the Box Properties window to view further options. 

• Create Horizontal Line (SHIFT+2) – Create a frame in the Layout area containing a configurable horizontal 
line. Click on the ... box within the Frame panel in the Box Properties window to view further options. 

• Create Vertical Line (SHIFT+3) – Create a frame in the Layout area containing a configurable vertical line.  
Click on the ... box within the Frame panel in the Box Properties window to view further options. 

• Create Colour Box (SHIFT+4) – Create a frame in the Layout area containing a configurable colour. Click on 
the ... box within the Frame panel in the Box Properties window to view further options. 

• Create Text Box (SHIFT+5) – Create a frame in the Layout area containing configurable text. Click on the … 
box within the Frame panel in the Box Properties window to view further options.

Note: For all Create options a frame will appear at the current mouse pointer location if using the shortcut keys. If 
selected from the menu, the frame will appear in the centre of the current Layout view. 
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Frame Menu 

• Bring to Front – Move the selected frame to the front (top) layer of the nesting layout. 

• Bring Forward – Move the selected frame one layer forward (up) in the nesting layout. 

• Send Backward – Move the selected frame one layer backwards (down) in the nesting layout. 

• Send to Back – Move the selected frame to the back (bottom) layer of the nesting layout. 

• Clear – Clear the contents of the selected frame.

• Pin – Pin the selected frame/s to the current location. This stops the user from moving the frame, but an asset 
can be dropped into empty pinned frames and contents  modified.  Auto-arrange,  rotation,  and alignment 
options will override any pinned frames. 

• Unpin – Unpin the selected pinned frame/s.

• Edit Crop – The selected frame will enter Crop mode. Double-clicking on a frame will also enter Crop mode. 

• Group – Group multiple selected frames for movement, deletion, locking or asset multi-drop. Grouping is 
ignored if auto-arrange/ auto-arrange with rotation are used. 

• Ungroup – Ungroup any currently grouped frames. 

• Align Left – Align selected frames along the left edge of the leftmost box in the selection. 

• Align Right – Align selected frames along the right edge of the rightmost box in the selection. 

• Align Top – Align selected frames along the top edge of the uppermost box in the selection. 

• Align Bottom – Align selected frames along the bottom edge of the lowest box in the selection. 

• Align Horizontal Centre – Align selected frames along the averaged horizontal centre line of the frames. 

• Align Vertical Centre – Align selected frames along the averaged vertical centre line of the frames. 

• Orient Up / Down – Alter the frame orientation to either upright or upside down (180 degrees). 

• Orient Right / Left – Alter the frame orientation to either right or left by 90 degrees from the upright position. 

• 90CW – Rotate the frame and contents 90 degrees clockwise. 

• 90CCW – Rotate the frame and contents 90 degrees counter-clockwise. 

• Rotate – Rotate the frame Content (only) by the positive or negative angle (###.##°) entered in the popup 
window Angle field. A selected frame can be rotated freehand by holding Alt+left click, then dragging the 
pointer. 

Note: This option will increase the horizontal and vertical dimensions of the frame. Rotation and freehand 
rotation are only available on the frame style Frame. 

• Lock – Lock the selected frames. Locked frames appear transparent and cannot be edited until unlocked. 

• Unlock All – Unlock all currently locked frames. 

• Decloak  All  –  Decloaks  all  frames.  Allows  for  movement,  deletion  or  editing  of  frames  that  were 
locked/cloaked after submission (only available when Cloaking mode is active). 

• Select  All  –  Selects  all  frames in  the  nest  layout  area  for  grouping,  ungrouping,  movement,  locking  or  
deletion. Frame properties may be adjusted and will affect all selected frames and their positions within the 
Layout area. 

• Select Inverse – Deselects currently selected frames while selecting all previously unselected frames. 
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• Step and Repeat – Create a set of user-defined frames for image placement, or copy dimensions of existing 
frames and repeat them across and down the Layout area. Step and Repeat can also be used to create an  
empty template. If an asset is placed into a frame prior to step and repeat, both frame and asset are repeated 
when selected. 

• Auto  arrange  –  Automatically  arranges  (nests)  the  images  placed  in  the  Layout  area  to  fill  the  media 
dimensions. 

• Auto arrange with Rotation – Automatically arranges (nests) the images placed in the Layout area to best fill  
the media dimensions by appropriately rotating the frames. 

View Menu 

• Zoom In – Zoom in to the Layout area view. Holding down Z+left click will also enable this mode. 

• Zoom Out – Zoom out of the Layout area view. Holding down Shift+Z+left click will also enable this mode. 

Note: Holding down CMD (Mac) or CTRL (Win) and scrolling the mouse wheel over the image will allow for zoom in 
and out functions. 

• Fit All – Scales the Layout area view to show all frames currently in the nest. 

• Fit Tiling Document – Scales the Layout area view to show all assets and frames within the dimensions as 
defined in the Media Panel > Tiling Options. 

• Print Size – Shows the nest in the Layout area at actual print size. 

• Fill with Tiling Document – Scales the Layout area, filling the view to the shorter width or height dimension as 
defined in the Media Panel > Tiling Options. 

• Clear Guides – Clear any guides from the Layout area. 

• Guides – Enabled by default. Create a guide by clicking in the horizontal or vertical ruler section of the Layout  
area and dragging the guide to the desired location. See the “Guides” section for further information. 

• Box Properties – Displays the Group, Frame and Contents properties for any assets and frames placed in the  
Layout area. The window can remain open, floating above any assets for quick access to precise editing of  
frames and images, or it can be locked into the left panel via the Studio Settings > Floating Box Properties 
option. See the “Frames vs Content” section for further information. 

◦ Group – Allows for the accurate positioning of grouped frames only. 

◦ Frame – Displays editable properties for the frame that holds the asset (image/job). 

◦ Contents – Displays editable properties for the contents (asset) placed into any frame. 

• Job Names – Toggle this option to display the name of each job (asset) placed in the layout area. Names are 
displayed at the top edge of each frame.

• Clear  Layout  –  Clears  the  Layout  area  of  all  frames  and  assets,  including  resetting  the  Media  panel  
dimensions. 

• Full Screen – Toggle between a windowed or full screen view. 

• Sidebar – Toggle the view of the sidebar containing the Asset, Template and Media panels. 

• Section Headers – Toggle the headers of each section within the sidebar on or off. 

• Toolbars  –  Toggle  the  toolbar  on  or  off.  Select  which  sections  of  the  toolbar  to  show  or  hide  by 
ticking/unticking the available sections. 
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As an added option, holding down the spacebar will  allow for panning around the Layout area when moving the 
mouse, similar to navigation used in graphics applications. The mouse cursor will change to a hand when this mode 
is enabled. 

Guides 

Guides are a useful tool when placing asset images into the Layout area for printing. Enabled by default, guides are  
created by clicking in either the horizontal or vertical rulers of the Studio Layout interface and dragging a guide in to 
the desired location. Guides are saved with a template design in the library. 

• To move or reposition an existing guide – CTRL (win) / CMD (mac) + click on the guide and drag it to a new  
location. 

• To snap guides to grid – CTRL / CMD + shift + click on the guide and drag it to a new location. The guide will  
snap to the closest grid point. 

• To remove all guides – Select View menu > Clear Guides. • To remove a single guide – CTRL / CMD + click  
on a guide and press delete (not  backspace),  or  CTRL /  CMD + click + drag the guide back in to the  
appropriate ruler. 

• To enter a precise location for a guide – CTRL / CMD + double-click on a guide to open a dialog box and  
enter the ruler location for either horizontal or vertical guides. 

Note: If Guides and Snap to Grid are both active, the asset frame will snap to the guide first if the frame edge is  
closest, otherwise it will  snap to the grid point. Guides are ignored if Auto arrange or Auto arrange with rotation 
options are used. 

Templates 

Templates are a useful tool for anyone needing to make repeat prints using a specific layout for the available media.  
Studio  gives  users  the  opportunity  to  create  and  store  a  library  of  templates,  set  to  specific  sizes,  styles  and 
orientations. 

Templates  are  saved  when  a  Server  backup  is  performed,  or  can  be  selectively  archived  using  the  Archives 
application via the Add to Archive menu options. 

Loading Saved Templates 

Templates (nesting layouts) can be loaded from the template library by selecting Load Template from the Studio 
menu. 

The Load Template window will display any available templates. Selecting a template in the list will display a visual 
representation of the template to the right. 

Select a template and click OK to open, or double-click the name of the template. 

Assets dragged in to an empty frame are resized to fit or fill, are rotated and cropped according to the frame settings.  
A single asset dragged in to a selected frame grouping will be duplicated and placed into every frame within the  
group.  
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Creating Templates 

Templates can be created from an existing asset file or by utilising the Step and Repeat function within Studio. Both 
methods are outlined below.  Media dimensions, guides, frame positions and styles are saved.

Create a Template from an Existing Asset 

1. Select Submit menu > Files as Assets to add the job as an asset. 

2. Navigate and select any files to use in Studio. Once the asset appears in the Asset panel they are ready to be 
used. 

3. Select an asset and drag+drop it in to the Layout area. 

4. Adjust the size and properties for the frame if required. The frame may be copied and pasted in the Layout  
area for quick duplication, or use the Step and Repeat function. 

5. Save the template when finished. This does not save the images within the frames, only the empty frame and 
its various properties. 

6. To load the template, go to Studio > Load Template. Select the template and OK, or double-click the name.  
An empty frame set of the nest will appear in the Layout area, ready to accept any asset files dropped in to  
the frames. 

Create a Template using Step and Repeat 

1. Go to the Frame menu > Step and Repeat option, or select the Step and Repeat icon in the toolbar. 

2. Enter  the  required  dimensions,  spacing  and  number  for  horizontal  and  vertical  distribution.  Frames  will 
automatically appear in the Layout area as values are entered. 

3. Select OK when done. 

4. Select single or multiple frames and adjust their properties as required via the Box Properties option. 

5. Save the template when finished. 

Note: If the Step and Repeat function is used when there are multiple frames selected with varied sizes, all frames 
will be repeated in the Layout area. The size dimensions in the Step and Repeat window will not be editable. 

Frame vs Content 

Assets placed in the Layout area are always contained within a separate frame. 

The  Frame  controls the size, position, style and orientation. Frames in the layout area will display a floating info  
bubble when selected or when hovering the mouse pointer over them. The bubble displays the asset name, its 
current orientation, and the width and height dimensions of the frame. The information updates dynamically when 
resizing with the mouse. 

The Content relates to the actual asset placed inside the frame. If an asset is dropped into the empty Layout area, it  
is automatically assigned a frame. 

Both Frame and Content can be edited via the Box Properties popup window. 

Frame Properties 

• Left – The offset distance of the frame from the left guideline. Offset is measured from the top left corner of  
the frame. 
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• Top – The offset distance of the frame from the top guideline. Offset is measured from the top left corner of  
the frame. 

• Width – The width of the frame. This field will lock when Canvas Wrap is selected. 

• Height – The height of the frame. This field will lock when Canvas Wrap is selected. 

• Lock Button – Locks the current proportions of the frame size if resized along one dimension. The locked 
proportions are overridden by free resizing with the mouse within the Layout area. Frames can be unlocked 
and resized to any required dimension. 

• Cropmarks – Enable to add cropmarks (as defined in Studio Settings) to the selected frame. Cropmarks are 
enabled by default when Canvas Wrap mode is in use. 

• Overprint – Enable to convert the selected frame to overprint mode. Not available when using Canvas Wrap. 

• Style – The style of frame, (Frame, Canvas Wrap, Marker, Frame with Border, or Text). Click the ... button to 
configure options for Canvas Wrap and Marker modes. 

• Canvas Wrap – Convert the selected frame to a canvas wrap. Configure properties via the ... button. 

• Marker – Convert the selected frame to a marker. Configure properties via the ... button. 

• Frame with Border – Create a border around the selected frame of user-defined size and colour. Configure  
properties via the ... button. 

Content Properties 

Content within Studio refers to the actual  assets placed within a frame. Content is editable when in Frame and 
Canvas Wrap modes. It is not available for Marker mode. 

• Left – The offset distance of the asset image from the left edge of the frame. This is available when in Crop  
mode. 

• Top – The offset distance of the asset image from the top edge of the frame. This is available when in Crop  
mode. 

• Width – The width of the asset within the frame. 

• Height – The height of the asset within the frame. 

• Lock Button –  Locks the current  proportions of  the content  if  resized along one dimension.  The locked 
proportions are overridden by free resizing with the mouse. Content can be unlocked and resized to any 
required dimension when in Crop mode. 

• Scaling – The method of scaling used for an asset placed within a frame. 

• None – The asset is shown at actual size inside the frame, irrespective of what size the frame is. 

• To Fit – The entire asset image is rescaled and shown within the frame proportions. 

• To Fill – The asset expands to fill the frame, scaling to show as much of the image as possible given the 
proportions and centring options of the frame. 

• Custom – The dimensions and frame offset for the asset are independent of the frame (similar to Crop mode). 
This method is automatically selected when in Crop mode. 

• Centring – When enabled, any selected frames will have their asset centred within the frame. This is useful 
for reverting to the original placement when undoing any cropping. 
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• Orientation (dropdown) – Change the orientation angle of  the frame Content,  selecting from 0°,  90°CW, 
90°CCW, 180°or  Angle°.  If  Angle°  is  selected,  the  Content  is  rotated  by  the  positive  or  negative  angle 
(###.##°) entered in the pop-up window Angle field. 

Note – the Angle° option will increase the horizontal and vertical dimensions of the Frame. Angle rotation is 
only available on the frame style Frame. 

Canvas Wrap 

The Canvas Wrap mode allows for the asset to be transformed in to a canvas print, ready for stretching around a  
wooden (or other) frame. 

Cropmarks are enabled by default when Canvas Wrap mode is in use. This is to assist in cutting the canvas. Set the  
type of cropmark to be used in Studio via the Studio Settings option. 

Note: Cropmarks (Standard) will take up extra space around a job when selected for use, changing the position of 
the job on the media and the total size of the job once rendered. Paper-saving cropmarks will not expand the overall  
rendered job size. 

Canvas Wrap Options 

• Front width – The width of the front of the canvas. 

• Front height – The height of the front of the canvas. 

• Frame thickness – The thickness of the canvas frame (wooden or other). The default size is 1.25in. 

• Back wrap – The length of canvas to wrap around the back once the canvas is stretched around the frame. 
The default size is 20mm. This will remain as an unprinted area unless Print Back Wrap options are selected. 

• Print Back Wrap – Prints the currently selected wrap style to the back wrap in addition to the frame sides of  
the canvas. 

• Wrap style – The style of canvas to create. Further options are: 

◦ Gallery – This is the default  canvas style, stretching the image to expand to the frame thickness as 
defined. 

◦ Mirror – Mirror the edges of the image to the frame thickness as defined. 

◦ Colour – Select a colour to fill  the frame thickness as defined. Double-click the colour display box to 
select a colour from a Special Colour Set (Blackmagic only), or create a colour using the Lab, CMYK or  
RGB sliders.  

◦ Pick from screen (eyedropper button) – Activates an eye-dropper tool to select a screen/image colour to 
apply to a Colour wrap style. Hover the pointer to see RGB values and a colour swatch of the current 
colour. Left-click to select. This option is only available when using RGB as the selected colourspace. 

• Save – Saves the Canvas Wrap configuration but will not change the size of the asset (image) to fit the 
dimensions specified if they have been altered. 

• Fit & Save – Fit the asset to the configured Canvas Wrap settings and save the layout, returning to the Studio  
screen. 

Note: If multiple canvasses are to be printed, a quick and easy method of duplicating a finished canvas is to use the 
Step and Repeat function. 
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Marker 

The Marker mode allows for the placement of a frame containing a style of marker in the Layout area. 

• Crosshair (Shift+1) – Create a frame containing a configurable crosshair. 

• Horizontal Line (Shift+2) – Create a frame containing a configurable horizontal line. 

• Crosshair (Shift+3) – Create a frame containing a configurable vertical line. 

• Colour Box (Shift+4) – Create a frame containing a configurable colour.

Note: For all create options, a 1x1 inch frame will appear at the current mouse pointer position if using the shortcut  
keys. If selected from the menu the frame will appear in the centre of the screen. 

When in Marker mode, click on the ... box within the Box Properties popup window to view settings for each marker  
style. 

Options include: 

• Marker Type – Select from Crosshair, Horizontal Line, Vertical Line or Colour Box. 

• Line Thickness – Set the thickness of the line for Crosshair, Horizontal and Vertical Line options. Does not 
apply for Colour Box. 

• Line Colour – Select a colour for the line or box as selected above. Double-click the colour display box to 
select a colour from a Special Colour Set (Blackmagic only), or create a colour using the Lab, CMYK or RGB 
sliders. 

• Pick from screen (eyedropper button) – Activates an eye-dropper tool to select a screen/image colour to 
apply. Hover the pointer to see RGB values and a colour swatch of the current colour. Left-click to select. This  
option is only available when using RGB as the selected colourspace. 

Note: If a frame is selected in the Layout area and Marker is chosen from the Style dropdown menu, the frame and  
image within will be replaced with the selected Marker. 

Frame with Border

Frame with Border allows for the asset to have a colour border applied to the outside of the frame. It is best practice  
to apply the style of Frame with Border before any other editing of the frame.

• Frame thickness – The thickness of the border applied to the frame. The default size is 0.5cm. 

• Colour – Select a colour to fill the frame thickness as defined. Double-click the colour display box to select a  
colour from a Special Colour Set (Blackmagic only), or create a colour using the Lab, CMYK or RGB sliders. 

• Pick from screen (eyedropper button) – Activates an eye-dropper tool to select a screen/image colour to 
apply. Hover the pointer to see RGB values and a colour swatch of the current colour. Left-click to select. This  
option is only available when using RGB as the selected colourspace. 

• Save – Saves the configuration.

• Fit & Save – Fit the border to the configured settings and save the layout, returning to the Studio screen. 

• Save as Defaults – Save the current settings as the default option when Frame with Border is selected.

Text 

Text allows for a frame to contain configurable text with a transparent background. Options are available via the … 
button and include: 

• Text – Enter the text to appear in this field.

• Font – Select the font from the dropdown menu. Available fonts include Helvetica and Times New Roman.
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• Orientation – Set the text orientation from 90CW, 90CCW, or 180 degrees.

• Transparency – Set the desired level of transparency for the text. Default is 0% (solid, opaque). 100% will  
render the text invisible.

• Text Colour – Select a colour for the text. Double-click the colour display box to select a colour from a Special 
Colour Set (Blackmagic only), or create a colour using the Lab, CMYK or RGB sliders. 

• Pick from screen (eyedropper button) – Activates an eye-dropper tool to select a screen/image colour to 
apply. Hover the pointer to see RGB values and a colour swatch of the current colour. Left-click to select. This  
option is only available when using RGB as the selected colourspace. 

• Save – Saves the configuration.

• Cancel – Cancels any changes made.

Using Studio

Positioning Assets for Nesting 

A media guide sheet will appear to scale (in light gray) in the Layout area when width and height dimensions have  
been entered in the Media panel. This allows for clear and simple placement of assets for nesting. 

When submitted to print, everything on the media guide sheet is printed. If only a width is entered (for example, using  
roll media), once an asset is placed in the Layout area the media guide sheet will automatically lengthen to fit the job.  
As more assets are placed, the sheet will extend to display the total nesting area. 

Note: It is not necessary to have dimensions entered for the media when creating a manual nest in Studio. When 
submitted, the nest will print to the selected media from the top left origin point, printing as much of the width or  
length of the nest as the paper in the printer will permit. The remainder will be cropped. 

Creating a Nest 

Studio allows for single or multiple assets to be dropped in to the Layout area. 

1. Select the assets (jobs) from the Asset panel. 

2. Drag and drop the assets in to the Layout area. Assets will appear at their native size unless placed in an  
empty frame with specific properties (via template or Step and Repeat). 

3. Resize and adjust the frame and asset as required. This can be done via the Box Properties window or by  
using the following mouse options: 

I. Left click (on a frame) – Selects the frame for editing, movement, locking or deletion. Selected frames 
are highlighted by a magenta border. 

II. Left click (on empty Layout area) – Deselects all frames. 

III. Left  click (hold) + drag (on empty Layout area) – Creates a temporary framing box for selecting  
multiple frames. Any frames wholly or partially within the box when the mouse button is released will  
be selected. 

IV. Left click (hold) + drag (on a frame) – Moves the selected frame around the Layout area. Release the 
mouse button to drop and place the frame. 

V. Right click – Opens the contextual menu with options, depending on where in the Layout area the 
click occurred. 
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VI. Double click (on a frame containing an asset) – Activates Crop mode for the selected frame. A frame 
in Crop mode will appear with a green border (see Cropping Assets for more information). 

VII.Spacebar + Left click (hold) – Activates the Grip tool which allows for panning around the Layout 
area. The mouse cursor will change to a hand when in this mode. 

Resizing Options 

The following resizing options are available when clicking at the borders of a frame. 

• Left  click  + drag – Enlarge or  shrink the frame.  Proportions are maintained.  Resize is  anchored at  the 
opposing edge or corner of the frame. 

• ALT + Left click + drag – Enlarge or shrink the frame. Proportions are maintained. Resize is anchored at the 
centre of the frame. 

• Shift + Left click + drag – Free resizing of the frame, ignoring locked width/height ratios. Assets within the 
frame will fit or fill the resized frame depending upon frame settings. Resize is anchored at the opposing edge 
or corner of the frame. 

• CTRL + Left Click + drag (Windows) – Snaps the frame proportions to the assets native proportions and 
resizes. Resize is anchored at the opposing edge or corner of the frame. 

• CMD + Left click + drag (Mac) – Snaps the frame proportions to the assets native proportions and resizes.  
Resize is anchored at the opposing edge or corner of the frame. 

Grouped frames can be resized by selecting an edge or corner of the group and dragging the mouse. All contents  
within the group are resized proportionally. Canvas Wraps will not be resized if part of a selected group.

Rotating Frames

In addition to the menu, rotation buttons and Content Orientation dropdown, selected Frame (or Grouped frames) can 
be rotated using the mouse pointer within their borders.

ALT + Left click + drag – Changes the orientation angle of the frame contents, rotating them around the centre point  
of the frame.

Note: This option will increase the horizontal and vertical dimensions of the Frame or group. Freehand rotation is only  
available on the frame style Frame. 

Cropping Assets 

Crop mode is activated or deactivated by double-clicking anywhere within a frame containing an asset image, or by  
selecting a frame and clicking the Crop mode button in the toolbar. 

When activated the frame changes from magenta to green and a second frame with an orange border is assigned to 
the asset. Cropping can only be done one frame at a time. Multi-select image cropping is not available. 

Either the frame or asset can be selected and moved, or resized as required. Double-clicking the frames again will 
show how the asset will be cropped. If the frame is resized larger than the asset within, the space around the asset 
will also be printed to the size of the entire frame. 
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Cloaking and Nesting with Large Format Flatbed Devices 

One of Studio’s primary functions is the laying out of jobs for print using large format flatbed printers. 

When activated, the Cloaking feature locks images and frames after they have been submitted as a nest to the 
printer. Cloaked images appear shadowed in the Layout area, are static and non-editable unless decloaked. This 
allows for easy placement and printing of new jobs on to blank, available areas of the flatbed media. Cloaked images 
are not reprinted when a new nest is submitted for printing. 

If desired, it is certainly possible to place jobs over others that have already been printed. Any new image will print  
exactly where it is placed, regardless of whether or not anything has already been printed in that area. 

Important: The cloaking feature is disabled by default. It is not recommended for use with printers using roll media 
unless the device has the ability to roll back to previously unused areas of media. 

Tiling with Media 

Studio’s tiling feature allows users to set the total document area and automatically create a tile grid based on pre-  
configured print media dimensions and overlap. 

Tiling is useful for billboard printing, or any type of printing where the image is larger than the available print media  
(paper). 

To Tile a Job: 

1. Activate the Tiling mode by ticking the Tiling option in the Media panel. 

2. Click on the Settings button to configure the tiling parameters. 

3. Document Width/Height – These are the dimensions of the imageto be tiled. If a height is not entered the 
tiling document height will automatically match the height of the asset to be tiled. 

4. Enter any overlap size if required. 

5. In the Media panel, enter the width and height (optional) of the printer media to be used. This is the tile size. If 
a height is not entered, such as when using roll paper, the tile height will match that of the tiling document. 

6. The tiled area will be outlined by a red border. 

7. Once tiling has been configured, place the asset to be tiled in the Layout area and resize as required. 

8. Submit the job to print when ready. The print option will appear as Print Tiles in the Studio menu. 

Note: Cropmarks and alignment marks are automatically added to any tiling jobs when submitted via Studio. 

Studio Rendering Effects 

There are various rendering effects available when using Studio. They will not be visible in the Layout area and will  
only affect the job when it is rendered, ready for printing. Any effects can be previewed using SoftProof once the job  
has been rendered and nested. 

The available rendering effects are: 

• Cropmarks – Available as a checkbox within the Studio application. Enabling this will place cropmarks around 
the selected frame. This effect will adjust the placement of the job on the media to compensate for adding 
cropmarks during the rendering phase. The type of cropmark to be used is configured in the Studio Settings. 

• Convolution Matrix – Available via the Jobticket (see Workbench data types). Allows you to design your own 
filter  effect  according  to  a  pre-defined  mathematical  operation  known as  convolution.  This  effect  is  not 
available when using the C5 Client. 

• Image Overlay – When enabled, this effect allows a Blackmagic Image, JPEG, PNG, PPM, Photoshop or 
TIFF file to be placed anywhere on the job. Settings include width, height and opacity for the overlayed image 
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plus options to allow it to stretch and rotate with the job. Available via the Jobticket. This effect is not available 
when using the C5 Client. 

• Mirror – Available via the Jobticket. Mirrors the job. 

• Negative – Available via the Jobticket. Allows for the job to be negated or inverted. Useful for printing to film  
using a white ink printer. 

• Unsharp Mask – Available via the Jobticket. Applies an unsharp mask to the submitted job. This effect is not 
available when using the C5 Client.

• Watermark – Available via the Jobticket. Allows for the placement of a watermark across the job. This effect is  
not available when using the C5 Client. 

• ColourKeys and Screenprinting mode are also available when using Studio, accessible via the Jobticket and 
Media used for processing the job files. 
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Serendipity Client Menu Items 
The Serendipity Client menus provide access to direct job submission options, system settings and extra functions. 

Application Menu (Windows/Linux) or Serendipity Client Menu 
(macOS) 
Preferences – Select this menu option to open the Client Settings (Preferences) for the Serendipity Client, containing 
default values and preferences configured for the Client and its applications and modules. See the System Settings >  
Client Settings section of this manual for further information. 

Submit Menu 
Submit Files 

Select one or more files to send to a Media and Pagesetup for processing. 

Selecting Open will present the Submit dialog window displaying a list of Pagesetups available. Additional Media and 
Jobticket tabs are also displayed. 

Choose the Pagesetup/Media and optional  Jobticket  combination to submit  any files to for  processing and click  
Submit. The files will be copied into the system for processing. 

Flow control can be enabled to hold the job after imaging or rendering. The number of copies can be set, or jobs can  
be placed as pages in a publication. 

Submit Window 

The  Submit  window  is  comprised  of  a  settings  preview  panel  to  the  left;  a  main  panel  for  selecting  a 
Pagesetup/Media/Jobticket combination; and a submission control panel. 

Selected Settings Preview Panel 

This panel displays the currently selected Pagesetup, Media and optional Jobticket items. A summary appears when 
a Jobticket is attached to display any custom settings to be used when processing the job. The panel can be hidden  
by clicking on the information icon at the bottom of the screen. 

Pagesetup/Media/Jobticket 

The Pagesetup Panel lists all available Pagesetups. Select one from the list to submit a job. 

The  Pagesetup  /  Pool  buttons  (top  right  when  in  Pagesetup  panel)  toggle  between  available  Pagesetups  and 
Pagesetup Pools. When Pool is selected the Media list button is disabled. Jobs submitted to a Pool always use the  
Pagesetup default Media. 

The Media Panel lists any Media items compatible with the selected Pagesetup. Select a Media to which the job will  
be submitted. If a Media is not selected, the default Media shown in the Settings preview panel is used. 

The Jobticket Panel lists all available Jobticket items. Select a Jobticket to use when submitting a job. If a Jobticket is  
not selected, the default system settings will be used. If a Jobticket is already assigned to the selected Pagesetup, its  
settings will be used. 
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A configuration (Edit) button is available within Jobticket to make any custom changes to an existing Jobticket, or to 
create a new one. Options include: 

• Defaults – Load the system default Jobticket settings. 

• Save – Save the edited Jobticket to the database. A dialog box opens with options to save over the existing 
Jobticket or rename it and save as a new one. Once saved, the user is returned to the Jobticket list. 

• Discard – Close the Jobticket Edit window and return to the Jobticket list, discarding any changes. 

• Done – Save the edited settings to a temporary Jobticket for the job currently being submitted. 

Submit Options 

The lower section of the Submit window contains the flow control, copies and publication options available for any 
submitted files. 

Flow Control 

• Hold after Imaging – Hold the job after the imaging stage has completed. 

• Hold after Rendering – Hold the job after both imaging and rendering stages have completed. 

• Nest – Submit the job for imaging and rendering then on to be nested with other jobs. Nesting criteria are  
defined in the Output (see Workbench > Output). 

• Duplex – Submit the job for imaging and rendering, then to be duplexed with other jobs. This option is only 
available  to  printers  capable  of  duplexing.  Duplex options are defined in  the Output  (see Workbench > 
Output).

• Rotate 90 – Rotate the job 90 degrees. This will override any rotation settings in a Jobticket. 

Copies 

• No. of copies – Enter the number of copies of the job to be output (printed). 

• Lock button – Locks the number of copies to be output (printed) for any files submitted until unlocked and 
changed. 

Publication 

• Publication Name – Optional. Enter a publication name to which the submitted file will be assigned. The job  
will be viewable in the publication view of the QueueManager. 

• First Page – Enter the page number for the submitted file in the publication. If submitting multiple files, the 
page numbering will start at the defined page and increase sequentially for each job. 

• Submit – Press Submit to send the job for processing using the selected options. 

• Cancel – Cancel the job submission, closing the Submit Window. 

Note: The Serendipity Client stores the last Pagesetup, Media, and Jobticket selections so they need not be selected 
every time a job is submitted. 

Job name – When submitting a job from Studio, the option to enter a job name is available.
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Submit Files as Asset 

Select files to send to the Studio application Asset queue. Submitted Assets appear in the QueueManager queue as 
thumbnails, but are not processed until submitted for printing from the Studio application (see Applications – Studio 
for more information). 

Submit ICC Target 

This is the standard option that should be used when calibrating a printer Media and submitting an ICC target to 
generate an output ICC profile. Files submitted using this option utilise the Paper Profile, Linearisation LUT and 
Correction LUT in the Media but are not ICC corrected. 

Note: This is the standard option for submitting an (EPS or TIFF) ICC target chart used for creating an output ICC 
profile when calibrating a printer Media. 

Submit ICC Target Without Colour Correction 

Submit an ICC Target to a selected Pagesetup/Media/Jobticket combination. All ICC options and colour correction 
curves are disabled. 

Note: This option works in a similar way to “Submit ICC Target” however, all Linearisation data will be disabled at the 
time of  submission,  unlike Submit  ICC Target  which enables colour  correction curves.  The job info will  display 
Calibration Target, ICC Disabled in the Properties field. 

Test Prints 

Send a Megarip Test Print to one or more Pagesetups/Medias. Select which test print(s) to submit by ticking the 
checkboxes beside each file name in the Submission area of the Submit window. 

Note: You can add your own files to the lib/testprints directory for use as test prints. Any files you have permission to  
use that are placed in this directory will appear for selection in the Test Prints chooser window. 

Test Prints as ICC Target 

Submit  one or  more internal  test  images as an ICC target  (as per  option above).  This  allows users to  store a  
commonly used ICC Target chart in the “/lib/testprints” folder for easy access when calibrating Media. 

Server Menu 
Server Settings 

Select this menu option to open the System Settings (Preferences) for the Serendipity Server. The Systems Settings 
section contains default values and preferences configured for the Server. See the Server Settings section below for 
further information on each panel. 

Connect to Server 

This allows the Serendipity Client to connect to a Megarip Server running on the network. The Refresh button will 
search for and display any active Servers. Alternatively, you can enter the name or IP address of the Server in the 
Server Address field under the Manual tab. 
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If there are multiple Servers (Masters) running on the network, the list is cached on the first “Connect to Server”  
selection. A dropdown list of available Servers is accessible via the Auto Detect tab. If a new Server appears after this 
time, the Refresh button must be pressed to find and add it to the list. Likewise, if a Server becomes unavailable, the 
connection will fail and the list will require a refresh. 

When the Serendipity Client is started, it will attempt to connect to the last Megarip Server accessed by default. 

Accounts Admin 

Accounts Admin allows an authorised administrator to create, modify and manage User accounts and User Groups. 
Users can be reassigned to groups dependent upon the operating privileges granted to each User Group. See the 
Accounts Admin/Secure Mode section below for further information. 

Log Out (Secure Mode only) 

This  menu  item  only  appears  while  Megarip  is  in  Secure  Mode  (see  Accounts  Admin/Secure  mode  for  more 
information). Selecting Log Out while using Megarip in Secure Mode simultaneously logs out the current user and 
generates the Login window. At this point, the options available are to enter a username and password; Choose 
Server before login; and to Quit the Megarip Client. 

While the Login window is displayed, the Megarip Client is effectively LOCKED to all users. The Server will continue 
to operate as normal. 

Chatterbox 

Chat to other users connected to the same Server. The Chatterbox window will display the Clients connected to the 
Server. If the user has entered a nickname in the System Settings, this name is displayed; otherwise the machine 
name is used. If the user’s name cannot be selected, the user has selected the Away option and is not available. 

Broadcast Message 

This allows messages to be sent to all users connected with a Client to the same Server. Selecting the Broadcast 
option displays a message window to type into and send. The message is displayed on the users window for a short 
time and will automatically dismiss if it is not acknowledged by clicking OK. 

Download PPD 

This option downloads the Megarip PPD from the Server to the desired location. A chooser will appear to navigate to 
the location for saving the PPD file on the drive. This saves having to get the PPD off the disk. Use the PPD when 
installing a local printer. When installed, the Megarip PPD (Postscript Printer Description) is selected as the printer 
driver  when  setting  up  a  Megarip  Published  Pagesetup  as  a  print  destination  for  third  party  applications  (see 
Workbench – Pagesetup and the Publish to a Windows Printer sections for more information). 
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Accounts Admin / Secure Mode 
Megarip gives users the option to login using Secure Mode, which allows the administrator to create accounts for  
users  and groups,  with  each group configured  to  allow or  deny  its  users  access  to  particular  applications  and 
functions. 

When Secure Mode is active, users are required to enter a username and password whenever the Client is started or 
users are changed. The username and password are both case sensitive. 

The Accounts Admin menu option is selected in order to display the panels for configuring any Users and Groups and 
these should be created prior to activating Secure Mode. 

The Log Out option only appears once Secure Mode has been activated. Selecting this while using Megarip in Secure 
Mode simultaneously logs the current user out and generates the Login window with options to login as a new user 
and select a Server to connect to, or Quit the application. While the Login window is displayed, the Client is effectively 
locked to all users. The Server will continue to operate normally. 

Setting up Users and Groups 

Megarip’s Secure Mode is set inactive by default. The software will  continue to function normally whether or not  
Secure Mode is activated. 

Important Note: It  is recommended all users and groups requiring access be setup BEFORE activating Secure 
Mode. Secure Mode cannot be activated until at least one (1) user has been created. This would usually be the 
Admin account, as this is automatically created when the Accounts Admin option is selected for the first time. 

Select Server menu > Accounts Admin to display the configuration panels. 

Activating Secure Mode 

Once the initial user account(s) have been setup, Secure Mode can be activated by checking the tick box located via 
Accounts Admin menu > Accounts Admin Settings. 

Secure Mode can only be activated or deactivated by an administrator (a member of the Admin group). 

• Secure mode – Enable or disable Secure Mode. 

• Mail Server – Enter the details of the mail server for error notification emails when using Secure Mode. 

• Sender Email Address – Enter the details of the Sender (From) address for error notification emails. 

• Default Asset Ownership – Set the level of permission for users and groups when an asset is submitted for 
use in the Studio application via the Asset Queue Drop Folder. 

Activating Secure Mode 

Secure Mode should be activated after any users and/or groups have been created. Only an administrator or member 
of the admin group can activate or deactivate Secure Mode. 

To activate: 

1. Select Accounts Admin menu > Accounts Admin Settings. 

2. Tick the checkbox at the top of the screen – Secure mode – to activate or deactivate. 

3. Click OK and close the settings when done. 
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4. If activating Secure Mode, a login window will appear as soon as you close the Settings. 

If Email Notifications are setup for users: 

1. Enter the mail server details in the Mail Server field. This is the outgoing SMTP server. 

2. Enter the email address for the Sender (From) field of the email in the Sender Email Address field. 

Configurations Panels Users Panel 

• Name – The username of the account. This is case sensitive. 

• User ID – This is a numerical ID assigned automatically but may be changed by the administrator. 

• Password / Verify – The password is entered and stored here. New passwords must be verified by entering 
the details in each field. The password is also case sensitive. 

• Permission – The level of permission for the user is created here. Click Edit to make changes to the user 
read/write/execute permissions. Note: The Group (second line) and “Everyone” permissions in the Edit popup 
determine whether jobs submitted by a user are able to be seen/edited/deleted in the QueueManager by 
other users in the same user group, or by users outside the group. 

• Email – Enter the users email address here. 

• Comment – Allows the administrator to enter a note on the particular user account if necessary. 

• Group (dropdown) – Assign a user group to the user account. 

• User Privileges – Privileges other than those in the user’s group can be added here. 

• Notifications – Select which email notifications the user is to receive by clicking the + icon or remove any via 
the  –  icon.  Notifications  are  available  for  Job  Spooling  failure,  Job  Autodetection  failure,  Job 
Imaging/Rendering failure, Job Printing failure, Dongle removal, Server Crash, Media Remaining warnings, 
Software Updates available, and Maintenance Expiration reminders. 

Note: Notifications will be sent to the nominated email address/es when the Server is running. Maintenance 
expiration reminders are sent out when the maintenance cover is 30 days or less. 

To create a user: 

1. Click the + icon in the bottom left of the window. To delete a user, click the – icon. 

2. Enter a username in the Name field. 

3. Enter a User ID number or leave the default value. 

4. Create a password for the user and verify the details. The password boxes will always display black dots 
irrespective of the length of your password. 

5. Edit the permission level to the required access level. 

6. Enter the user’s email address (if notifications are required). 

7. Add a comment against the user if necessary. 

8. Assign a Group for the user. A default group “users” is assigned automatically unless another is selected. The  
“users” group allows access to the Client but no other functions except job submission. The user may be 
assigned  to  multiple  groups  via  the  Groups  tab  if  limited  access  is  required  (for  accessing  specific 
applications and/or functions). 

Serendipity Megarip Product Manual – Version 9.1
158



9. Add any extra privileges to the user if  required.  This will  only show privileges not  included in the group 
selected for the user. 

10.Add any notifications to the user if required. 

11.Apply the changes or select Revert to cancel. 

Groups Panel 

An admin User and Group are created by default with access to all permissions and privileges when the Accounts  
Admin option is selected for the first time. The admin user and group cannot be deleted. It is recommended this be 
the only group with access to the Accounts Admin application. 

The fields within the Groups panel are: 

• Name – The name of the Group. 

• Group ID – This is assigned automatically but may be changed by the administrator. 

• Comment – Allows you to enter a note on the particular user group if necessary. 

• Group Privileges – This is a list of available privileges relating to functions within Megarip. 

• Members – A list of Usernames and IDs belonging to the Group. 

To create a group: 

1. Click the + icon in the bottom left of the window. To delete a group, click the – icon. 

2. Enter a name in the Name field. 

3. To add privileges, click the + icon in the Group Privileges panel. A popup list will appear with all available 
items. To add, highlight the privilege/s and click OK. 

4. Click Apply to save any changes to the group or Revert to cancel. 

Assigning Users to a Group

Users are assigned to the groups via the Users or Groups panel. Once you have created the user group, click on the 
Users panel. 

1. Select the User Name from the list of users. 

2. Select the Group to assign the user to from the Groups dropdown menu. 

3. Click Apply to save any changes or Revert to cancel. 

Once the user group has been created, click on the Groups panel (if not there already). 

1. Select the Group from the list on the left. 

2. In the Members panel, click the + button. 

3. Select any users to be added to the Group. 

4. When finished, click Apply. 
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Hosts Panel 

The Hosts panel allows for the configuration of automatic Client logins for selected host computers or network IP 
addresses when using Secure Mode. 

The fields available are: 

• Name – Enter a name for the Host setup. 

• Hostname/IP – Enter the Hostname or IP address of the computer the user will automatically connect to. 

• Automatic Login – Disable or Select a User from the dropdown list. Only one user may be selected per Host 
setup. 
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System Settings 
The Systems Settings section contains default values and preferences configured for the Server and Client. The 
settings are split into two (2) different sections – Server and Client. 

Access the  Client  Settings via the Application menu (Win) or Serendipity Client menu (Mac). Access the  Server 
Settings via the Server menu. 

Client Settings 
The Client settings are divided into three (3) tabbed categories: Colour, General and Shortcuts. 

Colour tab 

• Input CMYK Profile - Select a default Match ICC profile for accurate display of CMYK data. 

• CMS Dithering – Disabled by default. Enable for smoother results whenever conversion between 16-bits to 8-
bits is required. 

• Force Relative Colourimetric Media White - Various ICC profiling packages and some older ICC v2 profiles 
included an Lab value for media (paper) white in the Relative Colourimetric Intent LUT. This has the effect of 
printing a paper layer when printing with Relative Colourimetric rendering intent. When enabled, this option 
ignores the Lab value for paper in the Relative LUT, leaving paper white areas unprinted. 

• Output Screening Spots – Set the number of Special/Spot plates available in the Media > Output Screening 
when printing separated plate output using Screen Print mode. The Workbench application must be closed 
and reopened if this is changed.

Monitor Settings 

• Calcheck Managed – Enabling this will display the current calibration status of the selected monitor. When 
selected, there will be a small icon showing a green tick or a red cross. This icon is shown in the bottom right  
corner of the SoftProof window. Its status depends on the expiration time of the monitor calibration (as set 
below) and the Calcheck status. 

• Use Native Profile – Enable this to use the operating system defined ICC profile for colour management. The 
Client will use the monitor profile as setup for the operating system, i.e., Mac OS will  use what is in the  
Display Preferences Colour tab, Windows will use the Display Adapter Settings. 

• Profile – Select a monitor ICC profile for the display the Client is running on. The profiles are used so any 
colour element viewed on the display is shown as accurately as possible. This includes SoftProof and any 
colour swatch. It is recommended the monitor be calibrated and set to the same match profile as is used for  
the softproofing Pagesetup. 

• Resolution – Choose the default resolution to use for the monitors. This is used in SoftProof for calculating 
various fit methods. Options include: 

◦ Use System Settings – The Client will calculate the system’s monitor resolution. 

◦ Custom Resolution – Specify your own resolution. 

◦ Calibration Expires – Set a reminder to popup when a calibration needs updating. 

Additional Monitors 

Specific settings may be set for each monitor when in a multi-monitor environment. The Client Settings will show 
additional sections with Monitor 2, Monitor 3 etc listed. To identify which monitor is which, press the monitor indicator 
button to display a graphic in the middle of the screen for the relevant monitor. 

Serendipity Megarip Product Manual – Version 9.1
161



Calcheck Managed 

The Calcheck Managed option (under Colour Management) constantly reports the status of the monitor used for 
softproofing. 

When this option is enabled a small tick or cross icon representing the Calcheck status will be displayed at the bottom 
right of the SoftProof window in the status bar. 

General tab 

• Language – Select your preferred language from those available. This displays all Client and log messages in 
the chosen language. The default is English. A restart is required if the language setting is changed. 

• Default Font – Set the font and size to be used by the Client. 

• Undo Levels – Set the number of levels for Undo. The default is zero (0), which means no restriction. 

• Default Units – Set the measurement units used by the Client and all of the Applications/Modules. 

• Theme – This dropdown menu allows the selection of an overall visual theme for the Serendipity Client. The 
available options are: 

◦ Light  – Client  appears in the standard Light  Mode. The option matches how the Client  appeared in 
previous versions of the software.

◦ Dark – Client appears in Dark Mode, appearing predominantly in black/grey tones with white text.

◦ System –  Optional  item  depending  on  operating  system.  Client  matches  the  light/dark  appearance 
configured for applications in the operating system settings. This is the default Theme setting.

• Show Tooltips – Enable or disable tooltips within the Client. 

• Turn Sound FX Off – Check this to disable the sound effects. Sounds are used for things such as drag and 
drop, and error message alerts. 

• Nickname – Enter a nickname to use when accessing the Chatterbox application. 

• Temp (button) – Set the temporary path for scratch/temp files on the local drive. Useful if using SSD (solid 
state drive) as operations will perform faster. 

• Reset – Reset the location of the temp directory to the operating system default. 

Shortcuts Tab 

This tab displays a list of the Applications and Modules for which keyboard shortcuts can be created. 

Note: It is the responsibility of the user to check the created shortcuts do not conflict with any other Megarip, third  
party software, or operating system shortcuts/hotkeys. 

To add a shortcut: 

1. Highlight the selected application or module in the list. 

2. Use  the  Edit  option  in  the  context  menu  (right  click)  or  click  in  the  Shortcut  field  to  the  right  of  the 
application/module name. 

3. Type in the key or key combination for the shortcut and press Enter. 
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4. The shortcuts will now appear in the Application and/or Modules menu of the Client. 

To remove a shortcut: 

1. Highlight the selected application or module in the list. 

2. Use the Clear option in the context menu (right click); or 

3. Click in the Shortcut field and delete the shortcut. 

Server Settings 
Server settings are saved to the Server and are common to all connected Clients. The Server settings are divided into 
tabbed categories – Process, Colour, Options, Paths and Debug. 

Process tab 

• Tasks – Control the number of processes the machine will handle, i.e., the number of Imaging and Rendering  
tasks simultaneously run on the Server. The defaults are 1/1. Up to one imaging and rendering task can be  
set per CPU core the Server machine possesses. In practice, it is recommended the combined number of 
imaging and rendering tasks be set to no more than the number of cores. For example, 4 CPU cores = 2 
Image/2 Render. 

• Compression - Set the compression level for the intermediate file formats (the imaged and rendered files).  
Choose from Fast, Standard, Better, or Best. The default is Standard. 

• Multi-resolution generation – When enabled, the Server generates imaged and rendered preview files that 
include a pre-calculated pyramid of preview images (at power of 2 intervals), resulting in much faster zooming 
when softproofing. 

Note: This option slightly increases image and render times and increases the disk size of the preview by 
approximately one third. Options include: 

◦ None 

◦ Fast – Default option. Suitable for the majority of workflows, this option slightly increases image and 
render times and increases the disk size of the preview images by approximately one-third. 

◦ High Quality – This option can be used in the rare circumstance that moire or unwanted antialiasing 
appears in a SoftProof preview. This option further increases image and render times, file size and results 
in slightly slower zooming. 

• Maximum Print Preview Resolution – Set the maximum resolution for the rendered preview. The default is 
196 dpi. 

• Low Quality Thumbnail – Selecting this produces a lower quality thumbnail. This is faster but some detail may 
be lost in the thumbnail. 

• Default Jobticket – Assign a system default Jobticket. This Jobticket is used when submitting to a Pagesetup 
without an assigned Jobticket, or when no Jobticket has been previously selected in the Submit window. This 
is the Jobticket assigned when the “Apply Defaults” option is selected in the Submit window Jobticket editor. 

• Immutable Jobtickets – When enabled, jobs in the QueueManager retain the Jobticket options they had when 
they were first  submitted,  even if  the job’s  ticket  is  subsequently  changed.  If  the job is  reprinted or  re-
rendered it will do so with the original Jobticket options. Jobticket information can be viewed by displaying the 
Job Info window for any submitted jobs. 

Note: When selecting “Render with new Jobticket”, the immutable jobticket option is overridden. 
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Colour Tab 

• Default ICC Profiles – Select the default ICC profiles used when first creating a new Jobticket (Input profiles)  
and Media (Output profiles). 

• ICC Engine Accuracy – Select Faster or Better, depending on preferences. 

• CMS Dithering – Disabled by default. Use CMS Dithering for smoother results whenever conversion between 
16 bits to 8 bits is required. 

• Force Relative Colourimetric Media White – Various ICC profiling packages and some older ICC v2 profiles 
included an Lab value for media (paper) white in the Relative Colourimetric Intent LUT. This has the effect of 
printing a paper layer when printing with Relative Colourimetric rendering intent. When enabled, this option 
ignores the Lab value for paper in the Relative LUT, leaving paper white areas unprinted. 

Asset tab 

• Publish Asset Queue – Enabled by default. When disabled, the Asset queue destinations will be hidden from 
any Output bonjour/zeroconf configuration options. 

• AutoClean – Automatically delete assets from the queue based on times and/or number of assets in the 
queue. Auto-cleaning is performed the next time an asset is submitted after an auto-cleaning condition has 
been met. Options include: 

◦ Keep Most Recent – Set a number of assets. Megarip will keep that number of most recent submitted 
assets in the queue, automatically deleting any excess. 

Note:  If  this is enabled and the number of  assets is set to zero, assets will  be deleted from the queue  
immediately after submitting, so no assets will ever be accepted. 

• Keep Jobs Newer Than – Megarip looks at the time signature of submitted assets jobs and deletes any in  
the queue older than the specified (days/hours/min) time. 

 

Options tab 

• Default Units – Set the units used by the Server. Options are mm, cm, inches, points, picas, metres or feet. 

• Server Back Log – Number of days to keep the log. Older days are trimmed when the Server starts. Zero (0)  
means the log will not be trimmed. 

• Minimum Broadcast Interval – Set the interval between the Server sending out updates to connected Clients.  
The default interval is 2sec. High-end systems with good networking are able to set the interval to 0sec for  
slightly improved image/render times when processing large numbers of jobs. Sites using the Client remotely 
connected via the internet should set a longer polling interval of 10-20sec. 

• Output Unknown Files to Printer – Output any unknown files direct to a printer. If this is unchecked, any 
unknown files will result in errors and will not be output. 

• Log Printed Jobs – When enabled, this option will log completed print jobs in the Server log. The jobname 
and dimensions are noted. 

• Web server – Disabled by default.  Enable to allow access to the built-in web server. A Server restart is 
required for any changes to take effect. When Job Statistics are enabled, this must also be enabled. 

• Calcheck History – Disabled by default. When enabled, all Job and Media calcheck results are stored in an 
internal database. The function enables a History button in the Calcheck application used to view stored 
results.  Note: The database is backed-up as part of Backup Server function (see Server Options > Help 
menu). 
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• Job  Statistics  –  Enable  (along  with  the  Web server  option)  to  collect  job  statistics  in  an  internal  sqlite 
database file. 

Paths tab 

Paths lists the default location of the working paths the Server uses to process jobs. 

• Raster – Holds all the imaged, rendered and print jobs while they are live in the system. 

• Spool – The location where the job is spooled prior to processing. 

• Temp – After spooling, the job is moved to the temp directory where it is worked on. 

• Drop – The default location for the DropFolders. 

• Asset Drop – The default location for the Asset DropFolder (if set). 

The Raster directory holds all jobs while they are in the system and as such, can be very large. If this is moved it 
needs to be placed on a disk with plenty of space. A Server restart is required if any paths are changed in order for 
the changes to take effect. 

Important Note: All existing files in the new working path directory are deleted when the Server is restarted. Ensure 
the new working path directory has no essential data. A warning message will popup to confirm whether to proceed 
with the path change. 

Debug tab 

The Debug tab contains options used only when advised by Serendipity Software support for assistance in technical 
issues. 

Do not enable the options unless advised by Serendipity Software,  as the Server speed will be substantially 
reduced if they are. 

• Colourspace Dump. 

• Screening Dump. 

• Memory Dumps.
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Web Server 
The  Megarip  Server  has  a  built-in  web  server.  Accessed  via  a  web  browser,  the  Web Server  provides  status 
information about the Server and jobs currently in the system. It cannot be used for submitting or managing files in 
the system. 

Accessing the Web Server 
To connect: 

1. Enter the IP address or machine name (if using DNS) of the computer running the Server in the browser 
window, followed by a colon and the port number 8080. For e.g., 192.168.3.43:8080 

2. Press Enter once the address has been typed in. If you have a DNS server, you can type the machine name  
instead, e.g., papaya:8080 

3. Once connected, the front page will appear with an options menu at the top right: 

1. Queues – Shows all the queues configured on the Server you are connected to. 

2. Server Log – View the log file. 

3. System Info – Displays information about the system. 

• Queues – Click on any of the queues to get information about jobs in that queue. Information about the job,  
including name and current status will be shown. 

• Log File – To view the log file, select the option from the list on the left. From here, you can select a particular 
time period to fetch from the Server. Once viewed, you can print the file or save it to disk. The log can be 
printed, saved or exported from the browser. 

• System info  –  Choose  this  to  display  information  about  the  system.  Product  Info,  Licensed  Modules  – 
available printers and input drivers; and Available Destinations are shown. 

The menus at the top of the page are linked to the live Serendipity Software website. You will need to have an active  
Internet connection for access to the support website function. 
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Publishing a Pagesetup on macOS 
Megarip Pagesetup’s can be set up as a macOS system printer destination to allow jobs to be easily submitted via 
the Print option of third party software or design packages. 

Jobs printed to a Published Pagesetup will be automatically sent for processing and colour management in Megarip, 
eliminating the need for dropfolders or manual file submission. 

Note: Jobs printed via Megarip in this way must be in a file input format available to your Megarip version. 

Installing the Serendipity Printer Drivers 

The first step when Publishing a Pagesetup for the first time is to install the Serendipity Printer Drivers for macOS.  
The installation package is located on the Megarip Installation DVD: 

1. Navigate to the /drivers/mac folder and run the file Serendipity Printer Drivers.pkg 

2. An installer window will appear. Follow the prompts to complete the installation of the drivers. The installer will  
require administrator access privileges. 

Configuring a Pagesetup for Publishing as a TCP/IP System Printer 

To configure a calibrated Pagesetup for Publishing: 

1. In the Workbench, select the Pagesetup from the list of available data types. 

2. Go to the Publish panel and enable the checkbox for TCP Port: Activate port number option. 

3. Enter the TCP port number into the field and Save the Pagesetup. 

Port Numbers 

It is recommended that the port number assigned to a Pagesetup be a port over 10000 to avoid any conflict with the 
operating system or an existing application. Each Pagesetup to be published needs its own unique port number, for 
example, 10200, 10201, etc. 

Media 

When submitting jobs to a Published Pagesetup, the default Media assigned to the Pagesetup is used. If you wish to  
publish to different media on the same printer, each Media required needs to be assigned to its own Pagesetup, with 
its own unique port number. 

Creating a TCP/IP macOS System Printer 

A system printer needs to be created and configured on the macOS computer that is running the Megarip Server. 

1. Open the System Preferences for the macOS. 

2. Choose Print & Fax. 

3. Click the + icon at the bottom of the printer list panel to create a new printer. 

4. Select the IP icon at the top of the Add Printer window. 

5. Protocol – Select HP Jetdirect - Socket from the dropdown menu. 
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6. Address  –  Enter  the  TCP/IP address  and  port  information  for  the  printer  setup  in  the  following format:  
Computer IPaddress:PagesetupPortNumber (see image for example). The IP address for the printer should 
not be used. 

7. Name – Enter the desired name for the printer. It should be easily recognisable as a Published Pagesetup  
and/or the particular Pagesetup being published. 

8. Print Using – Select Printer Software from the dropdown menu. 

9. A list of available macOS system printer drivers will popup. 

10.Either scroll down the list and select Serendipity Megarip, or type “Serendipity” in the filter field and select 
Serendipity Megarip and click OK. 

11.Click Add to add the new printer. 

12.Set the published Pagesetup “Printer”  as the system default  and/or share the printer  on the network as 
required. 

Configuring a Pagesetup for Publishing as a Bonjour Printer 

To configure the Pagesetup for Publishing: 

1. In the Workbench, select the Pagesetup to be Published from the list of available items. 

2. Go to the Publish panel and enable the printer: Mac checkbox. This lists the Pagesetup in the macOS system 
Bonjour destinations as “Pagesetup name @ computer name”. 

3. Save the Pagesetup configuration when done. 

Creating a Bonjour System Printer for macOS 

A system printer needs to be created and configured on the macOS computer running the Megarip Server. 

1. Open the System Preferences for macOS. 

2. Choose Print & Fax. 

3. Select the Default icon at the top of the Add Printer window. 

4. Choose the Pagesetup from the Printer Name list. The Pagesetup will be listed as Kind: Bonjour and named 
“Pagesetup name @ computer name”. 

5. Print Using – If you have installed the Serendipity Printer Drivers, the Print Using field should auto-fill to show 
Serendipity Megarip. 

6. If the Serendipity Printer Drivers have not been installed, cancel the printer setup and install the drivers as per 
the above instructions. 

7. If  the field does not auto-fill,  choose Select Printer Software from the dropdown menu. A list of available  
macOS system printer drivers will popup. Either scroll down the list and select Serendipity Megarip or type  
“Serendipity” in the filter field and select Serendipity Megarip. Click Add. 

8. Name – Enter the desired name for the printer. It should be named to be easily recognisable as a Published 
Pagesetup and/or the particular Pagesetup being published. 

9. Click Add to add the new printer. 

10.Set the published Pagesetup “Printer”  as the system default  and/or share the printer  on the network as 
required. 
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Publishing a Pagesetup on Windows 
Megarip Pagesetups can be set up as Windows system printer destinations to allow jobs to be easily submitted via 
the Print option of third party software or design packages. 

Jobs printed to a Published Pagesetup will be automatically sent for processing and colour management in Megarip, 
eliminating the need for dropfolders or manual file submission. 

Note: Jobs printed via Megarip in this way must be in a file input format available to your Megarip version. 

Megarip Printer Driver 

The first step before proceeding is to enable access to the Megarip.inf driver file. The Megarip printer driver is a 
proprietary Serendipity Software driver that Windows will use as the printer driver. 

The file is located on the Serendipity Megarip installation DVD in the following directory: /drivers/win/win_xp_vista_7/ 

Configuring the Pagesetup for Publishing as a System Printer 

To configure a calibrated Pagesetup for Publishing: 

1. In the Workbench, select the Pagesetup from the list of available data types. 

2. Go to the Publish panel and enable the checkbox for TCP Port: Activate port number option. 

3. Enter the TCP port number into the field and Save the Pagesetup. 

Port Numbers 

It is recommended that the port number assigned to a Pagesetup be a port over 10000 to avoid any conflict with the 
operating system or an existing application. Each Pagesetup to be published needs its own unique port number, for 
example, 10200, 10201, etc. 

Media 

When submitting jobs to a Published Pagesetup, the default Media assigned to the Pagesetup is used. If you wish to  
publish to different media on the same printer, each Media required needs to be assigned to its own Pagesetup, with 
its own unique port number. 

Creating a TCP/IP Windows System Printer 

A system printer needs to be created and configured on the Windows computer that is running the Megarip Server. 

1. Select Windows Start Menu > Devices and Printers. 

2. Click on Add Printer. The Add Printer wizard will appear. • Select Add a Local Printer and click Next. 

3. Select Create a New Port and Standard TCP/IP Port from the Type of Port dropdown menu. 

4. Click Next. 

5. Type a Printer or Hostname Address: 

1. Device Type – TCP/IP Device 
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2. Hostname or  IP address – Enter  the Network IP address of  the Windows computer  running the 
Megarip Server. (e.g., 192.168.3.59). 

3. Port Name – Enter a name for the Windows port (this is NOT the printer name). 

4. Uncheck the option to Query the Printer and Automatically Select the Driver to Use. 

5. Click Next. 

6. Additional Port Information Required: 

1. Device Type – Custom. 

2. Click the Settings button. A configuration window will appear. 

3. Configure Standard TCP/IP Port Monitor: 

4. Protocol – Select Raw. 

5. Raw Settings: 

1. Port  Number  –  Enter  the  unique  TCP  Port  number  assigned  to  the  Pagesetup  to  be 
published, e.g., 10201. 

2. Click OK. The window will close and return to the Additional Port Information window. 

7. Click Next. 

Install the Printer Driver: 

1. If this is the first time installing a Megarip system printer, insert the Megarip Installation DVD and select Have 
Disk. 

2. Navigate to the /drivers/win/win_xp_vista_7/ directory. 

3. Select the Megarip.inf file and click Open. The Serendipity Megarip driver should now be displayed. 

4. Click Next. 

Note: The above step can be skipped for any subsequent installs of Megarip system printers. The driver can be 
chosen from the Windows printer driver list. 

1. Which Version of the Driver do you want to use: 

1. Select Use the driver that is currently installed (recommended) unless you are replacing an older 
installed version of the Serendipity Megarip driver. 

2. Click Next. 

2. Type a Printer Name: 

1. Enter a name for the printer. This is the name that will appear in the Windows Printers list and be 
available as a printer option when printing from Windows applications. The name should be unique 
for the Published Pagesetup. 

2. Click Next. 

3. Printer Sharing: 

1. Select Share this printer so that others on your network can find and use it. 

2. Keep the default printer name or enter a share name. 

3. Click Next. 
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4. You’ve Successfully added “Printer Name”: 

5. Choose whether the Published Pagesetup destination is to be the default system printer. 

6. If desired, click the Print a Test Page button. The test page job should appear in the Megarip QueueManager. 

7. Click Finish to close the wizard. 

Printing to a Published Pagesetup Printer across a Network 

Printing from macOS → macOS, or Windows → Windows 

Printing to a Published Pagesetup printer across a network where both computers (the machine sending the print and 
the machine running the Megarip Server) share a common operating system is straight forward. If network sharing 
has been enabled for the system printer destination created for use with the Megarip Pagesetup, the printer will be  
available in the printer options of any other computer on the network. 

Printing from macOS → Windows, or Windows → macOS 

Printing from a computer on the same network, but with a different operating system to the computer running the 
Megarip Server requires the creation of a new system printer on the computer wishing to print to Megarip. This is  
done by following the appropriate steps outlined previously for the relevant operating system. The only alteration is  
when entering the TCP/IP address and the TCP port number: 

Enter the network TCP/IP address of the computer on which the Megarip Server is running, i.e., the machine you wish 
to print to. 

Enter the TCP Port Number assigned to the Published Pagesetup you wish to print to. 
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Troubleshooting 
Here are some suggestions of where to look if you run into trouble and experience problems when using a Cluster. 

Jobs Not Processing Through a Cluster Node 
The possible reasons for this are: 

The  Cluster  Node  is  not  configured  to  image,  render  or  both.  Check  the  ClusterStatus  to  see  if  either  of  the 
processing tasks have been disabled. To enable them, open the Clustering application and enable the appropriate 
task. 

The Cluster Node has a Processing Pool attached and the Pagesetup you are submitting jobs to is not contained 
within the Pool. You can either unselect the Pool or add the Pagesetup to the Pagesetup Pool. The Cluster Node has  
gone offline. To check, open the Clustering application and check the node. If the Clustering application is already 
open, click the Refresh button. This will  check for node status. If  the node appears grayed out or disabled, this  
indicates the node is not currently online. 

The Node and Master are different versions. The node should always be upgraded when the Master is to maintain the 
same versions in a Cluster. 

Cluster Nodes Errors Log 

The Cluster Nodes create an error log, which logs all the messages from the node. This is located in the Megarip  
installation directory on the node’s own machine and is called “errors.log”. This can be viewed with a normal text  
editor and can help to track a problem, or it can be sent to support for assistance in tracing a problem. 

A Node Cannot Be Found 

Once you have started your node successfully, you should be able to see it in the Clustering application. If not, you 
need to add the node manually. If this fails, there are a few things to check: 

Verify the node is still running and the clock is still counting up. Check the error log for any messages. 

Check that the Master machine can ping the node machine. If not, there may be a network issue and you will need to  
contact your network administrator for assistance. 

Check the ports on the machines are open for the node to connect to the Master and they are not being used by  
anything else. The port numbers for the node are as follows: 

9103/tcp – Server connects here and submits jobs via this port. 9103/udp – Listens to broadcasts so the Server can  
enumerate available Node Servers. 

Make sure the node is the same version as the Master. Nodes (Megarip Slaves) should always be upgraded at the 
same time as the Master. 

Serendipity Megarip Product Manual – Version 9.1
172



Printing to a Pagesetup on Windows 
Here are some suggestions of where to look if you run into trouble and experience problems when printing. For all of 
the methods documented in this guide, test each step to see where the problems arise. For example, when a printer 
is created, try printing a test page. 

Printing From Mac to Windows 

When printing from a Mac to a shared Windows printer, there are a couple of utilities available to verify whether or not  
the printer is installed correctly and working. These are: 

The CUPs printing system on the Mac has a web interface that lets you view and test printers. To access this, do the  
following: 

1. Open a web browser and enter the following address: http://localhost:631 

2. This will connect to the local print system. 

3. Choose Manage Printers or select the Printers tab and the list of printers configured on the Mac will appear. 

4. Scroll down the list to locate the printer. A detailed description of the printer is available here. 

5. Print a test page to the Windows printer. This will determine if the connection from the Mac to the Windows 
device is valid. The test job should appear in the Windows print spooler. 

As mentioned earlier, if a name is created with spaces or hyphens these are transposed to underscores for the actual 
printing device. Through CUPs the actual device name is shown. 

The description still contains the spaces but the actual device being printed to has underscores. Another way to check 
the status is to use the terminal. 

1. Open a terminal from the Applications > Utilities folder In the terminal type:lpstat -p 

2. This will report on all printers configured on the Mac. 

3. Search for your printer in the list and verify the name. The format will be like: 

printer my_printer_with_spaces is idle. Enabled since Jan 01 00:00 

4. Try and print from the terminal. Locate a print file (run a test job with the correct driver and find the file in the  
raster folder in the installation directory) and type the following on the command line: 

lp -P<printer> <jobname> 

5. For the example of a HP printer, we can type the following: 

lpr -Php_t1100_via_tanglefoot Quickcal_230166.rtl 

6. This should submit the rtl file created by the Server to the printer spooler. 

You must  be in  the raster  folder  when the command is  typed or  if  not,  enter  the full  path  to  the file,  for  e.g., 
Applications/Serendipity/Serendipity Megarip/raster/Quickcal_230166.rtl. 

 

The Mac Spooler Reports “NT_ACCESS_DENIED” 

This means that the print system cannot access the printer. It may be that there are insufficient privileges for the user 
trying to connect, the username and/or password could be incorrect, or the username and password part of the string 
have been forgotten. 
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Client Error 

When testing with lpr or from Serendipity Megarip and the error “client-error-not-found” is seen, it means it is unable 
to find the printer the file is being sent to. Check to make sure the name of the printer is correct. Unable to Print to 
Remote Windows Printer 

This can happen from Mac or Windows. 

If you are on a Windows machine and are creating a new printer to connect to the remote printer but it fails to find the 
path, make sure the remote printer is shared and the name is correct. 
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Copyright Notices 
PNG Library Copyright 

Copyright © 1995, 1996 Guy Eric Schalnat, Group 42, Inc. 

Contributing  Authors:  Andreas  Dilger,  Dave  Martindale,  Guy  Eric  Schalnat,  Paul  Schmidt,  Tim  Wegner.  The 
contributing authors would like to thank all those who helped with testing, bug fixes and patience. You know who you 
are. This wouldn’t have been possible without all of you. 

Thanks to Frank J. T. Wojcik for reviewing the documentation. 

The PNG Reference Library is supplied “as is”. The Contributing Authors and Group 42, Inc. disclaim all warranties,  
expressed or implied, including without limitation, the warranties of merchantability and of fitness for any purpose. 
The Contributing Authors and Group 42, Inc. assume no liability for damages, direct or consequential, which may 
result from the use of the PNG Reference Library. 

Permission  is  hereby  granted  to  use,  copy,  modify  and  distribute  this  source code,  or  portions  hereof,  for  any 
purpose, without fee, subject to the following restrictions: 

The origin of this source code must not be misrepresented. 

Altered versions must be plainly marked as such and must not be misrepresented as being the original source. This  
Copyright Notice may not be removed or altered from any source or altered source distribution. 

Compression Library Copyright 

Copyright © 1995 Jean-loup Gailly and Mark Adler. 

This software is provided “as is”, without any express or implied warranty. In no event will the authors be held liable 
for any damages arising from the use of this software. 

Permission is granted to anyone to use this software for any purpose, including commercial applications and to alter it  
and redistribute it freely, subject to the following restrictions: 

The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you  
use this software in a product, an acknowledgment in the product documentation would be appreciated but is not 
required. 

Altered source versions must be plainly marked as such, and must not be misrepresented as being the original  
software. This notice may not be removed or altered from any source distribution. 

Jean-loup  Gailly  and  Mark  Adler.  gzip@prep.ai.mit.edu  madler@alumni.caltech.edu  Independent  JPEG  Group’s 
Copyright 

The authors make no warranty or representation, either express or implied, with respect to this software, its quality, 
accuracy, merchantability,  or fitness for a particular purpose. This software is provided “as is” and you, its user, 
assume the entire risk as to its quality and accuracy. 

This software is copyright © 1991, 1992, 1993, 1994, 1995, Thomas G. Lane. All Rights Reserved except as specified 
below. 

Permission is hereby granted to use, copy, modify and distribute this software (or portions thereof) for any purpose, 
without fee, subject to these conditions: 

If  any part of the source code for this software is distributed, then this README file must be included, with this 
copyright and no-warranty notice unaltered; and any additions, deletions, or changes to the original files must be  
clearly indicated in accompanying documentation. 

If only executable code is distributed, then the accompanying documentation must state that “this software is based in 
part on the work of the Independent JPEG Group”. 
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Permission  for  use  of  this  software  is  granted  only  if  the  user  accepts  full  responsibility  for  any  undesirable 
consequences; the authors accept NO LIABILITY for damages of any kind. 

These conditions apply to any software derived from or based on the IJG code, not just to the unmodified library. If  
you use our work, you ought to acknowledge us. 

Permission is NOT granted for the use of any IJG author’s name or company name in advertising or publicity relating  
to this software or products derived from it. This software may be referred to only as “the Independent JPEG Group’s 
software”. 

We specifically permit and encourage the use of this software as the basis of commercial products, provided that all  
warranty or liability claims are assumed by the product vendor. 

ansi2knr.c is included in this distribution by permission of L. Peter Deutsch, sole proprietor of its copyright holder, 
Aladdin Enterprises of Menlo Park, CA. ansi2knr.c is NOT covered by the above copyright and conditions, but instead 
by the usual distribution terms of the Free Software Foundation; principally, that you must include source code if you 
redistribute it. (See the file ansi2knr.c for full details). However, since ansi2knr.c is not needed as part of any program 
generated  from the  IJG  code,  this  does  not  limit  you  more  than  the  foregoing  paragraphs  do.  “The  Graphics 
Interchange Format © is the Copyright property of CompuServe Incorporated. GIF (sm) is a Service Mark property of 
CompuServe Incorporated.” 

Copyright © 1980, 1993

The Regents of the University of California. All Rights Reserved. 

Redistribution and use in source and binary forms, with or  without  modification,  are permitted provided that  the 
following conditions are met: 

Redistributions  of  source  code  must  retain  the  above  copyright  notice,  this  list  of  conditions  and  the  following  
disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer  in  the  documentation  and/or  other  materials  provided  with  the  distribution.  All  advertising  materials 
mentioning  features  or  use  of  this  software  must  display  the  following  acknowledgment:  This  product  includes 
software developed by the University of California, Berkeley and its contributors. Neither the name of the University  
nor the names of its contributors may be used to endorse or promote products derived from this software without 
specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR 
IMPLIED  WARRANTIES,  INCLUDING,  BUT  NOT  LIMITED  TO,  THE  IMPLIED  WARRANTIES  OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL 
THE  REGENTS  OR  CONTRIBUTORS  BE  LIABLE  FOR  ANY  DIRECT,  INDIRECT,  INCIDENTAL,  SPECIAL, 
EXEMPLARY,  OR  CONSEQUENTIAL DAMAGES  (INCLUDING,  BUT  NOT LIMITED  TO,  PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT  (INCLUDING  NEGLIGENCE  OR  OTHERWISE)  ARISING  IN  ANY  WAY  OUT  OF  THE  USE  OF  THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

Copyright © 1990, 1994 Regents of the University of Michigan 

All Rights Reserved. 

Permission to use, copy, modify and distribute this software and its documentation for any purpose and without fee is  
hereby granted, provided that the above copyright notice appears in all copies and that both that copyright notice and 
this permission notice appear in supporting documentation, and that the name of The University of Michigan not be 
used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. This  
software  is  supplied  as  is  without  expressed  or  implied  warranties  of  any  kind.  This  product  includes  software 
developed by the University of California, Berkeley and its contributors. Code in sys/linux is developed by Alan Cox.  
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You may redistribute it and/or modify it under the terms of the GNU General Public License as published by the Free 
Software Foundation; either version 2 of the License, or (at your option) any later version. 

Research Systems Unix Group The University of Michigan C/O Wesley Craig

535 W. William Street 

Ann Arbor, Michigan

1-313-764-2278 netatalk@umich.edu

GNU GENERAL PUBLIC LICENSE

Version 2, June 1991

Copyright © 1989, 1991 Free Software Foundation, Inc.

675 Mass Ave,

Cambridge, MA 02139, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed. 

Preamble The licenses for  most  software are designed to take away your freedom to share and change it.  By  
contrast, the GNU General Public License is intended to guarantee your freedom to share and change free software-
to make sure the software is free for all its users. This General Public License applies to most of the Free Software 
Foundation’s software and to any other program whose authors commit  to using it.  (Some other Free Software 
Foundation  software  is  covered by the  GNU Library  General  Public  License instead).  You can apply  it  to  your 
programs, too. When we speak of free software, we are referring to freedom, not price. Our General Public Licenses 
are designed to make sure that you have the freedom to distribute copies of free software (and charge for this service 
if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces 
of it in new free programs; and that you know you can do these things. 

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to  
surrender the rights.  These restrictions translate to certain responsibilities for  you if  you distribute copies of  the 
software, or if you modify it. 

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all  
the rights that you have. You must make sure that they too, receive or can get the source code. And you must show 
them these terms so they know their rights. 

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal  
permission to copy, distribute and/or modify the software. 

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no 
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients to  
know that what they have is not the original, so that any problems introduced by others will not reflect on the original 
author’s reputations. 

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors 
of a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent this, we  
have made it clear that any patent must be licensed for everyone’s free use or not licensed at all. The precise terms 
and conditions for copying, distribution and modification follow. 

GNU GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION 

 This License applies to any program or other work which contains a notice placed by the copyright holder saying it  
may be distributed under the terms of this General Public License. The “Program”, below, refers to any such program  
or work, and a “work based on the Program” means either the Program or any derivative work under copyright law: 
that is to say, a work containing the Program or a portion of it, either verbatim or with modifications and/or translated  
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into another language. (Hereinafter, translation is included without limitation in the term “modification”). Each licensee 
is addressed as “you”. 

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. 
The act of running the Program is not restricted, and the output from the Program is covered only if its contents  
constitute a work based on the Program (independent of having been made by running the Program). Whether that is 
true depends on what the Program does. 

You may copy and distribute verbatim copies of  the Program’s  source code as you receive it,  in  any medium, 
provided  that  you  conspicuously  and  appropriately  publish  on  each  copy  an  appropriate  copyright  notice  and 
disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and  
give any other recipients of the Program a copy of this License along with the Program. 

You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program, 
and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet 
all of these conditions: 

You must cause the modified files to carry prominent notices stating that you changed the files and the date of any  
change. 

You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the  
Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of this License. 

If the modified program normally reads commands interactively when run, you must cause it, when started running for  
such interactive use in the most ordinary way, to print or display an announcement including an appropriate copyright 
notice and a notice that  there is  no warranty (or  else,  saying that  you provide a warranty)  and that  users may 
redistribute the program under these conditions, and telling the user how to view a copy of this License. (Exception: if  
the Program itself is interactive but does not normally print such an announcement, your work based on the Program 
is not required to print an announcement). 

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from 
the Program, and can be reasonably considered independent and separate works in themselves, then this License, 
and its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the 
same sections as part of a whole which is a work based on the Program, the distribution of the whole must be on the  
terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every  
part regardless of who wrote it. 

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the  
intent is to exercise the right to control the distribution of derivative or collective works based on the Program. In 
addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the  
Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this  
License. 

You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form 
under the terms of Sections 1 and 2 above provided that you also do one of the following: Accompany it with the 
complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 
2 above on a medium customarily used for software interchange; or, 

Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your 
cost of physically performing source distribution, a complete machine-readable copy of the corresponding source 
code, to be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software 
interchange; or, 

Accompany  it  with  the  information  you  received  as  to  the  offer  to  distribute  corresponding  source  code.  (This  
alternative is allowed only for noncommercial distribution and only if  you received the program in object code or 
executable form with such an offer, in accord with Subsection b above). 

The source code for a work means the preferred form of the work for making modifications to it. For an executable 
work, complete source code means all the source code for all modules it contains, plus any associated interface 
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definition files, plus the scripts used to control compilation and installation of the executable. However, as a special 
exception, the source code distributed need not include anything that is normally distributed (in either source or binary 
form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs,  
unless that component itself accompanies the executable. 

If distribution of executable or object code is made by offering access to copy from a designated place, then offering 
equivalent access to copy the source code from the same place counts as distribution of the source code, even 
though third parties are not compelled to copy the source along with the object code. 

You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License. Any  
attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate your 
rights under this License. However, parties who have received copies, or rights, from you under this License will not 
have their Licenses terminated so long as such parties remain in full compliance. You are not required to accept this  
License,  since you have not  signed it.  However,  nothing else grants  you permission to  modify  or  distribute the 
Program or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by 
modifying or distributing the Program (or any work based on the Program), you indicate your acceptance of this 
License to do so, and all its terms and conditions for copying, distributing or modifying the Program or works based 
on it. 

Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a 
license from the original licensor to copy, distribute or modify the Program subject to these terms and conditions. You 
may  not  impose  any  further  restrictions  on  the  recipients’  exercise  of  the  rights  granted  herein.  You  are  not 
responsible for enforcing compliance by third parties to this License. 

If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to  
patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the 
conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to 
satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence 
you may not distribute the Program at all. For example, if a patent license would not permit royalty-free redistribution 
of the Program by all those who receive copies directly or indirectly through you, then the only way you could satisfy 
both it and this License would be to refrain entirely from distribution of the Program. If any portion of this section is 
held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply and 
the section as a whole is intended to apply in other circumstances. It is not the purpose of this section to induce you 
to infringe any patents or other property right claims or to contest validity of any such claims; this section has the sole  
purpose of protecting the integrity of the free software distribution system, which is implemented by public license 
practices. Many people have made generous contributions to the wide range of software distributed through that  
system in reliance on consistent application of that system; it is up to the author/donor to decide if he or she is willing 
to distribute software through any other system and a licensee cannot impose that choice. 

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License. If  
the  distribution and/or  use of  the Program is  restricted in  certain  countries  either  by  patents  or  by  copyrighted  
interfaces, the original copyright holder who places the Program under this License may add an explicit geographical 
distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus 
excluded. In such case, this License incorporates the limitation as if written in the body of this License. 

The Free Software Foundation may publish revised and/or new versions of the General Public License from time to  
time.  Such new versions will  be similar  in spirit  to the present version,  but  may differ  in detail  to address new  
problems or concerns. 

Each version is given a distinguishing version number. If the Program specifies a version number of this License 
which applies to it and “any later version”, you have the option of following the terms and conditions either of that  
version or of any later version published by the Free Software Foundation. If the Program does not specify a version 
number of this License, you may choose any version ever published by the Free Software Foundation. If you wish to  
incorporate parts of the Program into other free programs whose distribution conditions are different, write to the 
author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free  
Software Foundation;  we sometimes make exceptions for  this.  Our  decision will  be guided by the two goals of  
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preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software 
generally. 

NO WARRANTY BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR 
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN 
WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT 
WARRANTY OF  ANY KIND,  EITHER  EXPRESSED  OR  IMPLIED,  INCLUDING,  BUT NOT LIMITED  TO,  THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE 
RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM 
PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT 
HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED 
ABOVE,  BE  LIABLE  TO  YOU  FOR  DAMAGES,  INCLUDING  ANY  GENERAL,  SPECIAL,  INCIDENTAL  OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING 
BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY 
YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), 
EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
END OF TERMS AND CONDITIONS 

Appendix: How to Apply These Terms to Your new Programs 

If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to  
achieve this is to make it free software which everyone can redistribute and change under these terms. To do so,  
attached the following notices to the program. It is safest to attach them to the start of each source file to most  
effectively convey the exclusion of warranty; and each file should have at least the “copyright” line and a pointer to 
where the full notice is found. 

<one line to give the program’s name and a brief idea of what is does> 

Copyright © 19yy <name of author> 

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General Public  
License as published by the Free Software Foundation; either version 2 of the License, or (at your option) any later  
version. 

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied 
warranty  of  MERCHANTABILITY or  FITNESS FOR A PARTICULAR PURPOSE.  See  the  GNU General  Public 
License for more details. 

You should have received a copy of the GNU General Public License along with this program; if not, write to the Free 
Software Foundation, Inc., 675 Mass Ave, Cambridge, MA 02139, USA. 

Also add information on how to contact you by electronic and paper mail. 

If the program is interactive, make it output a short notice like this when it starts in an interactive mode: Gnomovision  
version 69, Copyright © 19yy name of author 

Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type “show w”. This is free software, and you 
are welcome to redistribute it under certain conditions; type “show c” for details. 

The hypothetical commands “show w” and “show c” should show the appropriate parts of the General Public License.  
Of course, the commands you use may be called something other than “show w” and “show c”; they could even be  
mouse- clicks or menu items-whatever suits your program. 

You should  also  get  your  employer  (if  you work  as  a  programmer)  or  your  school,  if  any,  to  sign  a  “copyright 
disclaimer” for the program, if necessary. Here is a sample; alter the names: 

Yoyodyne  Inc.,  hereby  disclaims  all  copyright  interest  in  the  program  “Gnomovision”  (which  makes  passes  at  
compilers) written by James Hacker. 
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<signature of Ty Coon>, 1 April 1989 Ty Coon, President of Vice 

This General Public License does not permit incorporating your program into proprietary programs. If your program is  
a subroutine library, you may consider it more useful to permit linking proprietary applications with the library. If this is  
what you want to do, use the GNU Library General Public License instead of this License. Copyright 

The XFree86 Project, Inc. 

Copyright © 1994, 1995 The XFree86 Project, Inc. All Rights Reserved. 

Permission  is  hereby  granted,  free  of  charge,  to  any  person obtaining  a  copy  of  this  software  and associated 
documentation files (the “Software”), to deal in the Software without restriction, including without limitation the rights  
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons 
to whom the Software is furnished to do so, subject to the following conditions: The above copyright notice and this  
permission  notice  shall  be  included  in  all  copies  or  substantial  portions  of  the  Software.  THE SOFTWARE IS 
PROVIDED “AS  IS”,  WITHOUT WARRANTY OF ANY KIND,  EXPRESS OR IMPLIED,  INCLUDING BUT NOT 
LIMITED  TO  THE  WARRANTIES  OF  MERCHANTABILITY,  FITNESS  FOR  A  PARTICULAR  PURPOSE  AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE XFREE86 PROJECT BE LIABLE FOR ANY CLAIM, DAMAGES 
OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT 
OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 
Except as contained in this notice, the name of the XFree86 Project shall not be used in advertising or otherwise to  
promote the sale, use or other dealings in this Software without prior written authorization from the XFree86 Project. 

$XConsortium:  CPYRIGHT.sgml,v  1.2/95/01/16  13:17:39  kaleb  Exp  $  Generated  from  XFree86: 
xc/programs/Xserver/hw/xfree86/doc/sgml/CPYRIGHT.sgml,v 3.3 1995/01/28 16:01:20 dawes Exp $ 

$XFree86: xc/programs/Xserver/hw/xfree86/doc/COPYRIGHT,v 3.8 1995/07/24 06:52:11 dawes Exp $ CIECAM02 
Copyright
Copyright (c) 2003 Billy Biggs <vektor@dumbterm.net> 

Permission  is  hereby  granted,  free  of  charge,  to  any  person obtaining  a  copy  of  this  software  and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights 
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons 
to whom the Software is furnished to do so, subject to the following conditions: The above copyright notice and this  
permission notice shall be included in all copies or substantial portions of the Software. 

THE  SOFTWARE  IS  PROVIDED  "AS  IS",  WITHOUT  WARRANTY  OF  ANY  KIND,  EXPRESS  OR  IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE 
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT 
OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR 
OTHER DEALINGS IN THE SOFTWARE. 
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